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MPEG Disclaimers

MPEGLA MPEG2 Patent
ANY USE OF THIS PRODUCT IN ANY MANNER OTHER THAN PERSONAL USE THAT COMPLIES WITH THE 
MPEG-2 STANDARD FOR ENCODING VIDEO INFORMATION FOR PACKAGED MEDIA IS EXPRESSLY 
PROHIBITED WITHOUT A LICENSE UNDER APPLICABLE PATENTS IN THE MPEG-2 PATENT PORTFOLIO, 
WHICH LICENSE IS AVAILABLE FROM MPEG LA, LLC, 4600 S. Ulster Street, Suite 400, Denver, Colorado 
80237 U.S.A.

MPEGLA MPEG4 VISUAL
THIS PRODUCT IS LICENSED UNDER THE MPEG-4 VISUAL PATENT PORTFOLIO LICENSE FOR THE 
PERSONAL AND NON-COMMERCIAL USE OF A CONSUMER FOR (i) ENCODING VIDEO IN COMPLIANCE 
WITH THE MPEG-4 VISUAL STANDARD (“MPEG-4 VIDEO”) AND/OR (ii) DECODING MPEG-4 VIDEO THAT 
WAS ENCODED BY A CONSUMER ENGAGED IN A PERSONAL AND NON-COMMERCIAL ACTIVITY AND/OR 
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MPEGLA AVC
THIS PRODUCT IS LICENSED UNDER THE AVC PATENT PORTFOLIO LICENSE FOR THE PERSONAL USE OF 
A CONSUMER OR OTHER USES IN WHICH IT DOES NOT RECEIVE REMUNERATION TO (i) ENCODE VIDEO 
IN COMPLIANCE WITH THE AVC STANDARD (“AVC VIDEO”) AND/OR (ii) DECODE AVC VIDEO THAT WAS 
ENCODED BY A CONSUMER ENGAGED IN A PERSONAL ACTIVITY AND/OR WAS OBTAINED FROM A 
VIDEO PROVIDER LICENSED TO PROVIDE AVC VIDEO. NO LICENSE IS GRANTED OR SHALL BE IMPLIED 
FOR ANY OTHER USE. ADDITIONAL INFORMATION MAY BE OBTAINED FROM MPEG LA, L.L.C. SEE HTTP://
WWW.MPEGLA.COM.

MPEG4 SYSTEMS
THIS PRODUCT IS LICENSED UNDER THE MPEG-4 SYSTEMS PATENT PORTFOLIO LICENSE FOR 
ENCODING IN COMPLIANCE WITH THE MPEG-4 SYSTEMS STANDARD, EXCEPT THAT AN ADDITIONAL 
LICENSE AND PAYMENT OF ROYALTIES ARE NECESSARY FOR ENCODING IN CONNECTION WITH (i) DATA 
STORED OR REPLICATED IN PHYSICAL MEDIA WHICH IS PAID FOR ON A TITLE BY TITLE BASIS AND/OR (ii) 
DATA WHICH IS PAID FOR ON A TITLE BY TITLE BASIS AND IS TRANSMITTED TO AN END USER FOR 
PERMANENT STORAGE AND/OR USE. SUCH ADDITIONAL LICENSE MAY BE OBTAINED FROM MPEG LA, 
LLC. SEE HTTP://WWW.MPEGLA.COM FOR ADDITIONAL DETAILS.

Limited Warranty and Disclaimers
Telestream, LLC (the Company) warrants to the original registered end user that the product will 
perform as stated below for a period of one (1) year from the date of shipment from factory:

Hardware and Media—The Product hardware components, if any, including equipment supplied but 
not manufactured by the Company but NOT including any third party equipment that has been 
substituted by the Distributor for such equipment (the “Hardware”), will be free from defects in 
materials and workmanship under normal operating conditions and use.

Warranty Remedies
Your sole remedies under this limited warranty are as follows:

Hardware and Media—The Company will either repair or replace (at its option) any defective Hardware 
component or part, or Software Media, with new or like new Hardware components or Software Media. 
Components may not be necessarily the same, but will be of equivalent operation and quality. 

Software Updates
Except as may be provided in a separate agreement between Telestream and You, if any, Telestream is 
under no obligation to maintain or support the Software and Telestream has no obligation to furnish 
you with any further assistance, technical support, documentation, software, update, upgrades, or 
information of any nature or kind.
Kumulate Administration Guide



Restrictions and Conditions of Limited Warranty
This Limited Warranty will be void and of no force and effect if (i) Product Hardware or Software Media, 
or any part thereof, is damaged due to abuse, misuse, alteration, neglect, or shipping, or as a result of 
service or modification by a party other than the Company, or (ii) Software is modified without the 
written consent of the Company.

Limitations of Warranties
THE EXPRESS WARRANTIES SET FORTH IN THIS AGREEMENT ARE IN LIEU OF ALL OTHER WARRANTIES, 
EXPRESS OR IMPLIED, INCLUDING, WITHOUT LIMITATION, ANY WARRANTIES OF MERCHANTABILITY OR 
FITNESS FOR A PARTICULAR PURPOSE. No oral or written information or advice given by the Company, 
its distributors, dealers or agents, shall increase the scope of this Limited Warranty or create any new 
warranties.

Geographical Limitation of Warranty—This limited warranty is valid only within the country in which 
the Product is purchased/licensed.

Limitations on Remedies—YOUR EXCLUSIVE REMEDIES, AND THE ENTIRE LIABILITY OF TELESTREAM, 
LLC WITH RESPECT TO THE PRODUCT, SHALL BE AS STATED IN THIS LIMITED WARRANTY. Your sole and 
exclusive remedy for any and all breaches of any Limited Warranty by the Company shall be the 
recovery of reasonable damages which, in the aggregate, shall not exceed the total amount of the 
combined license fee and purchase price paid by you for the Product. 

Damages
TELESTREAM, LLC SHALL NOT BE LIABLE TO YOU FOR ANY DAMAGES, INCLUDING ANY LOST PROFITS, 
LOST SAVINGS, OR OTHER INCIDENTAL OR CONSEQUENTIAL DAMAGES ARISING OUT OF YOUR USE OR 
INABILITY TO USE THE PRODUCT, OR THE BREACH OF ANY EXPRESS OR IMPLIED WARRANTY, EVEN IF 
THE COMPANY HAS BEEN ADVISED OF THE POSSIBILITY OF THOSE DAMAGES, OR ANY REMEDY 
PROVIDED FAILS OF ITS ESSENTIAL PURPOSE.

Further information regarding this limited warranty may be obtained by writing:
Telestream, LLC
848 Gold Flat Road
Nevada City, CA 95959 USA

You can call Telestream during U. S. business hours via telephone at (530) 470-1300.

Regulatory Compliance
Electromagnetic Emissions: FCC Class A, EN 55022 Class A, EN 61000-3-2/-3-3, CISPR 22 Class A

Electromagnetic Immunity: EN 55024/CISPR 24, (EN 61000-4-2, EN 61000-4-3, EN 61000-4-4, EN 61000-
4-5, EN 61000-4-6, EN 61000-4-8, EN 61000-4-11)

Safety: CSA/EN/IEC/UL 60950-1 Compliant, UL or CSA Listed (USA and Canada), CE Marking (Europe)
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California Best Management Practices Regulations for Perchlorate Materials:
This Perchlorate warning applies only to products containing CR (Manganese Dioxide) Lithium coin 
cells. Perchlorate Material-special handling may apply. See www.dtsc.ca.gov/hazardouswaste/
perchlorate.
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Introduction
This guide gives system administrators a basic understanding of Kumulate 
functionality, and detailed instructions for Kumulate system configuration, daily 
operations, and routine maintenance.

■ Kumulate Overview

■ Kumulate Administration

■ The Kumulate Control Bar

Kumulate Overview
Kumulate lets users manage remote video assets from any computer on your network 
via a web-based user interface. As an administrator on the network, you can maintain 
the Kumulate system and user accounts.

Some of the advantages of a web-based interface include:

• No client software installation

• No client application configuration

• No client updates

• Users can access content from anywhere on the network

Using Kumulate you can:

• Search for video clips by file name, date, category, and format

• Define metadata fields that support search

• Use advanced search operations to hone searches for specific criteria. For example, 
you can search for video clips of farm animals in the United States, but not in 
Nebraska or Kansas.

• Review assets using the built-in media player

• Extract selected frames, add them to a list of related clips, forward them to editing 
applications, or arrange them for distribution

• Assign a default set of pinned metadata fields (administrators only)
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Release Notes
For details of a specific release of Kumulate, including system requirements, 
descriptions of new features, fixes, Knowledgebase articles, and new terminology, see 
the Kumulate Support page.

Kumulate Administration
After logging in to Kumulate, you find many tools for Kumulate configuration and 
administration on the Administration page of the System view.

Logging In
You access Kumulate for administration, as well as for operation, via the Kumulate web 
app.

To log in initially, use one of the default user IDs, such as user MNTN with password 
mntn. This user account is part of the default group, Montana User Group. You can use 
this user ID to set up user groups and users and perform other initial configuration 
tasks.

Note: Telestream recommends that you change the MNTN user account password.

To log in to Kumulate, do the following:

1. Point your browser to the URL for the Kumulate web application. 

The Web app URL syntax is: http://<host name | IP address>/montana.
You supply the DNS name or IP address of the server where the Kumulate web 
application is hosted; for example:
http://10.10.10.10/montana or http://kumulate-one/montana.

Telestream opens the Kumulate login page in your browser.

2. Enter your credentials.

The default user name is MNTN, and the default password is mntn.

3. Before proceeding to other tasks, set up user groups and users, as desired.

See Creating a Group and Creating a New Kumulate User.

Default User Group and Credentials
The default Montana User Group and its users have full read and write administration 
privileges for Kumulate. The MNTN user can create user groups and user accounts to 
meet your requirements.

Default user group: Montana User Group

Default user ID: MNTN

Default password: mntn
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Finding the Administrator Tools
Kumulate administration tools are located on the ADMINISTRATION page of the Settings 
view. To find the administrator tools, do the following:

1. Click the Page menu button.

See the Page menu button on the screenshot of the The Kumulate Control Bar.

Kumulate opens the Page drop-down menu.

2. Select System.

Kumulate opens the System view.

3. Click the ADMINISTRATION button.

Kumulate opens the ADMINISTRATION page.

4. Click any of the drop-down menu buttons on the ADMINISTRATION page to view 
menus of administration controls.
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The Kumulate Control Bar
You can choose Kumulate views, view system settings, and search for assets through 
the Kumulate control bar.

Table 1.

Element Description

Page menu button When clicked, Kumulate opens 
the Kumulate menu.

Kumulate logo When clicked, Kumulate opens 
the Dashboard view.

Locations button When clicked, Kumulate opens 
the Locations view.

Content button When clicked, Kumulate opens 
the Content view.

Jobs button When clicked, Kumulate opens 
the Jobs view.

Search drop-down menu When clicked, Kumulate opens 
the Search drop-down menu, 
showing searchable elements.

Search field Field for search terms.

Search button When clicked, Kumulate 
searches for the term in the 
Search field.

Page menu button
Kumulate logo

Locations button
Content button

Jobs button
Search drop-down menu

Search field
Search button

Basket button
System button

Help button
User button
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Basket button When clicked, Kumulate opens 
the Basket view.

System button When clicked, Kumulate opens 
the System view.

Help button When clicked, Kumulate opens 
the Help page.

User button When clicked, Kumulate opens 
the User menu.

Table 1.  (Continued)

Element Description
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Cluster Configuration and 
Failover
You can configure Kumulate clustered configurations securely.

■ Secure Clustered Configurations

■ Configuring Failover with Kumulate

■ Configuring Failover with Windows Failover Cluster Manager

■ Cluster Internal DataMover

Secure Clustered Configurations
In a clustered configuration, you connect two Kumulate servers to each other. This 
ensures redundancy and continuation of business during failovers. The two clustered 
servers operate as a Master and Backup. Services are installed on both servers, but run 
only on the Master server. During failover, Kumulate shuts down services on the Master 
and restarts them on the Backup.

Manage Kumulate cluster services with the Windows Failover Cluster Manager. With 
Windows Failover Cluster Manager, you can cause services to fail over from the 
Kumulate Web Interface, the Master server, or the Backup server.

Configuring Failover with Kumulate
To cause Kumulate to fail over from the Master Server, do the following:

1. Log in to Kumulate as an administrator.

See Logging In.

2. Click the Page menu button.

See the Page menu button on the screenshot for The Kumulate Control Bar.

Kumulate opens the Page drop-down menu.

3. Select System.
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4. Select Administration > DRAC Control > Cluster Information.

Kumulate opens the Cluster Information dialog, listing the Master and Backup serv-
ers.

5. Click the Make Master button  next to the Backup server name to trigger the 
failover, changing the Backup to the Master.

Kumulate opens the Validation Confirmation dialog.

6. Click OK.

Kumulate remains unavailable until all services have failed over. The failover pro-
cess takes approximately three minutes.

7. Reload the web page. When Kumulate comes back online, the server roles are 
reversed. The failover is complete.

Configuring Failover with Windows Failover 
Cluster Manager

To failover services from the Windows Failover Cluster Manager, do the following:

1. Log in to either the Master or Backup server and open Windows Failover Cluster 
Manager.

2. Right-click the cluster service named either MS_Services or MS_Service.
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3. Select Move > Node.

4. Select the Backup Server from the node list.

5. Click OK to take the services offline.

6. Kumulate remains unavailable while the services are moved between nodes. The 
failover should take approximately three minutes.
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7. Wait until the services are running on the Backup server before attempting to 
access Kumulate.

8. After the services are running, log into the Kumulate web interface and navigate 
back to the Cluster Information page. The Backup server is now the master.
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Cluster Internal DataMover
DataMovers on both the Master and Backup servers are operational in a cluster. 
However, only the DataMover on the Master acts as the internal DataMover. The 
DataMover on the Backup acts as an external DataMover.

In the event of failover, the internal DataMover also fails over. The Backup server 
becomes the Master server, and the external DataMover on the Backup becomes the 
internal DataMover.

A new flag, named Disable for Local DM, has been added to internal DataMover 
endpoint configuration. When set, this flag disables the endpoint when the DataMover 
assumes the role of the internal DataMover.

See Adding a DataMover Endpoint for more information.
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Storage Locations
You can add, change, and maintain Storage Locations in Kumulate.

■ Storage Locations

■ Avid Standalone Storage Locations

■ Avid Interplay Storage Locations

■ Avid Storage Location Metadata Mapping

■ Omneon FTP Storage Locations

■ Pitchblue FTP Storage Locations

■ Project FTP Storage Locations

■ Project UNC Storage Locations

■ UNC Storage Locations

■ BXF Storage Locations

■ Discriminators and File Identifiers

■ Media Composer PMRUpdater Module
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Storage Locations
Repository locations use either a UNC or an FTP transfer protocol. Configure each 
Storage Location based on the media stored on it and the transfer mode used to 
transfer the media.

Configure each Storage Location to support a specific instance format.

Note: Typically, you can transfer an instance to a location only if the format of the 
instance is the format for which the location is configured. However, you could make 
such a transfer if you have a Transcode Profile that can transcode the incoming 
instance to the format specified by the location Restore Profile.

Storage Locations aren’t automatically accessible to users, nor are they automatically 
added to external DataMovers. You must add repositories, explicitly, as endpoints to 
external DataMovers, and you must add them explicitly to user groups.

Avid Standalone Storage Locations
An Avid Standalone Storage Location consists of an Avid Media Composer workstation 
connected to the Kumulate system.

When two or more Media Composer workstations store files on a shared Storage 
Location--such as an ISIS Storage Location--Kumulate connects to the shared repository 
rather than to the Media Composer workstations.

Avid Standalone File and Folder Formats
Avid Standalone Storage Locations store MXF OP_ATOM files and AAF files.

MXF OP_ATOM files can contain video or audio essences. The video and audio of a 
media clip are stored in individual MXF OP_ATOM files. The video file and its audio file 
together make up an Avid Master Clip.

Master Clips are used to create finished media projects called sequences. A sequence's 
AAF file contains its list of Master Clip segments and the order in which to play them. 
When a sequence is added to Kumulate, its AAF file and Master Clips are also added to 
the instance.

Effects are stored in separate MXF_OP_ATOM files only if the effects are rendered either 
before the sequence is exported from Avid, or as part of the export process. If the 
effects are not rendered, they are stored as metadata in the AAF file.

When Kumulate monitors an Avid Standalone Storage Location, it monitors the AAF file 
location. When a new AAF file is discovered, Kumulate creates a new asset and adds the 
Master Clips listed in the AAF file to an instance.

When a sequence or Master Clip is transferred from an Archive Location, or from one 
Avid Standalone Storage Location to another, Kumulate transfers the AAF file and the 
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Master Clips it references. Kumulate places the Master Clips in numbered subfolders 
under the Avid MediaFiles\MXF\ root folder. The number of files per subfolder is 
capped by the Interplay Maximum Files Storage Location configuration parameter. The 
Avid MediaFiles\MXF\ folder can be located on a local drive, on a mapped drive or an 
UNC location.

The name of the numbered subfolders is set using the Interplay Repository Folder 
Pattern parameter. The folder number is appended to the folder name after a separator. 
The separator is specified by the Folder Pattern Separator parameter. For example, if 
MyMedia is used for the Interplay Repository Folder Pattern, and underscore (_) is used 
for the Folder Pattern Separator, then the subfolders will be named MyMedia_1, 
MyMedia_2, MyMedia_3, and so on.

If the Interplay Repository Folder Pattern is left blank, no separator will be used even if 
one is specified. In this case, the subfolders will simply be numbers: 1, 2, 3, and so on.

The Folder Pattern Separator can be a period (.), an underscore (_), or a dash (-). If 
PMRUpdater is being used, the Folder Pattern Separator must be a period (.), and the 
Interplay Repository Folder Pattern must be the Media Composer workstation's name. 
For example, if the Media Composer workstation's fully qualified domain name is 
MyWorkStation.MyOrg.com, the Interplay Repository Folder Pattern must be set to 
MyWorkstation.

Configuring Avid Standalone Storage Locations
Use the following procedure to configure the Avid Standalone Storage Locations, do 
the following:

1. Log in to Kumulate.

See Logging In.

2. Browse to the administration tools.

See Finding the Administrator Tools.

3. From the ADMINISTRATION page menus, select Locations > Storage.

4. To create a new Storage Location, click Add New Location.

5. Enter a name and description for the Storage Location, then click OK.

6. Select the Monitoring tab.

7. Set API Protocol to UNC, and Capture Format to AVID.

8. Click OK to continue.

Kumulate displays a warning dialog asking if you want to submit the change to the 
Storage Location.

9. Click OK to continue.

Kumulate opens the Connection tab.

10. Select the Transfer tab.

11.  Set Transfer Mode to UNC Interplay Standalone.

12. To continue and return to the Connection tab, click OK.
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13. (Optional) If you will use the Storage Location to discover new instances, continue 
to Configuring AAF Instance Discovery.

14. (Optional) If you will use the locations to copy instances from Kumulate to a 
physical location, continue to Configuring AAF Instance Transfer.

Configuring Avid Standalone Storage Locations for 
PMRUpdater

Use the following procedure to configure the Avid Standalone Storage Locations:

1. Log in to Kumulate.

See Logging In.

2. Browse to the administration tools.

See Finding the Administrator Tools.

3. From the ADMINISTRATION page menus, select Locations > Storage.

4. To modify, click the pencil icon next to the Avid Standalone Storage Location.

If you need to create a new location, see Avid Standalone Storage Locations.

5. Click the Transfer tab.

6. Set Folder pattern separator to a period (.), and set Interplay Media Reconcile After 
Transfer to YES.

Note: If PMRUpdater is not installed, but Interplay Media Reconcile After Transfer is 
set to YES, transfers to and from the Storage Location will fail.

7. Click OK to save the changes.

8. Modify all the Avid Standalone Storage that will be using the PMR Updater.

Configuring MMC Module 
Use the following procedure to configure the MMC Module:

Note: Before configuring the MMC module, perform at least one transfer to any Avid 
Standalone Storage Location. The PMRUpdater Path parameter will only 
become visible in the MMC module after a transfer to an Avid Standalone 
Storage Location has been made.

1. Log in to Kumulate.

See Logging In.

2. Browse to the administration tools.

See Finding the Administrator Tools.

3. From the ADMINISTRATION page menus, select Modules.
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4. Click the pencil button  next to the MMC module to open the MMC Module 
Configuration page.

5. Enter the path of the PMRUpdater executable in the PMRUpdater Path text box.

6. Click OK to save the changes.

Configuring AAF Instance Discovery 
To discover new instances and copy them into Kumulate, do the following:

1. On the Connection tab, enter the path to the AAF files in the Directory field. 
Kumulate monitors this directory for new AAF files.

2. On the Monitoring tab, set the values for Files Dir Enable, Media Repository Path, 
Media Repository String to Replace (regex), and Monitoring as follows:

Caution: Remember to set Metadata Mapping.

Configuring AAF Instance Transfer
To have Kumulate copy instances which are transferred to the Storage Location to a 
physical location, do the following:

1. Navigate to the Transfer tab.

Parameter Value

Files Dir Enable Must be set to YES.

Media Repository Path The path to the Avid MediaFiles\MXF\ 
folder on the Media Composer 
workstation relative to Kumulate.

Media Repository String to Replace (regex) Regular expression that matches the 
local path to the Avid MediaFiles\MXF\ 
folder used in the AAF file. 

The matched string is replaced by Media 
Repository Path. 

By default this is set to (.*\\), matching 
any drive letter. This should only be 
changed if Media Composer is running 
on a workstation running MacOS. 

Monitoring This must be set to ON.
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2. Enter values into the required fields, as follows:

See Settings for Avid Standalone Storage Location Transfer for the complete list of 
Transfer values.

Parameter Value

Interplay AAF Root Folder Path to the folder where Kumulate writes 
the AAF file, for example, 
C:\AvidStandalone\AAF.

Interplay Content Temporary Folder Fully qualified path to Avid media files, for 
example,
C:\AvidStandalone\Avid 
MediaFiles\MXF\Creating\.

Folder Pattern Separator The separator used with Interplay Media 
Repository Folder Pattern. 

Can be period (.), underscore (_), or dash 
(-). If it is omitted, and Interplay Media 
Repository Folder Pattern is not left blank, 
Kumulate uses MS. 

Set to period (.) when using PMRUpdater.

Interplay Media Reconcile After Transfer Determines whether PMR files are 
updated by PMRUpdater or Media 
Composer. 

Set to NO if PMRUpdater is not installed.

Interplay Media Repository Path Fully qualified path to a temporary 
directory for the AAF files, for example, 
C:\AvidStandalone\tmp.

Must be blank when using shared 
storage.

Interplay Media Root Folder Fully qualified path to Avid Media files, for 
example, Avid MediaFiles\MXF\.

Additional subfolders can be created 
below this folder.

Interplay Media Repository Folder Pattern The prefix name used with the indexed 
subfolders of the Interplay Media Root 
Folder, for example, MS.

Must be set to the Media Composer 
workstation name when using 
PMRUpdater.
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Settings for Avid Standalone Storage Location Monitoring 

Caution: Don’t modify any parameter not in the following list. Modifying an 
unlisted parameter might affect Kumulate operations.

Set the values on the Monitoring tab for Avid Standalone Storage Locations as follows:

■ API Protocol

Set to UNC

■ Capture Format

Set to Avid

■ Discover Avid Sequences with Media Offline

When discovering instances on the location, the AAF file used may point to files 
that are located on offline media. 

When this parameter is set to YES, instances will be discovered even if the files are 
located on offline media. Setting this parameter to NO will not discover instances if 
the files are located in offline media.

This is set to YES by default.

■ Files Dir Enable

Indicates whether the full directory structure of the folder on the ISIS storage unit is 
recreated on the cache.

Setting this parameter to YES recreates the directory structure, allowing Kumulate 
to transcode the files and create proxies. Setting the parameter to NO creates a 
proxy on the cache instead. 

The parameter must be set to YES when the Storage Location is configured for dis-
covery. Otherwise, the parameter can be left set to NO.

■ Media Repository Path

AAF files contain paths to the Master Clips used in its sequence. However, the paths 
are relative to the Media Composer workstation. To add files to Kumulate, the paths 
must be changed to be relative to the Kumulate server. 

This parameter is the path to Avid MediaFiles\MXF\ relative to the Kumulate server. 
It replaces the path specified by Media Repository String to Replace (regex).
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■ Media Repository String to Replace (regex)

AAF files contain paths to the Master Clips used in its sequence. However, the paths 
are relative to the Media Composer workstation. For the files to be discovered by 
Kumulate, the paths must be changed to be relative to the Kumulate server. 

This parameter is a regular expression that selects the path to the Avid Medi-
aFiles\MXF\ folder in the AAF file. The path selected by the regular expression is 
replaced by Media Repository Path. 

This parameter is set to (.*\\) by default and selects a drive letter. The result is that 
the drive letter before Avid MediaFiles\MXF\ is replaced with Media Repository 
Path.

For examples, see Media Repository Path Replacement Examples.

■ Monitor Timeout (min)

A possibly deprecated parameter that may or may not have an effect on some func-
tion. Don’t change this parameter.

■ Monitoring

This parameter indicates whether this Storage Location is to be monitored if the 
Storage Location will be used to copy in files. If the Storage Location will only be 
used to copy out files, set the parameter to OFF; otherwise set it to ON.

■ Interplay WS Mode

Indicates whether Kumulate communicates with the Storage Location through the 
Interplay Web Services interface. Since Avid Standalone Storage Locations are not 
connected to an Interplay system, this parameter must be set to NO.

■ Polling Begin Time, Polling End Time, Polling Interval(sec)

Controls how Kumulate polls the AAF file.

Polling Begin Time and Polling End Time instruct Kumulate to poll the Storage 
Location only between Polling Begin Time and Polling End Time. These Values are 
based on the 24-hour clock and can only be set to hours. 

Polling Interval(sec) instructs Kumulate to poll the Storage Location every specified 
number of seconds. The interval begins when the discovery operation ends. The 
minimum value for this interval is 10s. Setting this parameter to 0 effectively sets it 
to 10s.

Settings for Avid Standalone Storage Location Transfer

Caution: Don’t modify any parameter not in the following list. Modifying an 
unlisted parameter might affect Kumulate operations.

Set the values on the Transfer tab for Avid Standalone Storage Locations as follows:
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■ Capture Mode

The capture mode specifies whether the physical file on this Storage Location is 
kept or deleted after its instance is transferred to another location.

MOVE deletes the physical file from this location after the transfer, while COPY 
keeps it.

■ Checksum Type and Checksum Validation

Instance checksums are calculated to ensure that instance data is not corrupted.

When an instance is copied to the location, its checksum is calculated using the 
algorithm specified by Checksum Type. If the instance's checksum is not already in 
the database, it is added. If the instance's checksum is already in the database, but 
the two checksums do not match, the transfer will fail and an error will be gener-
ated.

If After Write is selected for Checksum Validation, then an additional check is made 
after the instance has been fully copied to the location. If the checksum of the writ-
ten instance does not match the checksum in the database, the transfer will fail.

■ Delete Source AAF file after copy in

This parameter only applies when Kumulate is copying in files from the Storage 
Location. It deletes the AAF file from the Storage Location after its files have been 
transferred from the Storage Location to cache. A copy of the AAF file will remain in 
the cache.

■ Interplay AAF Root Folder

This is the path to the location where Kumulate will write the AAF file when copying 
out files to the Storage Location. The Avid system must be configured to retrieve 
the AAF file from this location.

■ Interplay Content Temporary Folder

This is the temporary file write location on the Media Composer workstation or ISIS 
Storage Location. Kumulate writes files, including the AAF file, to this temporary 
folder to prevent the Avid system from indexing the files before Kumulate has com-
pleted restoring the files.

After Kumulate has completed transferring the files, it updates the Master Clip 
paths in the AAF file with the Interplay Media Root Folder path, and moves the con-
tents of this folder to the Interplay Media Root Folder. The AAF file is moved to 
Interplay AAF Root Folder.

The Interplay Content Temporary Folder must be named Creating and must be 
located on under Avid MediaFiles\MXF\. Creating can be located under a subfolder 
of Avid MediaFiles\MXF\. If the folder does not exist, it will be created by Kumulate.
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■ Folder Pattern Separator

This setting can be left blank or set to dash (-), underscore (_), or period (.). It must 
be set to period (.) when using PMRUpdater. 

It is used in conjunction with the Interplay Media Repository Folder Pattern to cre-
ate the numbered subfolders under the Interplay Media Root Folder. 

The numbered subfolders are created and named [repository_folder_pat-
tern][folder_pattern_separator][number]. For example, if the folder pattern separa-
tor is an underscore (_), and the folder pattern is MyFiles, folders named 
MyFiles_1, MyFiles_2, MyFiles_3, and so on will be created under the root folder. 

If this setting is left blank, Kumulate will use MS as the separator. For example, 
MyFilesMS1, MyFilesMS2, MyFilesMS3, and so on. 

If the Repository Folder Pattern is also left blank, Kumulate will create folders with 
only numbers in their names. For example, Avid MediaFiles\MXF\1\, Avid Medi-
aFiles\MXF\2\, Avid MediaFiles\MXF\3\, and so on.

■ Interplay Maximum Files

This is the maximum number of files per numbered subfolders. A new numbered 
subfolder is created when the maximum is reached.

Technical Support recommends 2500 files per folder. Avid limits the number of files 
per folder to 5000. Don’t set this parameter to a value greater than 5000.

■ Interplay Media Reconcile After Transfer

This parameter is only used when PMRUpdater is installed. 

When set to YES, PMRUpdater will be used to update PMR files. The PMR files will be 
updated by Media Composer when it is set to NO. 

If PMRUpdater is not installed and Interplay Media Reconcile After Transfer is set to 
YES, transfers to and from this Storage Location will fail.

■ Interplay Media Repository Path

Temporary directory for the AAF file.

■ Interplay Media Root Folder

The fully qualified path to the root folder on the Avid Standalone Storage Location 
where the transferred files are placed. The path used for the Interplay Media Root 
Folder must include Avid MediaFiles\MXF\, which is automatically created by Media 
Composer.

The numbered folders can be located in a subfolder of Avid MediaFiles\MXF\. If 
Avid MediaFiles\MXF\ is in an unmapped UNC location, the subfolder must already 
exist before it can be used as the Interplay Media Root Folder. If Avid Medi-
aFiles\MXF\ is located on a local or mapped drive, Kumulate will create the sub-
folder if it does not already exist.

■ Interplay Media Repository Folder Pattern

This setting is used in conjunction with Folder Pattern Separator to create the num-
bered subfolders under the Interplay Media Root Folder. 

The numbered subfolders are created and named [Interplay Media Repository 
Folder Pattern][Folder Pattern Separator][number]. For example, if Folder Pattern 
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Separator is set to underscore (_), and Interplay Media Repository Folder Pattern is 
set to MyFiles, folders named MyFiles_1, MyFiles_2, MyFiles_3, and so on will be 
created.

If this parameter is left blank, Kumulate creates folders with number names. For 
example, Avid MediaFiles\MXF\1\, Avid MediaFiles\MXF\2\, Avid Medi-
aFiles\MXF\3\, and so on. 

This parameter must be set to the Media Composer workstation machine name 
when using PMRUpdater. For example, if the machine's fully qualified domain 
name is ThisMachine.MyCompany.com, then this parameter must be set to This-
Machine.

■ Max Copy In

This setting only applies when the Storage Location is configured for copying in 
files. It sets the maximum number of concurrent transfers from the Storage Loca-
tion to Kumulate. 

The value can be between 0 and 127, where 0 means that there is no limit on the 
number of transfers. The default value is 0.

Note: Telestream strongly recommends you change this to a non-zero value.

■ Max Copy Out

Only applies when the Storage Location is configured for copying out files. Sets the 
maximum number of concurrent transfers from Kumulate to the Storage Location.

The value can be between 0 and 127, where 0 means that there is no limit on the 
number of transfers. The default value is 0. 

Note: Telestream strongly recommends you change this to a non-zero value.

■ Overwrite Video Server Instance

When set to NOT ALLOWED, a transfer from Kumulate to the Storage Location will 
fail if the file already exists on the Storage Location. 

When set to ALLOWED, the transfer will overwrite the existing file on the Storage 
Location.

■ Preserve Cache Structure

Preserve Cache Structure is set to YES in cases where Avid files are stored on a 
shared Storage Location that is not connected to a Media Composer workstation. 
This setting is generally used when moving files from one Kumulate system to 
another Kumulate system. 

When Avid files are saved to the cache, they are saved along with a copy of the AAF 
file to the same folder structure. The AAF file is stored under VirtualassetID/Meta-
data/ while the media files are stored under VirtualassetID/Media/.

When the files need to be transferred to another Kumulate system, the Virtualas-
setID folder on the originating Kumulate system is copied in its entirety to the Stor-
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age Location connected to the destination Kumulate system. This Storage Location 
is configured with Preserve Cache Structure set to YES. 

Restore Using must be set to Asset ID when Preserve Cache Structure is set to YES.

■ Restore Using

This parameter specifies how to name the physical file when an instance is trans-
ferred to this Storage Location. There are four options for Restore Using as follows:

Note: If the asset source location used Asset ID as the Naming Schema, the Asset ID, 
Asset Name, and the Original Name may be identical.

■ Transcode Using

Some files may contain information at the beginning and end of the file that is not 
necessarily meant to be transcoded. This happens most often with commercial 
spots which can have agency information, tags, and blacks appended to the beg-
ging and the end of the advertisement. Selecting SOM and EOM prevents these 
extraneous bits from being transcoded. Additional configuration is needed to use 
EOM and SOM. 

The entire file is transcoded when set to SOF and EOF. 

Only a part of the file is transcoded when set to SOM and EOM. 

See Start of Message Parameter for more information.

■ Transfer Mode

This parameter is always set to UNC Interplay Standalone.

Replacing a Drive Letter
When the path to Avid MediaFiles in the AAF file uses a drive letter, replace the drive 
letter by keeping Media Repository String to Replace (regex) set to (.*\\).

Option Description

Asset ID The file is named using the transferred instance's Asset ID. 

Name The file is named using the transferred instance's Asset Name.

Original Name The file is named using the transferred instance's Asset Original 
Name. Original Name contains the name of the Asset when its 
source instance was discovered.

Preserve Filenames The file name is not modified after transfer. The Restore 
Extension parameter will not be applicable when this option is 
used. If the Storage Location configuration is saved after setting 
this option then Restore Extension will be hidden.
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Note: Replacing multiple drive letters for the same Storage Location are not currently 
supported.

For example, to change:

C:\Avid MediaFiles\MXF\5\tvo1345.mxf

to

\\10.1.4.1\Avid MediaFiles\MXF\5\tvo1345.mxf

enter the following for Media Repository Path and Media Repository String to Replace 
(regex):

Replacing a Known Repository Path
When the path to Avid MediaFiles/MXF/ used in the AAF file is known, you can set 
Media Repository String to Replace (regex) to the path. If you want to remove any special 
character, add a backslash (\) as a prefix before the special character.

For example, to change:

\\macpath\workspace3\Avid MediaFiles\MXF\mtg.2\e1234567.mxf

to

\\isis123\workspace3\Avid MediaFiles\mxf\mtg.2\e1234567.mxf

enter the following for Media Repository Path and Media Repository String to Replace 
(regex):

or

In the first option, Kumulate matches and replaces only the names. In the second 
option, Kumulate matches the names and replaces the leading and trailing backslashes 
as well as to the names.

Media Repository Path \\10.1.4.1\

Media Repository String to Replace (regex) (.*\\)

Media Repository Path isis123

Media Repository String to Replace (regex) macpath

Media Repository Path isis123

Media Repository String to Replace (regex) \\\\mactest\\
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Note: Kumulate doesn’t support replacing multiple drive letters for the same Storage 
Location.

If Media Repository String to Replace (regex) ends with a double backslash (\\), include 
the ending backslash (\) in Media Repository Path. Otherwise, Kumulate removes the 
ending backslash without replacing it.

Media Repository Path Replacement Examples
The file paths extracted from monitored AAF files point to locations on the Media 
Composer host. These paths must be changed to locations relative to Kumulate for the 
files to be archived.

Replacing Path with Case-Insensitive Repository String
When the path to the Avid MediaFiles\MXF\ folder used in the AAF file can be either 
lower or upper case, use the (?!) modifier in the Media Repository String to Replace 
(regex) regular expression.

For example, to change

\\MyPath\Avid MediaFiles\MXF\5\tvo1345.mxf

or

\\mypath\Avid MediaFiles\MXF\5\tvo1345.mxf

to

\\isis123\Avid MediaFiles\MXF\5\tvo1345.mxf

enter the following for Media Repository Path and Media Repository String to Replace 
(regex):

The (?!) modifier matches the regular expression without considering case.

Regular Expression Does Not Match Root Path
If Media Repository String to Replace (regex) does not match the file path used in the 
AAF file, Kumulate will behave differently depending on the file path in the AAF file.

AAF File Contains Drive Letters or IPv4 Addresses
If the AAF file uses drive letters or IPv4 addresses, Kumulate will replace the paths in the 
AAF with the new path even if Media Repository String to Replace (regex) does not 
match the paths in the AAF file.

Media Repository Path \\isis123\

Media Repository String to Replace (regex) (?!)\\\\mypath\\
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For example, if the Media Repository Path and Media Repository String to Replace 
(regex) values are set as follows:

but the file paths in the AAF file are of the form

C:\Avid MediaFiles\MXF\5\tvo1345.mxf

or

\\10.1.4.1\Avid MediaFiles\MXF\5\tvo1345.mxf

the path will still be changed to

\\NewPath\Avid MediaFiles\MXF\5\tvo1345.mxf

Note: Leaving Media Repository String to Replace (regex) blank, but filling in Media 
Repository Path will produce the same result.

Transfer Error: Non-Matching UNC File Path
If the AAF file contains UNC file paths that do not match Media Repository String to 
Replace (regex), Kumulate adds the Media Repository Path to the beginning of the path. 
The files listed in the AAF files will not be found and the copy-in will fail.

For example, if the Media Repository Path and Media Repository String to Replace (regex) 
values are set as follows:

but the file paths in the AAF file are of the form

\\SomeOtherPath\Avid MediaFiles\MXF\5\tvo1345.mxf

the new path will be

\\NewPath\SomeOtherPath\Avid MediaFiles\MXF\5\tvo1345.mxf

Note: The files will not be found in this case and the transfer will fail.

Log and Operator Messages
In all cases where Media Repository String to Replace (regex) doesn’t match the paths in 
the AAF file, Kumulate logs an error in the Montana logs, and generates an operator 
message.

For example, the operator message would state:

Media Repository Path \\NewPath\

Media Repository String to Replace (regex) \\\\OriginalPath\\

Media Repository Path \\NewPath\

Media Repository String to Replace (regex) \\\\OriginalPath\\
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Media Repository String to Replace (<\\\\OriginalPath\\>) does not match on Storage 
Location TEST

The message in the Montana log would state:

14-11-17 11:36:32.609 
CMI:FtpUncAvidStandaloneFolderCommandExecutor.getFilesInfoIfCompleted: Failed 
to replace (\\\\OriginalPath\\)/(\\NewPath\) on file C:\Avid 
MediaFiles\MXF\5\tvo1345.mxf

Avid Interplay Storage Locations
An Avid Interplay Storage Location consists of an ISIS storage unit and an Interplay 
server. The Interplay server keeps an inventory of the contents of the ISIS unit.

Kumulate communicates with the Interplay server through a Web Services interface, to 
identify files available to copy in from the ISIS storage unit, and to check-in files that 
have been copied to the ISIS storage unit with the Interplay server.

The files are moved to and from the ISIS storage unit using an ISIS client installed on the 
Kumulate server. When Kumulate transfers files to the ISIS unit, the files must be 
checked-in with the Interplay server (by Kumulate) to update the Interplay server's 
inventory.

Separate Avid Interplay Storage Locations must be configure for copy in and copy out, 
even if they both correspond to the same physical Interplay server and ISIS storage unit.

Avid Interplay File and Folder Formats
Avid Interplay Storage Locations store MXF OP_Atom files that can contain video or 
audio essences. The video and audio of a media clip are stored in individual MXF 
OP_ATOM files. The video file and its audio file together make up an Avid Master Clip.

Master Clips are used to create finished media projects called Sequences. Sequences 
are defined in AAF files. A sequence's AAF file contains a list of Master Clip segments, 
and the order in which to play them. If data and effects are used in the sequence, they 
are stored in separate MXF OP_ATOM files, which are also referenced in the sequence's 
AAF file. When a sequence is added to Kumulate, its AAF file and Master Clips are also 
added to the instance.

In an Avid Interplay Storage Location, Kumulate communicates with the Interplay 
server through the Web Services interface. Kumulate and Interplay pass messages that 
contain information about Sequences and Master Clips. Both the Kumulate and 
Interplay servers use these messages to create AAF files.

When a sequence is copied in to Kumulate, Kumulate polls Interplay through Web 
Services. Interplay responds with a message that contains information about the 
sequence. Kumulate then uses the message to generate an AAF file used to pull the 
Master Clips from the ISIS storage unit using the ISIS client.
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When an instance is copied out to the Avid Interplay Storage Location, Kumulate 
creates an AAF describing the instance, then copies the files to the ISIS storage unit 
using the ISIS client installed on the Kumulate server host. Kumulate places the Master 
Clips in numbered subfolders under the Avid MediaFiles\MXF\ root folder. The number 
of files per subfolder is capped by the Interplay Maximum Files Storage Location 
configuration parameter. Kumulate then uses its AAF file to create a Web Service 
message that it sends to Interplay. Interplay then becomes aware of the files that were 
copied to the ISIS storage unit.

The name of the numbered subfolders is set using the Interplay Repository Folder 
Pattern parameter. The folder number is appended to the folder name after a separator. 
The separator is specified by the Folder Pattern Separator parameter, which can be a 
period (.), an underscore (_), or a dash (-). For example, if MyMedia is used for Interplay 
Repository Folder Pattern, and underscore (_) is used for Folder Pattern Separator, then 
the subfolders will be named MyMedia_1, MyMedia_2, MyMedia_3, and so on.

If Interplay Repository Folder Pattern is left blank, no separator will be used even if one 
is specified. In this case, the subfolders will simply be numbers: 1, 2, 3, and so on.

Configuring Avid Interplay Instance Discovery

Note: Avid Interplay Storage Locations cannot be configured to both copy in new 
instances and copy out existing instances. Separate Storage Locations must be 
created for these two scenarios regardless of whether the same physical 
location is used for both.

Use the following procedure to configure Interplay Storage Locations to be used for 
instance discovery:

1. Log in to Kumulate.

See Logging In.

2. Browse to the administration tools.

See Finding the Administrator Tools.

3. From the ADMINISTRATION page menus, select Locations > Storage.

4. Click the Add New Location button to create a new Storage Location.

5. Enter a name and description for the Storage Location. Then, click OK.

6. Select the Monitoring tab and set API Protocol to UNC, and Capture Format to AVID.

7. Click OK to continue. 

Kumulate displays a warning asking if you want to submit the change to the Stor-
age Location.

8. Click OK to continue.

Kumulate opens the Connection tab.

9. Select the Monitoring tab.

10. Set Monitoring to ON and Interplay WS Mode to YES.
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11. Click OK to continue.

Kumulate displays a warning asking if you want to submit the change to the Stor-
age Location.

12. Click OK to continue.

Kumulate opens the Connection tab.

13. Set values for Monitoring, Interplay WS Mode, Interplay Folder, Interplay WS Password, 
Interplay WS Address, Interplay WS User, Interplay Work Group, and Temporary AAF 
Repository Path. as follows:

14. Click OK to continue.

Kumulate opens the Connection tab.

15. Select the Transfer tab and set Transfer Mode to UNC Interplay.

16. Click OK to continue.

Kumulate opens the Connection tab.

17. Ensure that the only connection parameter visible is Extract Metadata, and that it is 
set to NO.

Metadata is extracted automatically from the AAF file and does not need to be 
extracted from the discovered media files.

18. Set the metadata mapping. Then click OK to save and continue.

Settings for Monitoring Avid Interplay Instance Discovery 

Caution: Don’t modify any parameter not in the following list. Modifying an 
unlisted parameter might affect Kumulate operations.

The following values under the Monitoring tab are used by Avid Interplay copy in 
Storage Locations:
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■ API Protocol

Always set to UNC.

■ Capture Format

Avid Interplay Storage Locations that are used to send files to Kumulate (copy-in, 
archive, monitor) must have Capture Format set to Avid.

■ Delete From Video Server

Allows the deletion of files from the Storage Location after they have been copied 
in to Kumulate.

■ Discover Avid Sequences with Media Offline

When discovering instances on the location, the AAF file used may point to files 
that are located on offline media.

When this parameter is set to YES, instances will be discovered even if the files are 
located on offline media.

Setting this parameter to NO will not discover instances if the files are located in 
offline media.

The default is YES.

■ Files Dir Enable

Indicates whether the full directory structure of the folder on the ISIS storage unit is 
recreated on the cache. 

Setting this to YES recreates the directory structure. This allows Kumulate to 
transcode the files and create proxies. Setting the parameter to NO creates a proxy 
on the cache instead. 

Caution: Telestream strongly recommends you set Files Dir Enable to YES when 
the Storage Location is configured for discovery. Otherwise, leave it set 
to NO.

■ Interplay WS Mode

Indicates whether Kumulate communicates with the Storage Location through the 
Interplay Web Services interface. Kumulate always communicates through Web 
Services with Avid Interplay Storage Locations. Therefore this parameter must be 
set to YES.

■ Interplay Folder

Information about Avid files stored on the ISIS storage unit is saved in metadata on 
the Interplay server. The server organizes information about the Avid files in folders. 
Kumulate monitors only one Interplay folder on an Avid Interplay Storage Location, 
and queries Interplay for information about this folder. In return, Interplay sends 
information about the files referenced in the folder to Kumulate, and Kumulate 
uses this information to discover the files on the ISIS Storage Location.

Interplay Folder is the fully qualified path to the folder on the Interplay server that 
Kumulate will monitor.
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■ Interplay WS User, Interplay WS Password, and Interplay WS Address

The connection credentials for Interplay Web Services.

■ Interplay Work Group

The Interplay work group to connect to.

■ Monitor Timeout (min)

A possibly deprecated parameter that may (or may not) have an effect on some 
functionality somewhere. Do not change this parameter.

■ Monitoring

Indicates whether this Storage Location is to be monitored. Must be set to ON when 
the Avid Interplay location is used to send files to Kumulate (copy-in, archive, moni-
toring).

■ Polling Begin Time, Polling End Time, Polling Interval(sec)

Controls how Kumulate polls the Interplay server.

Polling Begin Time and Polling End Time instruct Kumulate to poll the Storage 
Location only between Polling Begin Time and Polling End Time. These values are 
based on the 24-hour clock, and can only be set to hours. 

Polling Interval(sec) instructs Kumulate to poll the Storage Location every specified 
number of seconds. The interval begins when the discovery operation ends. The 
minimum value for this interval is 10s. Setting this parameter to 0 effectively sets it 
to 10s.

■ Temporary AAF Repository Path

Kumulate uses the information received from Interplay to create an AAF file that it 
then uses to discover files on the ISIS storage unit. The AAF file is saved to Tempo-
rary AAF Repository Path; which is a fully qualified path to a location on the Kumu-
late cache.

Enabling Edit-While-Capture for Avid Locations
By default, Kumulate lets you edit while capturing media with Avid Standalone or Avid 
Interplay. When Enable EWC Check is enabled, Kumulate checks the AAF file for the 
attribute,  _EWC_FILE_MOB. If Kumulate finds this attribute, it will not discover it. When 
Enable EWC Check is disabled, Kumulate does discover _EWC_FILE_MOB.

To enable or disable Edit While Capture (EWC), do the following:

1. Log in to Kumulate.

See Logging In.

2. Browse to the administration tools.

See Finding the Administrator Tools.

3. From the ADMINISTRATION page menus, select Locations > Storage.

Kumulate opens the Storage Location Manager page.

4. Select the Monitoring tab.
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5. On the Monitoring tab, do one of the following:

– To enable EWC, select YES from the Enable EWC Check drop-down menu.

– To disable EWC, select NO from the Enable EWC Check drop-down menu.

6. Click OK.

Configuring Avid Interplay Instance Transfer

Note: You can’t configure Avid Interplay Storage Locations to both copy in new 
instances and copy out existing instances. You must create separate Storage 
Locations for these two scenarios regardless whether the same physical 
location is used for both.

Use the following procedure to configure an Avid Interplay Storage Location for 
instance transfers:

1. Log in to Kumulate.

See Logging In.

2. Browse to the administration tools.

See Finding the Administrator Tools.

3. From the ADMINISTRATION page menus, select Locations > Storage.

4. To create a new Storage Location, click Add New Location.

5. Enter a name and description for the Storage Location, then click OK.

6. Select the Monitoring tab.

7. Enter an API HostName. Set API Protocol to UNC and Capture Format to 
MXF_OP_ATOM.

8. Click OK to continue.

Kumulate displays a warning asking if you want to submit the change to the Stor-
age Location.

9. Click OK to continue.

Kumulate opens the Connection tab.

10. Select the Monitoring tab.

11. Set Monitoring to OFF, and Naming Schema to UMID.

12. Click OK to continue.

Kumulate opens the Connection tab.

13. Select the Transfer tab.

14. Set Transfer Mode to UNC Interplay.

15. Click OK to continue.

Kumulate opens the Connection tab.

16. Set Extract Metadata to NO.
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17. Set Directory to the UNC path to the location for the media files on the ISIS storage 
unit.

18. Click OK to continue.

19. Kumulate opens the Connection tab.

20. Select the Transfer tab and set the following values:

For the complete list of transfer values, see Settings for Copy In and Copy Out Trans-
fer.

13.Click OK to save and continue.

Values for Monitoring Instance Transfer 

Caution: Don’t modify any parameter not in the following list. Modifying an 
unlisted parameter might affect Kumulate operations.

Parameter Description

Interplay Check In Folder The fully qualified path to the folder on the 
Interplay server for the metadata about the 
transferred files, for example, Interplay://
AvidWorkGroup.

Folder Pattern Separator The separator used with Interplay Repository 
Folder Pattern. This can be a period (.), underscore 
(_), or dash (-). If it is omitted, and Interplay Media 
Repository Folder Pattern is not left blank, 
Kumulate uses MS.

Interplay Repository Folder Pattern The prefix name used with the indexed subfolders 
of the Interplay Root Path, for example, MS.

Interplay Root Path UNC path to the Avid MediaFiles\MXF\ folder on 
the ISIS storage unit. Include any subfolders of Avid 
MediaFiles\MXF\ in this path.

Interplay WS Password

Interplay WS Address

Interplay WS User

The web server connection credentials.

Interplay Work Group The Interplay workgroup to connect to.

Restore Using Must be set to Name.

DataMover Repository Path The UNC path to the location on the ISIS storage 
unit where the media files will be copied. This must 
be the same path used for the Directory parameter 
in the Connection tab.
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Set the values on the Monitoring tab for Avid Interplay Copy Out Storage Locations as 
follows:

■ API Protocol

Always set to UNC.

■ Capture Format

Avid Interplay Storage Locations that are used to receive files from Kumulate (copy-
out, check in) must have Capture Format set to MXF_OP_ATOM.

■ Files Dir Enable

Indicates whether the full directory structure of the folder on the ISIS storage unit is 
recreated on the cache.

Setting Files Dir Enable to YES recreates the entire directory structure on the cache. 
This allows Kumulate to transcode the files and create proxies. Setting the parame-
ter to NO will only create file proxies on the cache.

Caution: Telestream strongly recommends you set Files Dir Enable to YES when 
the Storage Location is configured for discovery. Otherwise, leave the 
parameter set to NO.

■ Monitoring

Indicates whether this Storage Location is to be monitored. This parameter must be 
set to OFF when the Avid Interplay location is used to receive files from Kumulate 
(copy-out, check in).

■ Naming Schema

Set this to UMID.

Settings for Copy In and Copy Out Transfer

Caution: Don’t modify any parameter not in the following list. Modifying an 
unlisted parameter might affect Kumulate operations.

Set the values on the Transfer tab for Avid Interplay Storage Locations as follows:

■ Capture Mode

The Capture Mode parameter specifies whether the physical file on this Storage 
Location is kept or deleted after its instance is transferred to another location.

MOVE deletes the physical file from this location after the transfer, while COPY 
keeps it.

Note: Only the COPY option is implemented for Avid Interplay Storage Locations.
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■ Check If Sequence Online

When set to NO, Kumulate assumes the sequence to copy in from the Storage Loca-
tion is online and ready to transfer.

When set to any other value, Kumulate queries the Interplay server about the state 
of the sequence for each transfer.

This parameter is not case sensitive.

■ Checksum Type and Checksum Validation

Instance checksums are calculated to ensure that instance data is not corrupted.

When an instance is copied to the location, its checksum is calculated using the 
algorithm specified by Checksum Type. If the instance's checksum does not exist in 
the database, it is added. If the instance's checksum does exist in the database, but 
the two checksums do not match, the transfer will fail and an error will be gener-
ated.

If After Write is selected for Checksum Validation, then an additional check is made 
after the instance has been fully copied to the location. If the checksum of the writ-
ten instance does not match the checksum in the database, the transfer will fail.

■ Interplay Check In Folder

After Kumulate transfers files to the ISIS storage unit, it sends a Web Service mes-
sage to Interplay to update the Interplay folder associated with the files that have 
been transferred. The Interplay Check In Folder is the fully qualified path to the 
Interplay folder that is being updated. Only one folder can be updated per Storage 
Location.

■ Folder Pattern Separator

This parameter can be left blank or set to dash (-), underscore (_), or period (.). 

Used in conjunction with the Interplay Repository Folder Pattern to create the num-
bered subfolders under the Interplay Root Path. 

The numbered subfolders are created and named as follows:

<repository_folder_pattern><folder_pattern_separator><number>

For example, if the folder pattern separator is an underscore (_), and the folder pat-
tern is MyFiles, folders named MyFiles_1, MyFiles_2, MyFiles_3, and so on will be 
created under the root folder.

If Folder Pattern Separator is left blank, Kumulate will use MS as the separator. For 
example, MyFilesMS1, MyFilesMS2, MyFilesMS3, and so on. 

Note: If the Interplay Repository Folder Pattern is also left blank, Kumulate will create 
folders with only numbers in their names. For example, Avid 
MediaFiles\MXF\1\, Avid MediaFiles\MXF\2\, Avid MediaFiles\MXF\3\, and so 
on.

■ Interplay Maximum Files

This parameter is the maximum number of files per numbered subfolders. A new 
numbered subfolder is created when the maximum is reached.
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Note: 2500 files per folder is recommended. Avid limits the number of files per folder 
to 5000. Do not set this parameter to any value greater than 5000.

■ Interplay Repository Folder Pattern

This parameter is used in conjunction with Folder Pattern Separator to create the 
numbered subfolders under the Interplay Root Path.

The numbered subfolders are created and named as follows:

[Interplay Repository Folder Pattern][Folder Pattern Separator][number]

 For example, if Folder Pattern Separator is set to underscore (_), and Interplay 
Repository Folder Pattern is set to MyFiles, folders named MyFiles_1, MyFiles_2, 
MyFiles_3, and so on will be created. 

Note: If you leave the Interplay Repository Folder Pattern blank, Kumulate creates 
folders with number names. For example, Avid MediaFiles\MXF\1\, Avid 
MediaFiles\MXF\2\, Avid MediaFiles\MXF\3\, and so on.

■ Interplay Root Path

The fully qualified path to the root folder on the ISIS storage unit where the 
restored Master Clips are placed. The path used for the Interplay Root Path must 
include Avid MediaFiles\MXF\, which is automatically created by Media Composer.

The numbered folders can be located in a subfolder of Avid MediaFiles\MXF\. The 
subfolder must already exist before it can be used as the Interplay Root Path.

■ Interplay WS Check In Retry Interval (sec) and Interplay WS Check In Retry Number

In the event that a transfer is not successful, the transfer will be retried Interplay WS 
Check In Retry Number times, every Interplay WS Check In Retry Interval (sec). If the 
transfer is still unsuccessful when Interplay WS Check In Retry Number is reached, 
the transfer fails.

■ Interplay WS User, Interplay WS Password, and Interplay WS Address

The connection credentials for the Interplay Web Services service.

■ Interplay Work Group

The Interplay workgroup to connect to.

■ Max Copy In

This only applies when the Storage Location is configured for copying in files. It sets 
the maximum number of concurrent transfers from the Storage Location to Kumu-
late. The value can be between 0 and 127, where 0 means that there is no limit on 
the number of transfers. The default value is 0.

Note: Telestream strongly recommends you change this to a non-zero value.

■ Max Copy Out

This only applies when the Storage Location is configured for copying out files. It 
sets the maximum number of concurrent transfers from Kumulate to the Storage 
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Location. The value can be between 0 and 127, where 0 means that there is no limit 
on the number of transfers. The default value is 0.

Note: Telestream strongly recommends you change this to a non-zero value.

■ Overwrite Video Server Instance

When set to NOT ALLOWED, a transfer from Kumulate to the Storage Location will 
fail if the file already exists on the Storage Location.

When set to ALLOWED, the transfer will overwrite the existing file on the Storage 
Location.

■ Restore Using

This parameter specifies how to name the physical file when an instance is trans-
ferred to this Storage Location. There are three options for Restore Using as follows:

Note: If the asset source location used Asset ID as the Naming Schema, the Asset ID, 
Asset Name, and Original Name may be identical.

■ Restore Extension

This parameter determines how file extensions are handled when files are copied 
to the Storage Location.

Filenames and their extensions are preserved when instances are copied between 
locations by default. The Restore Extension parameter allows extensions to be 
added, removed, or replaced.

Asset ID The file is named using the transferred instance's Asset 
ID.

Name The file is named using the transferred instance's Asset 
Name.

Original Name The file is named using the transferred instance's 
Original Name. Original Name contains the name of the 
asset when its source instance was discovered.

Preserve Filenames The file name is not modified after transfer.

The Restore Extension parameter will not be applicable 
when this option is used. If the Storage Location 
configuration is saved after setting this option, Restore 
Extension will be hidden.
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The following Restore Extension options are available:

The New extension, Add extension if no original extension, and Remove specific 
extension work with the Extension parameter. This parameter is not visible by 
default. If the Extension parameter is not visible, click OK to save the configuration, 
then navigate back to the Transfer tab. The Extension parameter should now be vis-
ible.

■ Extension

The Extension parameter works with the Restore Extension parameter to replace 
file extensions when instances are copied to the Storage Location.

This parameter is not visible by default. It only becomes visible when Restore Exten-
sion is set to New extension, Add extension if no original extension, or Remove spe-
cific extension.

Note: In some cases, the configuration must be saved after selecting New extension, 
Add extension if no original extension, or Remove specific extension for the 
Extension parameter to become visible.

■ Transcode Using

Some files may contain information at the beginning and end of the file that is not 
necessarily meant to be transcoded. This happens most often with commercial 
spots which can have agency information, tags, and blacks appended to the beg-
ging and the end of the advertisement. Selecting SOM and EOM prevents these 

Value Behavior

Preserve original extension The extension does not change when the 
file is copied to the Storage Location.

This is the default behavior.

New extension Change the existing extension to the 
specified extension.

Remove extension Remove the extension if one exists.

Add extension if no original extension Add the specified extension if the original 
filename does not have an extension.

Remove specific extension Remove only the specified extension and 
preserve all other extensions.
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extraneous bits from being transcoded. Additional configuration is needed to use 
EOM and SOM.

When set to SOF and EOF, the entire file is transcoded.

When set to SOM and EOM, only a part of the file is transcoded.

See Start of Message Parameter for more information.

■ Transfer Mode

Always set to UNC Interplay.

■ DataMover Repository Path

Provides the DataMover access to the ISIS Storage Location. This must point to the 
location of the files on the ISIS storage unit. With copy-out Storage Locations, this 
path must be the same path used for the Directory parameter under the Connec-
tion tab.

■ MassTransit Repository Path

Provides HQS access to the ISIS Storage Location. Allows HQS to transcode files on 
the Storage Location rather than on the cache.

The parameter should either point to the location of the files on the ISIS storage 
unit, or it can be left blank. If this parameter is left blank, HQS will transcode files 
once they are transferred to the cache.

With copy-out Storage Locations, this path must be the same path used for the 
Directory parameter under the Connection tab.
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Avid Storage Location Metadata Mapping
When Avid instances are copied into Kumulate, an AAF processor extracts metadata 
and a metadata mapping assigns the extracted metadata to Kumulate metadata.

You have to manually add metadata mappings to an Avid Storage Location for the 
metadata extracted from the AAF to be assigned to the appropriate Kumulate 
metadata.

Before mappings are added, a representative AAF file needs to be examined by the 
administrator creating the metadata mappings. The AAF processor included with HQS 
can be used for this purpose.

Note: The information in this section applies to all Avid Storage Locations except Avid 
Interplay Copy Out Storage Locations.

Mapping AAF Metadata
The metadata in an Avid instance's AAF file can be mapped to Kumulate metadata. 
These mappings must be added to the Avid Storage Location after a representative 
AAF file has been examined. The AAF processor installed with HQS can be used to 
extract the metadata in an AAF file to an xml file.

For example:

C:\AAFFiles>aafProcessor.exe -r ExtractMetadata Sample.aaf MD_Sample.aaf.xml

Note: The aafProcessor.exe can be found on the server where HQS is installed in 
C:\Program Files (x86)\Masstech\AAFProcessor\ folder.

Each xml tag in the output file is an AFF metadata and its value.

For example:
<AAFProcessor version=”1.0”>
[...]
<Metadata type=”TVDM”>
<MobAttributeList id=”60958183-47b1-11d4-a01c0004ac969f50”> 

   <_VERSION>2</_VERSION>
   <_SERVERUSER type=”__AttributeList”>
   <Name>W0002-076</Name>
   </_SERVERUSER>

<_EXPORT type=”__AttributeList”>
<Duration>24;35;29</Duration>
<Modified_Date>7/31/2014 9:52:50</Modified_Date>
<Creation_Date>7/28/2014 11:52:29</Creation_Date>
<CFPS>59.94</CFPS>
<Color></Color>
<End>02;52;03;01</End>
<FPS>59.94</FPS>
<Lock></Lock>
<Offline></Offline>
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<Start>02;27;27;02</Start>
<Tracks>V1 A1-8 TC1</Tracks>
<_HEADFRAMEOFFSET>0</_HEADFRAMEOFFSET>
<_HEADFRAMEIMAGE type=”Unknown”>
ccaa73d1-f538-11d3-a081006094eb75cb

</_HEADFRAMEIMAGE>
</_EXPORT>

</MobAttributeList>
</Metadata>

[...]

</AAFProcessor>

The metadata tags in the output file correspond to a point-separated Location 
Metadata ID.

For example:

<metadata><mobAttributList><export><start>

corresponds to

metadata.mobAttributeList.export.start
<Metadata type=”TVDM”>
<MobAttributeList id=”60958183-47b1-11d4-a01c0004ac969f50”> 

   […]
<_EXPORT type=”__AttributeList”>
[…]
<Start>02;27;27;02</Start>
[…]

</_EXPORT>
</MobAttributeList>

</Metadata>

Adding a Metadata Mapping
To add a metadata mapping to the Storage Location, do the following:

1. Click the Location Metadata Mapping button on the Storage Location Configuration 
page.

2. To add default metadata mappings, click Add Mapping.

3. Kumulate loads the default metadata mappings into the Storage Location.
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Note: The default metadata mapping is different for Avid Standalone and Avid 
Interplay locations.

The metadata mapping table has three columns:

The default metadata mapping may not correspond to the actual metadata in the AAF 
file, or the user may prefer that some metadata be mapped differently from the default.

If a metadata mapping needs to be changed, it can be modified by clicking the pencil 
icon.

For example, if the Asset/Default/Title Kumulate metadata needs to get its value from 
extractGroup.name rather than from metadata.userComments.name as set by default, 
click the pencil icon next to that line.

The Modify Metadata Mapping page shows the current metadata mapping.

You can modify both the Kumulate and the Location Metadata IDs. However, if both the 
Kumulate metadata and the AAF metadata need to be modified, create a new 
metadata mapping.

Column Description

Location Metadata ID The path to the metadata in the AAF file.

KUMULATE METADATA ID The Kumulate metadata that will be assigned the AAF 
metadata.

Mapping Type Can be Direct or Mapped. 

If the metadata is Mapped, the metadata in the AAF file is 
mapped to a value that is then used as the Kumulate 
metadata; otherwise the metadata in the AAF file is 
assigned to the Kumulate metadata directly.
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In the following example only the Location Metadata ID needs to be modified:

Select extractGroup.name from the Location Metadata ID pull down menu as shown.

Note: If the AAF metadata that needs to be mapped is not in the pull down menu, it 
can be added manually.

Creating a New Metadata Mapping
If an additional metadata mapping between location metadata and AAF metadata, it 
can be created and added to the list of metadata mappings.

Note: The AAF metadata must already exist in the Kumulate Metadata ID pull down 
menu. If the metadata does not exist in the drop down menu, it must be 
added.

Use the following procedure to create a new metadata mapping:

1. On the Storage Location Configuration page, click Location Metadata Mapping.

2. On the Metadata Mapping page, click Add Metadata Mapping.

3. From the Location Metadata ID drop-down menu, select the AAF file metadata.

4. From the MassStore Metadata ID drop-down menu, select the Kumulate metadata 
field to assign to the AAF metadata.

5. From the Mapping Type drop-down menu, select the mapping type.

6. If you select the Date mapping type, also select the date format.

7. On the Add New Mapping Attribute page, in the Location Value text box, add the 
expected location value from the AAF.

8. In the MassStore value text box, add the value to use in the Kumulate metadata.

7. To save click OK.
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7. To save click OK.

The mapping appears in the Metadata Mapping List.

Kumulate metadata is populated with the information extracted from the AAF file.

Adding AAF Metadata
When a new metadata mapping is created, map the metadata from the AAF file to 
Kumulate metadata. The available AAF metadata is visible from the Location Metadata 
ID drop-down menu.

If the AAF metadata needed for the mapping is not in the drop-down menu, it can be 
added by modifying AVID_UNC_location_metadata.properties and aaf-xml-
entries.xml.

To add AAF Metadata, do the following:

1. On the Kumulate server host, change directory to C:\Program Files\Apache Software 
Foundation\Tomcat 8.5\webapps\montana\WEB-INF\classes\.

2. Open the AVID_UNC_location_metadata.properties file.

3. Convert the metadata xml tags in the AAF file to a point-separated name.

For example, the AAF metadata xml path <metadata><slots><Descriptive-
Marker><UserComments><Comment> corresponds to 
metadata.slots.DescriptiveMarker.UserComments.Comment.

4. Add the point-separated AAF metadata ID to the list of IDs: 

metadata.mobAttributeList.systemColumnData.columnVideoFileFormat
metadata.timecodeInfo.duration
metadata.timecodeInfo.cfps
metadata.timecodeInfo.start
metadata.timecodeInfo.end
metadata.slots.DescriptiveMarker.UserComments.Comment

5. Save AVID_UNC_location_metadata.properties.

6. Open aaf-xml-entries.xml (located in the same directory), and create an entry 
for the new Location Metadata ID.

7. Each MetadataInfo entry in the aaf-xml-entries.xml file associates the point-
separated name used in the Location Metadata ID field with the xml path in the AAF 
file.

8. For example, to add metadata.slots.DescriptiveMarker.UserComments.Comment, 
add the following at the end of the file, before the </MetadataInfo> closing tag:

<MetadataInfo>
  <MetadataName>
    metadata.slots.DescriptiveMarker.UserComments.Comment
  </MetadataName>
  <Type>TEXT</Type>
  <Tag>
    /Metadata[0]/Slots[0]/DescriptiveMarker[0]/UserComments[0]/
Comment[0]
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  </Tag>
</MetadataInfo>

9. Save aaf-xml-entries.xml.

10. Stop and start the Tomcat server to restart Kumulate.

11. The newly-added metadata ID appears in the drop-down list.
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Omneon FTP Storage Locations
Note: Omneon Spectrum and Media Deck are now known as Harmonic Spectrum 

Family. However, the configuration name for this type of Storage Location 
remains Omneon FTP, and the capture type remains OMNEON.

An Omneon FTP Storage Location consists of a Harmonic Spectrum video server, or an 
Omneon Spectrum or Media Deck video server, connected to a Kumulate server 
through location on an FTP server. Kumulate monitors the FTP server location for new 
instances.

Omneon FTP File and Folder Formats
An Omneon FTP Storage Location only supports reference MOV files. A reference MOV 
file is essentially a file containing a list of MOV files. The MOV files in the list are stored in 
a separate directory.

When Kumulate discovers a reference MOV file, Kumulate transfers the file, opens it to 
obtain its list of files, then copies in the files in the list.

Files that are transferred from Kumulate to the video server are also placed on the FTP 
server.

The reference MOV files are generally located under the clip.dir directory. The media 
files referenced by the MOV files are located in the clip.dir/media.dir directory.

Configuring Omneon FTP Storage Locations
An Omneon FTP Storage Location is typically configured as both a copy-in and a copy-
out location. Each Omneon FTP Storage Location is configured to discover MXF, self-
contained MOV, or reference MOV files. An Omneon FTP Storage Location can handle 
either self-contained MOV files or reference MOV files, but not both.

Use the following procedure to configure an Omneon FTP Storage Location:

1. Log in to Kumulate.

See Logging In.

2. Browse to the administration tools.

See Finding the Administrator Tools.

3. From the ADMINISTRATION page menus, select Locations > Storage.

4. Click the Add New Location button to create a new Storage Location.

5. Enter a name and description for the Storage Location. Then, click OK.

6. Select the Monitoring tab and set API Protocol to FTP, and Capture Format to 
Omneon.
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7. Click OK to continue. 

Kumulate displays a warning asking if you want to submit the change to the Stor-
age Location.

8. Click OK to continue.

Kumulate opens the Connection tab.

9. Select the Monitoring tab.

10. Set Capture Format to OMNEON.

11. Click OK to continue to the Connection tab.

12. Enter the FTP credentials in the text boxes. Set the Directory parameter to the FTP 
root directory. Set Extract Metadata to NO.

Kumulate uses Active FTP by default.

13. To use Passive FTP, set Use Passive Mode (if server supports it) to YES.

Note: The FTP connection defaults back to Active if the Passive FTP connection fails.

14. Click OK to continue.

Kumulate displays a warning asking if you want to submit the change to the Stor-
age Location.

15. Click OK to continue to the Connection tab.

16. Navigate to the Monitoring tab.

17. Set API Hostname, Clip Dir (Omneon), Files Dir Enable, Files Patterns (Include), Media 
Dir (Omneon), and Monitoring, as follows:

See Avid Standalone Storage Locations and Settings for Omneon FTP Transfer for the 
complete list of applicable values.

Parameter Description

API HostName The FTP hostname or IP address. Must be the same as that 
used under the Connection tab.

Clip Dir (Omneon) The FTP folder used for the clip files. This directory contains 
the MXF and MOV files, including reference MOV files. The 
folder will generally be named clip.dir.

Files Dir Enable Must be set to YES.

Files Patterns (Include) The file type extensions to discover on the Storage Location. 
The extensions should be separated by a comma (,) if both 
MXF and MOV files will be discovered.

Media Dir (Omneon) The FTP folder for media files referenced by the reference 
MOV files. The folder will generally be named 
clip.dir\media.dir.

Monitoring Set Monitoring to ON.
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10. To save the configuration, click OK.

Values for Monitoring Omneon FTP

Caution: Don’t modify any parameter not in the following list. Modifying an 
unlisted parameter might affect Kumulate operations.

Set the values on the Monitoring tab for Omneon FTP Storage Locations as follows:

■ API HostName

The IP address of the FTP server.

■ API Protocol

Always set to FTP.

■ Capture Format

Omneon FTP Storage Locations must have Capture Format set to OMNEON.

■ Clip Dir (Omneon)

This is the FTP directory used for the clip files. This directory contains the MXF and 
MOV files, and includes the reference MOV files.

The MXF and MOV files (including reference MOV files) are typically kept in the 
clip.dir directory. This directory may be different in certain configurations. The files 
referenced by reference MOV files are stored in a subdirectory. The Media Dir 
(Omneon) parameter must point to this directory.

■ Delete Content From Archive

Delete Content From Archive sets whether an asset's archived instances are deleted 
when the physical instance on the Storage Location changes.

When an instance changes on the Storage Location, the existing instance is deleted 
and replaced with the changed instance.

Setting Delete Content From Archive to YES will also delete all instances located on 
Archive Locations when the physical instance on the Storage Location changes.

If the Delete Asset With No Instances parameter in the Asset Manager module is set 
to ON, and the asset does not contain any other Storage Location Instances in addi-
tion to the one that has changed, the asset will be deleted and a new asset will be 
created for the changed instance. 

Delete Content From Archive is set to NO by default. 

Note: Delete Content From Archive has no effect when discriminators are used by the 
location.

■ Delete From Video Server

Allows the deletion of files from the Storage Location after they have been copied 
in to Kumulate.
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■ Delete Timeout

The amount of time to wait for a file to be physically deleted from the video server. 

If the timeout is reached and the file has not been deleted, the operation fails and 
the file will no longer be visible. However, it may remain in an unusable state on the 
video server.

■ Files Dir Enable

Indicates whether the full directory structure of the folder on the FTP server is rec-
reated on the cache.

Setting Files Dir Enable to YES recreates the entire directory structure on the cache. 
This allows Kumulate to transcode the files and create proxies. Setting the parame-
ter to NO only creates file proxies on the cache.

Note: Files Dir Enable must be set to YES in Omneon FTP Storage Locations.

■ Files Patterns (Include)

The file type extensions to discover on the Storage Location and must be set to 
MOV. This value is used to populate the wrapper metadata.

■ Ignore List

Kumulate will not copy-in any files that appear in this list. Ignore List can either be a 
list of filenames or a regular expression.

■ Media Dir (Omneon)

The FTP directory used for media files referenced by reference MOV files.

The MXF and MOV files (including reference MOV files) are kept in the Clip Dir 
(Omneon). The MOV files referenced by the reference MOV files are kept in a subdi-
rectory of this directory; typically named media.dir.

■ Monitoring

Specifies whether Kumulate is monitoring the location to discover and copy in new 
instances.

Omneon FTP Storage Locations are generally used to both copy-in and copy-out 
media. Therefore, Monitoring is set to ON. It should only be set to OFF if the Storage 
Location will not be used to discover and copy-in instances.

■ Naming Schema

Determines how the Asset ID is set upon discovery.

Asset ID sets the Asset ID to the root filename of the discovered instance. In this 
case, the Asset Name, Asset ID, and Original Name of the asset will be identical.

UMID sets the Asset ID to a unique UMID. This ensures unique names for all assets. 
The Asset Name will still be the root filename of the discovered instance.

Note: Neither instance nor asset discriminators can be used when Naming Schema is 
set to Asset ID.
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■ Polling Begin Time, Polling End Time, Polling Interval(sec)

Controls the frequency at which Kumulate polls the FTP server.

Polling Begin Time and Polling End Time instruct Kumulate to poll the Storage 
Location only between Polling Begin Time and Polling End Time. These values are 
based on the 24-hour clock, and can only be set to hours.

Polling Interval(sec) instructs Kumulate to poll the Storage Location every specified 
number of seconds. The interval begins when the discovery operation ends. The 
minimum value for this interval is 10s. Setting this parameter to 0 effectively sets it 
to 10s.

Settings for Omneon FTP Transfer

Caution: Don’t modify any parameter not in the following list. Modifying an 
unlisted parameter might affect Kumulate operations.

The following settingss on the Transfer tab are used by Omneon FTP Storage Locations.

■ Capture Mode

The capture mode specifies whether the physical file on this Storage Location is 
kept or deleted after its instance is transferred to another location.

MOVE deletes the physical file from this location after the transfer, while COPY 
keeps it.

■ Checksum Type and Checksum Validation

Instance checksums are calculated to ensure that instance data is not corrupted.

When an instance is copied to the location, its checksum is calculated using the 
algorithm specified by Checksum Type. If the instance's checksum is not already in 
the database, it is added. If the instance's checksum is already in the database, but 
the two checksums do not match, the transfer will fail and an error will be gener-
ated.

If After Write is selected for Checksum Validation an additional check is made after 
the instance has been fully copied to the location. If the checksum of the written 
instance does not match the checksum in the database the transfer will fail.

■ File info command

The FTP command to use to determine whether a file is on an FTP server.

Note: Do not change the value from the default unless the FTP command results in 
errors.
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■ Max Copy In

Only applies when the Storage Location is configured for copying in files, and sets 
the maximum number of concurrent transfers from the Storage Location to Kumu-
late.

The value can be between 0 and 127 where 0 means that there is no limit on the 
number of transfers.

The default value is 0. 

Note: Telestream strongly recommends you change this to a non-zero value.

■ Max Copy Out

This parameter only applies when the Storage Location is configured for copying 
out files, and sets the maximum number of concurrent transfers from Kumulate to 
the Storage Location.

The value can be between 0 and 127 where 0 means that there is no limit on the 
number of transfers. 

The default value is 0.

Note: Telestream strongly recommends you change this to a non-zero value.

■ Overwrite Video Server Instance

When set to NOT ALLOWED, a transfer from Kumulate to the Storage Location will 
fail if the file already exists on the Storage Location.

When set to ALLOWED, the transfer will overwrite the existing file on the Storage 
Location.

■ Restore Using

This parameter specifies how to name the physical file when an instance is trans-
ferred to this Storage Location. There are four options as follows:

Asset ID The file is named using the transferred instance's Asset ID.

Name The file is named using the transferred instance's Asset Name.

Original Name The file is named using the transferred instance's Original 
Name. Original Name contains the name of the asset when its 
source instance was discovered.

Preserve Filenames The filename is not modified after transfer.

The Restore Extension parameter will not be applicable when 
this option is used. If the Storage Location configuration is 
saved after setting this option, Restore Extension will be 
hidden.
Kumulate Administration Guide



Storage Locations
Omneon FTP Storage Locations

65
Note: If the asset source location used Asset ID as the Naming Schema, the Asset ID, 
Asset Name, and Original Name may be identical.

■ Transcode Using

Some files may contain information at the beginning and end of the file that is not 
necessarily meant to be transcoded. This happens most often with commercial 
spots which can have agency information, tags, and blacks appended to the beg-
ging and the end of the advertisement. Selecting SOM and EOM prevents these 
extraneous bits from being transcoded. Additional configuration is needed to use 
EOM and SOM.

When set to SOF and EOF, the entire file is transcoded.

When set to SOM and EOM, only a part of the file is transcoded.

See Start of Message Parameter for more information.

■ Transfer Mode

Always set to Direct FTP.
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Pitchblue FTP Storage Locations
A Pitchblue Storage Location consists of an FTP server connected to Kumulate. 
Kumulate monitors the FTP server for new files and pulls them in. Pitchblue Storage 
Locations are purely used to discover and copy-in assets.

Two new options have been added to the Pitchblue Storage Location configuration in 
Kumulate 3.1 to enable the centralized ingest and subsequent distribution to local 
Kumulate systems. The new options are named Find Media from XML and Instance 
Format.

The Find Media from XML parameter was added to configure the media path discovery 
method. If the parameter is set to YES, Kumulate will extract the discovery file and 
media path from the XML file. If the parameter is set to NO, Kumulate will look for these 
files in the path specified in the XML Path parameter (similar to BXF/EXTREMEREACH).

• The xml files in XML Path are monitored; this can be a relative or absolute path from 
the FTP Connection directory.

• The connection directory is scanned for files matching the name of the XML file 
(excluding the extension).

– All files in the directory are iterated if there are wildcards in the extensions of the 
File Patterns (Include) setting.

– If there are only explicit extensions, Kumulate will attempt to find only files with 
the xml file’s name with the explicit extension; this is faster than iterating all files.

The Instance Format parameter provides the option of different instance formats to 
support configurations where content is transcoded before it arrives in the Kumulate 
Storage Location. The available values are as follows:

• PITCHBLUE (this is the default value)

• MXF

• QT

• MP4

• MPEG2TS

• MPEG2PS
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Pitchblue FTP File and Folder Formats
Kumulate uses the physical FTP server Storage Location to receive content from 
content creators. Kumulate doesn’t transfer instances to Pitchblue Storage Locations.

Pitchblue Storage Locations expect each media file to have a corresponding 
formatsheet file. The formatsheet file is an xml file containing information on how to 
segment their associated media files. It can be saved as an attachment by using the 
Attach XML to Asset parameter.

The root FTP directory will contain two subdirectories: content and xml. The media files 
are located under the content directory and may contain several subdirectories. The 
formatsheets are located in the xml directory. These are searched recursively by 
Kumulate for media files.

Note: If a media file does not have a corresponding formatsheet file, the file will not 
be copied in, and no new asset will be created.
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Configuring Pitchblue FTP Storage Locations
1. Log in to Kumulate.

See Logging In.

2. Browse to the administration tools.

See Finding the Administrator Tools.

3. From the ADMINISTRATION page menus, select Locations > Storage.

4. Click the Add New Location button to create a new Storage Location.

5. Enter a name and description for the Storage Location. Then, click OK.

6. Select the Monitoring tab and set API Protocol to FTP, and Capture Format to 
Pitchblue.

7. Click OK to continue.

Kumulate displays a warning asking if you want to submit the change to the Stor-
age Location.

8. Click OK to continue.

Kumulate opens the Connection tab.

9. Select the Monitoring tab.

10. Set Capture Format to Pitchblue.

11. Click OK to continue to the Connection tab.

Kumulate displays a warning asking if you want to submit the change to the Stor-
age Location.
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12. Click OK to continue to the Connection tab.

13. Enter the FTP credentials in the text boxes. Set the Directory parameter to the FTP 
root directory. 

14. Set Extract Metadata to NO.

Kumulate uses Active FTP by default.

15. To use passive FTP, set Use Passive Mode (if server supports it) to YES. 

16. Click OK to continue to the Connection tab.

Note: The FTP connection defaults back to Active if the Passive FTP connection fails.

17. Navigate to the Monitoring tab. The XML Path is relative the root path and must 
point to the path on the FTP server where the format sheets are located. Set API 
Hostname, Asset Name Format, Attach XML to Asset, and Xml Path.

18. Click OK to save the configuration.

Settings for Monitoring Pitchblue FTP Storage Locations

Caution: Don’t modify any parameter not in the following list. Modifying an 
unlisted parameter might affect Kumulate operations.

The following settings under the Monitoring tab are used by Pitchblue FTP Storage 
Locations.

■ API HostName

The IP address of the FTP server.

Parameter Description

API HostName The FTP hostname or IP address. Must be the same as that used 
under the Connection tab.

Asset Name Format The format to use for asset naming. This sets the Asset Name 
metadata, not the Asset ID metadata.

Attach Xml to Asset Set this to YES to upload the formatsheet associated with the 
media to the asset as an attachment.

Set this to NO to discard the formatsheet after it has been 
parsed.

Remove Segment 
ID with List

Use this to exclude events with specific IDs from segments.

This can be used to remove blacks (BLK events) from segments.

Separate multiple IDs with a comma.

Xml Path The path to the location of the formatsheets relative to the root 
FTP directory.
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■ API Protocol

Always set to FTP.

■ Attach XML to Asset

When set to YES, the formatsheet associated with the discovered media file is 
uploaded as an attachment to the new asset.

If this parameter is set to NO, the information in the formatsheet will still be used, 
but the file will not be uploaded as an attachment.

■ Asset Name Format

The format to use when setting the Asset Name. With the exception of the Original 
Name option, the naming information is extracted from the media file's associated 
formatsheet. There are four options as follows:

■ Capture Format

Pitchblue FTP Storage Locations must have Capture Format set to PITCHBLUE.

■ Delete Content From Archive

Delete Content From Archive sets whether an asset's archived instances are deleted 
when the physical instance on the Storage Location changes.

When an instance changes on the Storage Location, the existing instance is deleted 
and replaced with the changed instance.

Setting Delete Content From Archive to YES will also delete all instances located on 
Archive Locations when the physical instance on the Storage Location changes.

If the Delete Asset With No Instances parameter in the Asset Manager module is set 
to ON, and the asset does not contain any other Storage Location Instances in addi-
tion to the one that has changed, the asset will be deleted and a new asset will be 
created for the changed instance.

This parameter is set to NO by default. 

Note: Delete Content From Archive has no effect when discriminators are used by the 
location.

Naming Option Description

Short Name + Episode Number Concatenate the short name and episode 
number to create the Asset Name.

Short Name + Job ShortName + 
Episode Number + Run ShortName

Concatenate the short name, job short name, 
episode number, and run short name to 
create the Asset Name.

Short Name + Episode Number [+ Job 
ShortName] [+ Run ShortName]

Concatenate the short name, episode 
number, job short name, and run short name 
to create the Asset Name.

Original Name Use the media file's root name as the Asset 
Name.
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■ Delete From Video Server

Allows the deletion of files from the Storage Location after they have been copied 
in to Kumulate.

■ Delete Timeout

The amount of time to wait for a file to be physically deleted from the video server. 
If the timeout is reached and the file has not been deleted the operation fails. The 
file will no longer be visible, but it may remain in an unusable state on the video 
server.

■ Ignore List

Kumulate will not copy in any files that appear in this list. This parameter can be a 
list of filenames or a regular expression.

■ Monitoring

Indicates whether this Storage Location is to be monitored.

Always set to ON.

■ Naming Schema

Determines how the Asset ID is set upon discovery.

The Asset ID parameter sets the Asset ID to the root filename of the discovered 
instance. In this case, the Asset Name, Asset ID, and Original Name of the asset will 
be identical.

UMID sets the Asset ID to a unique UMID. This ensures unique names for all assets. 
The Asset Name will still be the root filename of the discovered instance.

Note: Neither instance nor asset discriminators can be used when Naming Schema is 
set to Asset ID.

■ Polling Begin Time, Polling End Time, Polling Interval(sec)

Controls the frequency at which Kumulate polls the FTP server.

Polling Begin Time and Polling End Time instruct Kumulate to poll the Storage 
Location only between Polling Begin Time and Polling End Time. These values are 
based on the 24-hour clock, and can only be set to hours.

Polling Interval(sec) instructs Kumulate to poll the Storage Location every specified 
number of seconds. The interval begins when the discovery operation ends. The 
minimum value for this interval is 10s. Setting this parameter to 0 effectively sets it 
to 10s.

■ Remove Segment with ID in (list)

A comma-separated list of event IDs that need to be excluded from segments.

When the formatsheet is parsed to create segments, any events that include these 
IDs will not be included in a segment. If an event with the listed ID is present in a 
segment, the segment will be split around that event.

This parameter is used most often to remove blacks from the video. The event ID 
most likely to need to be removed is the BLK event ID.
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■ Type of Content

This parameter identifies the type of content being monitored.

■ Xml Path

The path to the directory on the FTP server that contains the formatsheets associ-
ated with the media files. The path must be in relation to the root directory.
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Project FTP Storage Locations
Kumulate monitors Project Storage Locations for new directories rather than for new 
files. Kumulate copies in entire directories as an asset, preserving the directory 
structure. This type of Storage Location is useful for archiving and restoring DPX 
projects. In the case of the Project FTP Storage Location, Kumulate monitors an FTP 
server for new directories.

Note: As of Kumulate 8.1, Project Locations can also be configured as UNC locations. 
UNC locations offer better performance over FTP locations and should be used 
instead of FTP locations whenever possible.

Project FTP File and Folder Formats
A project Storage Location consists of an FTP server connected to Kumulate. When 
Kumulate discovers a new directory on the location, it waits for all files under the 
directory to be completely uploaded before copying in the directory as a new asset.

Note: Kumulate will ignore any changes made to the directory after it has been 
copied in. It is strongly recommended that projects only be uploaded to the 
monitored location after the project is complete and no more changes will be 
made to it.

A dominant file is selected to be used for transcodes, for metadata and for thumbnail 
extractions. This file is specified by the Dominant File Location and Dominant File 
Pattern values. If Dominant File Pattern is left blank, the largest file in the directory is 
used. When the asset is copied out, the entire directory structure is preserved.

Configuring Project FTP Storage Locations
A Project FTP Storage Location is typically configured as both a copy-in and a copy-out 
location. Entire directories are copied in and out of the Storage Location.

Note: As of Kumulate 8.1, Project locations can also be configured as UNC locations. 
UNC locations offer better performance over FTP locations, and should be used 
instead of FTP locations when possible.

Use the following procedure to configure Project FTP Locations:

1. Log in to Kumulate.

See Logging In.

2. Browse to the administration tools.

See Finding the Administrator Tools.

3. From the ADMINISTRATION page menus, select Locations > Storage.
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4. Click the Add New Location button to create a new Storage Location.

5. Enter a name and description for the Storage Location. Then, click OK.

6. Select the Monitoring tab and set Capture Format to PROJECT.

7. Click OK to return to the Connection tab.

8. Enter the FTP root directory into the Directory field. Set Extract Metadata to NO. 
Enter the FTP credentials into the appropriate text fields.

9. Do one of the following:

– To use Active FTP, set Use Passive Mode (if server supports it) to NO (default).

– To use Passive FTP, set Use Passive Mode if server supports it) to YES.

Note: The FTP connection defaults back to Active if the Passive FTP connection fails.

10. Click OK to continue.

Kumulate displays a warning  asking if you want to submit the change to the Stor-
age Location.

11. Click OK to continue to the Connection tab.

12. Navigate to the Monitoring tab.

The Dominant File Location and Dominant File Pattern values are used to identify 
the file in the project that will be used for transcodes, metadata extractions, and 
thumbnail extractions

13. Set API Hostname, Dominant File Location, Dominant File Pattern, Files Dir Enable, 
and Monitoring values, as follows:
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See Settings for Monitoring Project FTP for a complete list of applicable values.

9. To save the configuration, click OK.

Settings for Monitoring Project FTP

Caution: Don’t modify any parameter not in the following list. Modifying an 
unlisted parameter might affect Kumulate operations.

The following settings on the Monitoring tab are used by Project FTP Storage Locations.

■ API HostName

The IP address of the FTP server.

■ API Protocol

Always set to FTP.

■ Capture Format

Project FTP Storage Locations must have Capture Format set to PROJECT.

Parameter Description

API HostName The FTP hostname or IP address. Must be the same as that 
used on the Connection tab.

Dominant File Location The directory to search for the file that matches Dominant 
File Pattern. This file will be used for transcodes, metadata 
extractions, and thumbnail extractions.

Set this to All Folders to search the project directory 
recursively for the file.

Set this to Root folder to search only the top-level project 
directory for the file.

Dominant File Pattern A regular expression that matches the file that will be used 
for transcodes, metadata extractions, and thumbnail 
extractions.

If more than one file matches the regular expression the 
largest of the matched files will be used.

If the parameter is left empty the largest file found will be 
used.

If the dominant file is not a media file, the Transcode, 
Extract Thumbnail, and Extract Metadata operations for 
that asset's instances will be disabled.

Files Dir Enable This parameter must be set to YES.

Monitoring Set this parameter to ON.
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■ Delete Content From Archive

This parameter sets whether an asset's archived instances are deleted when the 
physical instance on the Storage Location changes.

When an instance changes on the Storage Location the existing instance is deleted 
and replaced with the changed instance.

Setting Delete Content From Archive to YES will also delete all instances located on 
Archive Locations when the physical instance on the Storage Location changes.

If the Delete Asset With No Instances parameter in the Asset Manager module is set 
to ON, and the asset does not contain any other Storage Location Instances in addi-
tion to the one that has changed, the asset will be deleted and a new asset will be 
created for the changed instance.

The default setting is NO. 

Note: This parameter has no effect when discriminators are used by the location.

■ Delete From Video Server

Allows the deletion of files from the Storage Location after they have been copied 
in to Kumulate.

■ Delete Timeout

The amount of time to wait for a file to be physically deleted from the video server. 

The operation will fail if the timeout is reached and the file has not been deleted. 
The file will no longer be visible, but it may remain in an unusable state on the 
video server.

■ Dominant File Location, Dominant File Pattern

These two values provide information about the location and name of the project's 
dominant file. The dominant file is the media file used for transcoding, thumbnail, 
and metadata extraction.

Setting Dominant File Location to Root folder will only search the top-level folder 
for the dominant file. Setting it to All folders searches the project's entire directory 
tree for the dominant file.

Dominant File Pattern is a regular expression that matches the file used for meta-
data extraction.

The largest of the files will be used if more than one file matches Dominant File Pat-
tern.

The largest file found will be used as the dominant file if Dominant File Pattern is 
left blank.

If the dominant file is not a media file, the Transcode, Extract Thumbnail, and 
Extract Metadata operations for that asset's instances will be disabled.
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■ Files Dir Enable

Indicates whether the full directory structure of the folder on the FTP server is rec-
reated on the cache.

Setting Files Dir Enable to YES recreates the entire directory structure on the cache. 
This allows Kumulate to transcode the files and create proxies. Setting the parame-
ter to NO only creates file proxies on the cache.

Files Dir Enable must be set to YES in Project FTP Storage Locations.

■ Ignore List

Kumulate will not copy-in and create assets for directories that match this list. 
Ignore List can be a regular expression or a list of directory names.

■ Monitoring

Indicates whether this Storage Location is to be monitored. Set Monitoring to OFF if 
the Storage Location will only be used to copy-out files. Set Monitoring to ON in all 
other cases.

■ Naming Schema

Determines how the Asset ID is set upon discovery.

Asset ID sets the Asset ID to the root filename of the discovered instance. In this 
case, the Asset Name, Asset ID, and Original Name of the asset will be identical.

UMID sets the Asset ID to a unique UMID. This ensures unique names for all assets. 
The Asset Name will still be the root filename of the discovered instance.

Note: Neither instance nor asset discriminators can be used when Naming Schema is 
set to Asset ID.

■ Polling Begin Time, Polling End Time, Polling Interval(sec)

Controls how Kumulate polls the Storage Location.

Polling Begin Time and Polling End Time instruct Kumulate to poll the Storage 
Location only between Polling Begin Time and Polling End Time. These values are 
based on the 24-hour clock, and can only be set to hours.

Polling Interval(sec) instructs Kumulate to poll the Storage Location every specified 
number of seconds. The interval begins when the discovery operation ends. The 
minimum value for this interval is 10s. Setting this parameter to 0 effectively sets it 
to 10s.

Settings for Project FTP Transfer

Caution: Don’t modify any parameter not in the following list. Modifying an 
unlisted parameter might affect Kumulate operations.

Set the values on the Transfer tab for Project FTP Storage Locations as follows:
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■ Capture Mode

This parameter specifies whether the physical file on this Storage Location is kept 
or deleted after its instance is transferred to another location.

MOVE deletes the physical file from this location after the transfer, while COPY 
keeps it.

■ File info command

The FTP command to use to determine whether a file is on an FTP server.

Note: Do not change the value from the default unless the FTP command results in 
errors.

■ Checksum Type and Checksum Validation

Instance checksums are calculated to ensure that instance data is not corrupted.

When an instance is copied to the location, its checksum is calculated using the 
algorithm specified by Checksum Type. The instance's checksum is added to the 
database if it does not already exist. If the instance's checksum exists in the data-
base, but the two checksums do not match, the transfer will fail and an error will be 
generated.

If After Write is selected for Checksum Validation, then an additional check is made 
after the instance has been fully copied to the location. The transfer will fail if the 
checksum of the written instance does not match the checksum in the database.

■ Max Copy In

This parameter only applies when the Storage Location is configured for copying in 
files and sets the maximum number of concurrent transfers from the Storage Loca-
tion to Kumulate.

The value can be between 0 and 127, where 0 means that there is no limit on the 
number of transfers.

The default value is 0.

Note: Telestream strongly recommends you change this to a non-zero value.

■ Max Copy Out

This parameter only applies when the Storage Location is configured for copying 
out files and sets the maximum number of concurrent transfers from Kumulate to 
the Storage Location.

The value can be between 0 and 127, where 0 means that there is no limit on the 
number of transfers.

The default value is 0.

Note: Telestream strongly recommends you change this to a non-zero value.
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■ Overwrite Video Server Instance

Transfers from Kumulate to the Storage Location will fail if the file already exists on 
the Storage Location when set to NOT ALLOWED.

The transfer will overwrite the existing file on the Storage Location when set to 
ALLOWED.

■ Restore Using

This parameter specifies how to name the physical file when an instance is trans-
ferred to this Storage Location. There are four options for Restore Using:

Note: If the asset source location used Asset ID as the Naming Schema, the Asset ID, 
Asset Name, and Original Name may be identical.

■ Transcode Using

Some files may contain information at the beginning and end of the file that is not 
necessarily meant to be transcoded. This happens most often with commercial 
spots which can have agency information, tags, and blacks appended to the beg-
ging and the end of the advertisement. Selecting SOM and EOM prevents these 
extraneous bits from being transcoded. Additional configuration is needed to use 
EOM and SOM.

The entire file is transcoded when set to SOF and EOF.

Only a part of the file is transcoded when set to SOM and EOM.

See Start of Message Parameter for more information.

■ Transfer Mode

Always set to Direct FTP.

Asset ID The file is named using the transferred instance's Asset ID.

Name The file is named using the transferred instance's Asset Name.

Original Name The file is named using the transferred instance's Asset Original 
Name.

Original Name contains the name of the asset when its source 
instance was discovered.

Preserve Filenames The filename is not modified after transfer.

The Restore Extension parameter will not be applicable when 
this option is used. If the Storage Location configuration is 
saved after setting this option, Restore Extension is hidden.
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Project UNC Storage Locations
Kumulate monitors project Storage Locations for new directories rather than for new 
files. Kumulate copies in entire directories into assets preserving the directory structure. 
This type of Storage Location is useful for archiving and restoring DPX projects. In the 
case of the Project UNC Storage Location, Kumulate monitors a UNC location for new 
directories.

Project UNC File and Folder Formats

Note: Prior to Kumulate 8.1, Kumulate connected to the Project location using FTP. 
Systems that were upgraded from earlier versions to 8.1 may still have the FTP 
configuration.

When Kumulate discovers a new directory on the location, it waits for all files under the 
directory to be completely uploaded before copying in the directory as a new asset.

Note: Kumulate ignores any changes made to the directory after it has been copied 
in. It is strongly recommended that projects only be uploaded to the 
monitored location after the project is complete and no more changes will be 
made to it.

A dominant file is selected to be used for transcodes, metadata, and thumbnail 
extractions. This file is specified by the Dominant File Location and Dominant File 
Pattern values. If Dominant File Pattern is left blank, the largest file in the directory is 
used.

When the asset is copied out, the entire directory structure is preserved.

Configuring Project UNC Storage Locations
A Project Storage Location is typically configured as both a copy-in and a copy-out 
location. Entire directories are copied in and out of the Storage Location. Use the 
following procedure to configure a Project UNC Storage Location:

1. Log in to Kumulate.

See Logging In.

2. Browse to the administration tools.

See Finding the Administrator Tools.

3. From the ADMINISTRATION page menus, select Locations > Storage.

4. Click the Add New Location button to create a new Storage Location.

5. Enter a name and description for the Storage Location. Then, click OK.

6. Select the Monitoring tab.

7.  Set Capture Format to PROJECTand API Protocol to UNC
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8. Click OK to return to the Connection tab.

9. Enter the UNC path for root folder of the PROJECT location. Set Extract Metadata to 
NO.

10. Click OK to continue.

Kumulate displays a warning asking if you want to submit the change to the Stor-
age Location.

11. Click OK to continue to the Connection tab.

12. Navigate to the Monitoring tab.

Kumulate uses the Dominant File Location and Dominant File Pattern values to iden-
tify the file in the project used for transcodes, metadata extractions, and thumbnail 
extractions.

13. Set Dominant File Location, Dominant File Pattern, Files Dir Enable, and Monitoring 
values as follows:

See Settings for Monitoring Project UNC for a complete list of applicable values.

9. Click OK to continue to the Connection tab.

10. Select the Transfer tab.

Parameter Description

Dominant File Location The directory to search for the file that matches Dominant 
File Pattern. This file will be used for transcodes, metadata 
extractions, and thumbnail extractions.

Set this to All Folders to search the project directory 
recursively for the file.

Set this to Root folder to search only the top-level project 
directory for the file.

Dominant File Pattern A regular expression that matches the file that will be used 
for transcodes, metadata extractions, and thumbnail 
extractions.

If more than one file matches the regular expression the 
largest of the matched files will be used.

If the parameter is left empty the largest file found will be 
used.

If the dominant file is not a media file, the Transcode, Extract 
Thumbnail, and Extract Metadata operations for that asset's 
instances will be disabled.

Files Dir Enable This parameter must be set to YES.

Monitoring Set this parameter to ON.
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11. Do one of the following:

– Set the Transfer Mode parameter to UNC to use the Kumulate DataMovers to 
transfer files between the video server and Kumulate.

– Set the Transfer Mode parameter to Signiant or Aspera to use these transfer APIs.

Note: To use these modes install Signiant and Aspera.

12. Click OK to continue to the Connection tab.

13. Select the Transfer tab.

14. Set DataMover Repository Path and MassTransit Repository Path to the same UNC 
location that is used for the Directory parameter.

15. To save the changes, click OK.

Settings for Monitoring Project UNC

Caution: Don’t modify any parameter not in the following list. Modifying an 
unlisted parameter might affect Kumulate operations.

Set the values on the Monitoring tab for Project Storage Locations as follows:

■ API Protocol

Set to UNC.

■ Capture Format

Project Storage Locations must have Capture Format set to PROJECT.

■ Delete Content From Archive

This parameter sets whether an asset's archived instances are deleted when the 
physical instance on the Storage Location changes.

When an instance changes on the Storage Location, the existing instance is deleted 
and replaced with the changed instance.

Setting this parameter to YES will also delete all instances located on Archive Loca-
tions when the physical instance on the Storage Location changes.

If the Delete Asset With No Instances parameter in the Asset Manager module is set 
to ON, and the asset does not contain any other Storage Location Instances in addi-
tion to the one that has changed, the asset will be deleted and a new asset will be 
created for the changed instance.

The default setting for this parameter is NO.

Note: Delete Content From Archive has no effect when discriminators are used by the 
location.

■ Delete From Video Server

Allows the deletion of files from the Storage Location after they have been copied 
in to Kumulate.
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■ Delete Timeout

The amount of time to wait for a file to be physically deleted from the video server. 

The operation fails if the timeout is reached and the file has not been deleted. The 
file will no longer be visible, but it may remain in an unusable state on the video 
server.

■ Discovery Method

By default, Kumulate will attempt to open a file for reading to determine whether 
the file has finished copying to the UNC location monitored by the Storage Loca-
tion.

However, in cases where a file is being ingested and written in chunks to the UNC 
location, the file can be opened for reading even if the file has not been completely 
copied. In these situations, Discovery Method should be set to Open for write 
instead. This will cause Kumulate to attempt to open the file for writing to deter-
mine if it has finished being copied to the UNC location. The file will not be discov-
ered until the process writing to it releases it.

■ Dominant File Location, Dominant File Pattern

Dominant File Location and Dominant File Pattern provide information about the 
location and name of the project's dominant file. The dominant file is the media file 
used for transcoding, thumbnail, and metadata extraction.

Dominant File Pattern is a regular expression that matches the file that will be used 
for metadata extraction.

Setting Dominant File Location to Root folder will only search the top-level folder 
for the dominant file. Setting it to All folders will allow Kumulate to search the proj-
ect's entire directory tree for the dominant file.

The largest of the files will be used if more than one file matches Dominant File Pat-
tern.

If Dominant File Pattern is left blank, the largest file found will be used as the domi-
nant file.

If the dominant file is not a media file, the Transcode, Extract Thumbnail, and 
Extract Metadata operations for that asset's instances will be disabled.

■ Files Dir Enable

Indicates whether the full directory structure of the folder on the location is recre-
ated on the cache.

Setting Files Dir Enable to YES recreates the entire directory structure on the cache. 
This allows Kumulate to transcode the files and create proxies. Setting the parame-
ter to NO only creates file proxies on the cache.

This parameter must be set to YES for Project Storage Locations.

■ File Pre-Filter

Excludes files that match a regular expression from discovery.

The pre-filter step occurs before the file pattern inclusion and exclusion. Files that 
match the regular expression are not included in the list of files from which assets 
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can be discovered. This is useful for excluding system files used by video servers, 
such as .ds files. 

Note: Do not use this option with the MXF_OP_ATOM capture format.

■ Ignore List

Kumulate will not copy in and create assets for directories that match this list. 
Ignore List can be a regular expression or a list of directory names.

■ Monitoring

Indicates whether this Storage Location is to be monitored. Set Monitoring to OFF if 
the Storage Location will only be used to copy-out files; set Monitoring to ON in all 
other cases.

■ Naming Schema

Determines how the Asset ID is set upon discovery. Asset ID sets the Asset ID to the 
root filename of the discovered instance. In this case, the Asset Name, Asset ID, and 
Original Name of the asset will be identical.

UMID sets the Asset ID to a unique UMID. This ensures unique names for all assets. 
The Asset Name will still be the root filename of the discovered instance.

Neither instance nor asset discriminators can be used when Naming Schema is set 
to Asset ID.

■ Polling Begin Time, Polling End Time, Polling Interval(sec)

Instructs Kumulate how to poll the Storage Location.

Polling Begin Time and Polling End Time instruct Kumulate to poll the Storage 
Location only between Polling Begin Time and Polling End Time. These values are 
based on the 24-hour clock, and can only be set to hours.

Polling Interval(sec) instructs Kumulate to poll the Storage Location every specified 
number of seconds. The interval begins when the discovery operation ends. The 
minimum value for this interval is 10s. Setting this parameter to 0 effectively sets it 
to 10s.

Settings for Project UNC Transfer

Caution: Don’t modify any parameter not in the following list. Modifying an 
unlisted parameter might affect Kumulate operations.

Set the values on the Transfer tab for Project Storage Locations as follows:

■ Capture Mode

The capture mode specifies whether the physical file on this Storage Location is 
kept or deleted after its instance is transferred to another location.

MOVE deletes the physical file from this location after the transfer; COPY keeps it.
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■ Checksum Type and Checksum Validation

Instance checksums are calculated to ensure that instance data is not corrupted.

When an instance is copied to the location, its checksum is calculated using the 
algorithm specified by Checksum Type. The instance’s checksum is added to the 
database if it does not already exist. If the instance's checksum does exist in the 
database, but the two checksums do not match, the transfer will fail and an error 
will be generated.

If After Write is selected for Checksum Validation an additional check is made after 
the instance has been fully copied to the location. If the checksum of the written 
instance does not match the checksum in the database, the transfer will fail.

■ DataMover Repository Path

This should always be set to the same value as the Directory Connection parameter.

■ MassTransit Repository Path

This should always be set to the same value as the Directory Connection parameter.

■ Max Copy In

Only applies when the Storage Location is configured for copying in files and sets 
the maximum number of concurrent transfers from the Storage Location to Kumu-
late.

The value can be between 0 and 127, where 0 means that there is no limit on the 
number of transfers.

The default value is 0.

Note: Telestream strongly recommends you change this to a non-zero value.

■ Max Copy Out

Only applies when the Storage Location is configured for copying out files and sets 
the maximum number of concurrent transfers from Kumulate to the Storage Loca-
tion.

The value can be between 0 and 127, where 0 means that there is no limit on the 
number of transfers.

The default value is 0. 

Note: Telestream strongly recommends you change this to a non-zero value.

■ Overwrite Video Server Instance

Transfers from Kumulate to the Storage Location will fail if the file already exists on 
the Storage Location when set to NOT ALLOWED.

Transfers will overwrite the existing file on the Storage Location when set to 
ALLOWED.
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■ Restore Using

This parameter specifies how to name the physical file when an instance is trans-
ferred to this Storage Location. There are four options for Restore Using:

Note: If the asset source location used Asset ID as the Naming Schema, the Asset ID, 
Asset Name, and Original Name may be identical.

■ Transcode Using

Some files may contain information at the beginning and end of the file that is not 
necessarily meant to be transcoded. This happens most often with commercial 
spots which can have agency information, tags, and blacks appended to the beg-
ging and the end of the advertisement. Selecting SOM and EOM prevents these 
extraneous bits from being transcoded. Additional configuration is needed to use 
EOM and SOM.

The entire file is transcoded when set to SOF and EOF.

Only a part of the file is transcoded when set to SOM and EOM.

See Start of Message Parameter for more information.

■ Transfer Mode

Set the value to UNC to use the Kumulate DataMovers to transfer files between the 
video server and Kumulate.

Set the value to Signiant or Aspera to use these transfer APIs.

Note: To use these modes install Signiant and Aspera.

Asset ID The file is named using the transferred instance's Asset ID.

Name The file is named using the transferred instance's Asset Name.

Original Name The file is named using the transferred instance's Original 
Name. Original Name contains the name of the asset when its 
source instance was discovered.

Preserve Filenames The filename is not modified after transfer.

The Restore Extension parameter will not be applicable when 
this option is used. If the Storage Location configuration is 
saved after setting this option, Restore Extension will be hidden.
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UNC Storage Locations
UNC Storage Locations are locations connected to Kumulate via the UNC protocol. You 
can use several capture formats with UNC Storage Locations. Configure the Storage 
Location in the same way for all capture formats, with minor differences per format.

Configuring UNC Repositories without Metadata Sidecar 
Files

Typically, you configure an UNC Storage Location as both a copy-in and a copy-out 
location. To configure UNC without metadata sidecar files, do the following:

1. Log in to Kumulate.

See Logging In.

2. Browse to the administration tools.

See Finding the Administrator Tools.

3. From the ADMINISTRATION page menus, select Locations > Storage.

4. To create a new Storage Location, click Add New Location.

5. Enter a name and description for the Storage Location, then click OK.

6. Select the Monitoring tab.

7. Set API Protocol to UNC, Capture Format to the file format that will be copied in and 
out to the video server, and Monitoring to ON. 

See Settings for Monitoring UNC Storage Locations for details.

8. Click OK to return to the Connection tab.

9. Select the Monitoring tab and confirm that Vendor Id  (now visible) is set to SPOT.

10. Click OK to return to the Connection tab.

11. Set Extract Metadata to NO.

12. Enter the shared UNC directory into the Directory field. 

13. Click OK to return to the Connection tab.

14. To use the Kumulate DataMovers to transfer files between the video server and 
Kumulate, select the Transfer tab.

15. Set Transfer Mode to UNC.

16. Set the value to Signiant or Aspera to use these transfer APIs.

Note: To use these modes install Signiant and Aspera.

17. Click OK to save the changes.
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Configuring UNC Repositories with Extreme Reach 
Metadata Sidecar Files

You can configure UNC locations to use metadata sidecar files in xml format.

Metadata sidecar files contain metadata not found in the accompanying media file. You 
can map this metadata to Kumulate metadata in the Storage Location configuration.

The Vendor ID parameter (visible when Import Metadata is set to YES) provides two 
options for sidecar metadata processing: SPOT and GENERIC XML.

Use the SPOT option specifically for metadata files created with Extreme Reach 
software. In addition to allowing metadata to be mapped from the sidecar file, this 
option allows you to transcode a commercial spot automatically, without its pre-
frames.

Use the GENERIC XML option with xml metadata files created with any software.

Use the SPOT UNC Storage Location configuration specifically for Storage Locations 
containing media files with Extreme Reach sidecar metadata files.

You can use the SPOT configuration also to automatically remove any frames that come 
before or after a commercial spot. In many cases, these additional frames contain 
advertising-agency information you don’t need to transcode. Kumulate removes these 
frames automatically if the TranscodeUsing parameter is set to SOM and EOM.

Use the following procedure to configure UNC using Extreme Reach:

1. Log in to Kumulate.

See Logging In.

2. Browse to the administration tools.

See Finding the Administrator Tools.

3. From the ADMINISTRATION page menus, select Locations > Storage.

4. To create a new Storage Location, click Add New Location.

5. Enter a name and description for the Storage Location, then click OK.

6. Select the Monitoring tab.

7. Set API Protocol to UNC, Capture Format to GENERIC, Import Metadata to YES, and 
Monitoring to ON.

See Settings for Monitoring UNC Storage Locations for details.

8. Click OK.

9. Select the Monitoring tab. Confirm that the Vendor Id parameter (now visible) is set 
to SPOT.

10. Click OK to return to the Connection tab.

11. Enter the FTP credentials in the text boxes.

12. Set Extract Metadata to NO.

13. Enter the shared UNC directory into the Directory field.

14. Click OK to return to the Connection tab.
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15. Select the Transfer tab.

16. To use the Kumulate DataMovers to transfer files between the video server and 
Kumulate, set the Transfer Mode parameter to UNC.

17. Set the value to Signiant or Aspera to use these transfer APIs.

Note: To use these modes install Signiant and Aspera.

18. Click OK to returned to the Connection tab.

19. Select the Transfer tab.

20. Do one of the following:

• If you want the entire file transcoded, set the Transfer Using parameter to SOF and 
EOF.

• Select SOM and EOM if only the commercial spot is to be transcoded, without the 
leading and trailing frames.

21. Click OK to continue.

22. Select the Transfer tab.

23. Set DataMover Repository Path and MassTransit Repository Path to the same UNC 
location used for the Directory field.

24. Click OK to save the changes.

Configuring UNC Repositories with Generic Metadata 
Sidecar Files

The Generic XML UNC Storage Location configuration is used to extract additional 
metadata from sidecar files. Any sidecar file can be used provided it is in xml format. 
The structure of the expected xml files must be known.

1. Log in to Kumulate.

See Logging In.

2. Browse to the administration tools.

See Finding the Administrator Tools.

3. From the ADMINISTRATION page menus, select Locations > Storage.

4. To create a new Storage Location, click Add New Location.

5. Enter a name and description for the Storage Location, then click OK.

6. Select the Monitoring tab.

7. Set API Protocol to UNC, Capture Format to GENERIC, Import Metadata to YES, and 
Monitoring to ON. 

See Settings for Monitoring UNC Storage Locations for details.

8. Click OK to continue.

9. Select the Monitoring tab.

10. Confirm that the Vendor Id parameter (now visible) is set to GENERIC XML.
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11. Click OK to return to the Connection tab.

12. Enter the FTP credentials in the text boxes. 

13. Set Extract Metadata to NO.

14. Enter the shared UNC directory into the Directory field.

15. Click OK to continue to the Connection tab.

16. Select the Transfer tab.

17. Do one of the following:

• To use the Kumulate DataMovers to transfer files between the video server and 
Kumulate, set Transfer Mode to UNC.

• To use these transfer APIs, set the value to Signiant or Aspera.

Note: To use these modes install Signiant and Aspera.

18. Click OK to continue.

19. Select the Transfer tab.

20. Set DataMover Repository Path and MassTransit Repository Path to the same UNC 
location used for the Directory parameter.

21. Click OK to save the changes.

Mapping Sidecar Metadata
To use the metadata in the metadata sidecar xml files, map the sidecar file to Kumulate 
metadata elements.

The following conditions must be met for the metadata to be mapped correctly:

• The sidecar metadata file must be in xml format.

• The sidecar metadata file must have the same root name as the media file. For 
example, if the media file is named MyMediaFile.mpg, the sidecar file must be 
named MyMediaFile.xml.

• The structure of the sidecar metadata files must be known.

• There can be no typographical errors in the mapping.

If any of these conditions are not met, Kumulate won’t generate any errors or messages. 
To map the metadata between the sidecar file and Kumulate, do the following :

1. Click the Location Metadata Mapping button on the Storage Location Configuration 
page.
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2. Click Add Mapping to add a mappings.

3. In the Xpath Location Metadata ID, add the xpath to the metadata in the sidecar 
file. For example, enter /ER_AD/TITLE_DESC in Xpath Location Metadata ID to 
extract the TITLE_DESC metadata from a sidecar file that looks like this:

Note: Do not add an extra / at the end of the xpath.

<?xml version=”1.0” encoding=”utf-8”?>
<ER_AD>

<TITLE_DESC>New Game Cutdown/Kids/Fri/HD :15</TITLE_DESC>
<ISCI_CODE>DIMI1543H</ISCI_CODE>
<PRODUCT_DESC>WDSMP/Million Dollar Arm</PRODUCT_DESC>
<PLAY_LENGTH>00:00:15:00</PLAY_LENGTH>
<START_TIME>00:00:07:00@29.97</START_TIME>
<COMPRESSION_LEVEL_CODE>4:2:2</COMPRESSION_LEVEL_CODE>
<ENCODER_TYPE_DESC>Extreme Reach</ENCODER_TYPE_DESC>
<OUTPUT_RATE>29.97</OUTPUT_RATE>
<FILE_NAME>DIMI1543H.mpg</FILE_NAME>
<FILE_SIZE>114523208</FILE_SIZE>
<COPY_DATE>2014-05-07T12:13:29.7415861Z</COPY_DATE>
<ADVERTISER>WDSMP/Million Dollar Arm</ADVERTISER>
<AGENCY_VENDOR>Walt Disney Studios Motion Pictures</AGENCY_VENDOR>
<SPOT_TYPE>HD</SPOT_TYPE>
<MEDIA_DESCRIPTION>HD1080i</MEDIA_DESCRIPTION>
<SUPPORT_EMAIL>support@extremereach.com</SUPPORT_EMAIL>

</ER_AD>

4. Select the Kumulate metadata to populate with the selected sidecar metadata from 
the Kumulate Metadata ID pull down menu.

For example, to populate the Asset Title with the sidecar metadata, select Asset/
Asset Information/Title from the pull down menu.

5. Choose the mapping type from the Mapping Type pull down menu.
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Note: The Unix Timestamp type is not used.

With the Date mapping type, the date format must also be selected.

With the Mapped Value type, the mapped value must be set. The Date mapping 
supports the following formats in the metadata file:

YY/MM/DD YYYY/MM/DD YYYY-MM-DD YYYY-MM-DD hh:mm:ss

YYYY-MM-
DDThh:mm:ss

YYYY-MM-
DDThh:mm:ss.s

YY-MM-
DDThh:mm:ssTDZ

YYYY-MM-
DDThh:mm:ss.sTDZ

D/M/YY DD/MM/YY D/M/YYYY DD/MM/YYYY

MM/DD/YY MM/DD/YYYY M/D/YYYY hh:mm:ss.s
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6. Click the Add Mapping Attribute button.

a. On the Add New Mapping Attribute page, add the expected value from the AAF 
in the Location Value box and add the value to use in the Kumulate metadata in 
the Kumulate value box as shown in the following figure:

b. Click OK to save.
c. Click OK to save.
d. The list of mappings will appear on the Metadata Mapping page as shown in the 

following figure:
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If more than one type of xml file will be used, xpaths for different file structures 
can be mapped to the same Kumulate metadata. Kumulate will search for the 
xpaths in the file, and, if one matches, it will be mapped to the Kumulate meta-
data as shown in the following figure:

7. When an instance is discovered on this Storage Location, the metadata will be 
extracted from its sidecar file and used to populate its Kumulate metadata.

Settings for Monitoring UNC Storage Locations
The following settings on the Monitoring tab are used by UNC Storage Locations.

■ API HostName

The IP address of the FTP server.

■ API Protocol

Always set to UNC.
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■ Capture Format

The capture format used depends on the type of file that will be copied in and out 
of the video server.

■ Delete Content From Archive

Delete Content From Archive sets whether an asset's archived instances are deleted 
when the physical instance on the Storage Location changes.

When an instance changes on the Storage Location, the existing instance is deleted 
and replaced with the changed instance.

Setting this parameter to YES will also delete all instances located on Archive Loca-
tions when the physical instance on the Storage Location changes.

If the Delete Asset With No Instances parameter in the Asset Manager module is set 
to ON, and the asset does not contain any other Storage Location Instances in addi-
tion to the one that has changed, the asset will be deleted and a new asset will be 
created for the changed instance.

This parameter is set to NO by default.

Note: Delete Content From Archive has no effect when discriminators are used by the 
location. 

Capture Format File Type

FCP_UN Final Cut Pro

Leitch Leitch - Used when the video server is a Leitch video server, and 
the files are in Leitch's proprietary format.

MPEG2PS Program Stream MPEG2

MXF All MXF operational patterns except OP_ATOM.

MXF_OP_ATOM MXF OP_ATOM

WM9 Windows Media Player

Generic Any single-file format such as self-contained MOV files, or single-
file MXF files.

Used when the file format is not covered by the other capture 
formats, or when the files can be a mix of any single-file format.

Used for commercial spots, and generic XML files.

Note: Cannot be used with MXF OP_ATOM files.
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■ Delete From Video Server

Allows the deletion of files from the Storage Location after they have been copied 
in to Kumulate.

■ Delete Timeout

The amount of time to wait for a file to be physically deleted from the video server. 

If the timeout is reached and the file has not been deleted, the operation fails. The 
file will no longer be visible, but it may remain in an unusable state on the video 
server.

■ Discovery Method

By default, Kumulate will attempt to open a file for reading to determine whether 
the file has finished copying to the UNC location monitored by the Storage Loca-
tion.

However, in cases where a file is being ingested and written in chunks to the UNC 
location, the file can be opened for read even if the file has not been copied com-
pletely. In these situations, Discovery Method should be set to Open for write 
instead. This will cause Kumulate to attempt to open the file for writing to deter-
mine if it has finished being copied to the UNC location. The file will not be discov-
ered until the process writing to it releases it.

■ Files Dir Enable

Indicates whether the full directory structure of the folder on the FTP server is rec-
reated on the cache.

Setting Files Dir Enable to YES recreates the entire directory structure on the cache. 
This allows Kumulate to transcode the files and create proxies. Setting the parame-
ter to NO only creates file proxies on the cache.

Files Dir Enable must be set to YES when the UNC location uses recursive discovery; 
otherwise it must be set to NO.

■ Files Patterns (Include)

The file type extensions to discover on the Storage Location. This value is used to 
populate the wrapper metadata.

Note: Do not use this option with the MXF_OP_ATOM capture format.

■ Files Patterns (Exclude)

Instructs Kumulate to ignore files with these extensions during discovery.

Note: Do not use this option with the MXF_OP_ATOM capture format.

■ File Pre-Filter

Excludes files that match a regular expression from discovery.

The pre-filter step occurs before the file pattern inclusion and exclusion. Files that 
match the regular expression are not included in the list of files from which assets 
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can be discovered. This is useful for excluding system files used by video servers, 
such as .ds files.

Note: Do not use this option with the MXF_OP_ATOM capture format

■ Ignore List

Kumulate will not copy-in any files that appear in this list. Ignore List can be a list of 
filenames, or a regular expression.

■ Import Metadata

Indicates that additional metadata will be pulled in from metadata sidecar files.

Sidecar files must be in xml format, and they must have the same root names as 
their corresponding media files. All sidecar files on the same Storage Location must 
have the same structure.

If this parameter is set to YES to import metadata from sidecar files, the Vendor Id 
parameter must be set appropriately.

The sidecar metadata must be mapped to Kumulate metadata explicitly.

■ Monitoring

Indicates whether this Storage Location is to be monitored. If the Storage Location 
will only be used to copy-out files, set Monitoring to OFF; otherwise set it to ON.

■ Polling Begin Time, Polling End Time, Polling Interval(sec)

Controls how Kumulate polls the Storage Location.

Polling Begin Time and Polling End Time instruct Kumulate to poll the Storage 
Location only between Polling Begin Time and Polling End Time. These values are 
based on the 24-hour clock, and can only be set to hours.

Polling Interval(sec) instructs Kumulate to poll the Storage Location every specified 
number of seconds. The interval begins when the discovery operation ends. The 
minimum value for this interval is 10s. Setting this parameter to 0 effectively sets it 
to 10s.

■ Recursive Discovery

If instances can be discovered anywhere under the root folder of the Storage Loca-
tion, set this parameter to YES.

Note: FTP Files Dir Enable must be set to YES when Recursive Discovery is set to YES.
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■ Vendor Id

Note: This parameter is only visible when Import Metadata is set to YES.

This parameter indicates the type of sidecar metadata files to expect.

Set Vendor Id to SPOT if Extreme Reach sidecar files will be used; otherwise set it to 
Generic XML.

Settings for UNC Storage Location Transfer 

Caution: Don’t modify any parameter not in the following list. Modifying an 
unlisted parameter might affect Kumulate operations.

Set the values on the Transfer tab for UNC Storage Locations as follows:

■ Capture Mode

The capture mode specifies whether the physical file on this Storage Location is 
kept or deleted after its instance is transferred to another location.

MOVE deletes the physical file from this location after the transfer; COPY keeps it.

■ Checksum Type and Checksum Validation

Instance checksums are calculated to ensure that instance data is not corrupted.

When an instance is copied to the location, its checksum is calculated using the 
algorithm specified by Checksum Type. The instance's checksum is added if it does 
not exist in the database. The transfer will fail and an error will be generated if the 
instance's checksum does exist in the database, but the two checksums do not 
match.

An additional check is made after the instance has been fully copied to the location 
if After Write is selected for Checksum Validation. The transfer will fail if the check-
sum of the written instance does not match the checksum in the database.

■ DataMover Repository Path

This should always be set to the same value as the Directory Connection parameter.

■ MassTransit Repository Path

This should always be set to the same value as the Directory Connection parameter.

■ Max Copy In

This only applies when the Storage Location is configured for copying in files, and 
sets the maximum number of concurrent transfers from the Storage Location to 
Kumulate.

The value can be between 0 and 127, where 0 means that there is no limit on the 
number of transfers.

The default value is 0.

Note: Telestream strongly recommends you change this to a non-zero value.
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■ Max Copy Out

This only applies when the Storage Location is configured for copying out files, and 
sets the maximum number of concurrent transfers from Kumulate to the Storage 
Location.

The value can be between 0 and 127, where 0 means that there is no limit on the 
number of transfers.

The default value is 0.

Note: Telestream strongly recommends you change this to a non-zero value.

■ Overwrite Video Server Instance

A transfer from Kumulate to the Storage Location will fail if the file already exists on 
the Storage Location when set to NOT ALLOWED.

The transfer will overwrite the existing file on the Storage Location when set to 
ALLOWED.

■ Restore Using

Restore Using specifies how to name the physical file when an instance is trans-
ferred to this Storage Location.

Note: If the asset source location used Asset ID as the Naming Schema, the Asset ID, 
Asset Name, and Original Name may be identical.

There are four options for Restore Using as follows:

Asset ID The file is named using the transferred instance's Asset ID.

Name The file is named using the transferred instance's Asset Name.

Original Name The file is named using the transferred instance's Asset Original 
Name.

Original Name contains the name of the asset when its source 
instance was discovered.

Preserve Filenames The file name is not modified after transfer.

The Restore Extension parameter will not be applicable when 
this option is used. If the Storage Location configuration is 
saved after setting this option, Restore Extension will be 
hidden.
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■ Restore Extension

The Restore Extension parameter determines how file extensions are handled 
when files are copied to the Storage Location.

File names and their extensions are preserved when instances are copied between 
locations by default. The Restore Extension parameter allows extensions to be 
added, removed, or replaced.

The New extension, Add extension if no original extension, and Remove specific 
extension work with the Extension parameter. This parameter, though, is not visible 
by default. If the Extension parameter is not visible, click OK to save the configura-
tion, then navigate back to the Transfer tab. The Extension parameter should now 
be visible.

■ Extension

The Extension parameter works with the Restore Extension parameter to replace 
file extensions when instances are copied to the Storage Location.

This parameter is not visible by default. It only becomes visible when Restore Exten-
sion is set to New extension, Add extension if no original extension, or Remove spe-
cific extension.

Value Behavior

Preserve original extension Default behavior. The extension does not 
change when the file is copied to the 
Storage Location.

New extension Changes the existing extension to the 
specified extension.

Remove extension Remove the extension if there is one.

Add extension if no original extension Add the specified extension if the original 
file name does not have an extension.

Remove specific extension Remove only the specified extension; 
preserve all other extensions.
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Note: In some cases, the configuration must be saved after selecting New extension, 
Add extension if no original extension, or Remove specific extension for the 
Extension parameter to become visible.

■ Transcode Using

Some files may contain information at the beginning and end of the file that is not 
necessarily meant to be transcoded. This happens most often with commercial 
spots which can have agency information, tags, and blacks appended to the beg-
ging and the end of the advertisement. Selecting SOM and EOM prevents these 
extraneous bits from being transcoded. Additional configuration is needed to use 
EOM and SOM.

When set to SOF and EOF, the entire file is transcoded.

When set to SOM and EOM, only a part of the file is transcoded.

See Start of Message Parameter for more information.

■ Transfer Mode

Set the value to UNC to use the Kumulate DataMovers to transfer files between the 
video server and Kumulate.

Set the value to Signiant or Aspera to use these transfer APIs.

Note: To use these modes install Signiant and Aspera.

Start of Message Parameter
Media files containing commercial spots will often begin with a series of frames with 
the name of the advertising agency, the name of the spot, and the running time of the 
spot.

Setting the TranscodeUsing parameter to SOM&EOM will remove these frames when an 
instance is transcoded.

UNC Storage Location using the SPOT Vendor ID will automatically remove the pre-
frames without additional configuration from video with Extreme Reach sidecar files.

For UNC Storage Locations configured with Generic XML Vendor ID, the pre-frames can 
also be removed, but additional configuration is needed as follows:
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1. To extract pre-frames, the sidecar file must contain the length of the clip, and a 
timestamp in hh:mm:ss:ms format that points to when the commercial spot begins.

2. The start time and length of the clip must be explicitly mapped to the SOM and 
Duration Kumulate metadata fields.

3. After the instance is discovered, extract its metadata.

4. Create the proxy. The pre-frames should now be trimmed.

BXF Storage Locations
A BXF Storage Location consists of an UNC path or FTP server that delivers BXF files to 
Kumulate. Kumulate monitors the location for new files, parses the BXF files for 
metadata and ingests the content.

The BXF Storage Location configuration in Kumulate can enable the centralized ingest 
and subsequent distribution to local Kumulate systems in the following ways:

• Retrieve XML sidecar files from a folder other than the folder for media files. You 
define the path in the Storage Location XML Path parameter. If no path is defined in 
this parameter, Kumulate assumes the sidecar folder is the same as the folder used 
for the media files.

• Retrieve various instance formats when content is transcoded before it arrives in 
the Kumulate Storage Location. You define the format in the Storage Location 
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Instance Format drop-down menu. All instances discovered on the location will 
have this format. The available values are as follows:

a. EXTREMEREACH (this is the default value)
b. MXF
c. QT
d. MP4
e. MPEG2TS
f. MPEG2PS

Configuring BXF Storage Locations
To configure BXF Storage Locations, do the following:

1. Log in to Kumulate.

See Logging In.

2. Browse to the administration tools.

See Finding the Administrator Tools.

3. From the ADMINISTRATION page menus, select Locations > Storage.

4. Create a new Storage Location by clicking the Add New Location button.

5. Enter a name and description for the Storage Location, then click OK.

6. Select the Monitoring tab and set Capture Format to ExtremeReach.

7. Click OK to continue. A warning will appear asking if you want to submit the change 
to the Storage Location. Click OK.

8. Kumulate opens the Connection tab.

9. Enter the UNC directory or FTP credentials and set Extract Metadata to NO.

10. Navigate to the Monitoring tab and set Vendor Id to GENERIC XML.

11. Navigate to the Transfer tab and set the input path for the DataMover. If UNC is used 
as the protocol then set the input path for the Transcode Engine.

12. Click OK to continue.

13. Add the appropriate permissions in the Security area and the endpoint to your 
DataMover.

Mapping BXF Metadata
When Kumulate discovers BXF files, Kumulate maps the BXF metadata to Kumulate 
metadata. There are six default mappings for BXF files, but you can add more.

To map BXF metadata, do the following:

1. Log in to Kumulate.

See Logging In.

2. Browse to the administration tools.

See Finding the Administrator Tools.
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3. From the ADMINISTRATION page menus, select Locations > Storage.

4. To modify the mappings for a location, click its Modify Storage Location button .

5. To navigate to the Metatdata Mapping page for that storage location, click the 
Location Metadata Mapping button.

6. Do one of the following:

– To add a metadata mapping, click the Add Metadata Mapping button.

– To remove a metadata mapping, click the Remove Metadata Mapping button.

7. Modify settings on the Monitoring tab if necessary as follows:

a. Attach XML to Asset.
b. Set ISCI as Title for Commercial segments.
c. Adjust SOM to zero (0).
d. Set Commercial as Note.

8. Validate the location.
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Discriminators and File Identifiers
Use the following values on the Discriminators tab to differentiate between instances 
with the same name on the Storage Location:

• Asset Discriminators

• Instance Discriminators

• File Identifiers

Asset and Instance Discriminators

Note: Discriminators override the Storage Location's Delete Contents From Archive 
setting.

Kumulate uses asset and instance discriminators to determine whether a changed 
instance is the same as or different from an instance already on the Storage Location.

If any of the discriminator metadata values do not match, Kumulate creates a new asset 
for the changed instance.

To compare discriminator values on the Discriminators tab, select discriminator fields 
from the lists on the left and click the right-facing arrow to move them to the lists on 
the right.

For example, to compare instances based on file size and video standard, select File Size 
and Video Standard Instance Discriminators, and click the right arrow to add them to 
the list on the right. When Kumulate detects that the physical instance on the Storage 
Location has changed, Kumulate compares the file size and video standard of the 
original instance to the changed instances. Kumulate creates A new asset for the 
changed instance if either of the two metadata values do not match.

Note: When using discriminators, set Naming Schema to UMID, and Extract Metadata 
to YES. Kumulate doesn’t discover instances on the Storage Location if the 
Storage Location's naming schema is not set to UMID, even if discriminators are 
used.
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Media Composer PMRUpdater Module
Media Composer PMR files are used to keep track of the online resources available to 
the Media Composer Editor. A Media Composer workstation that is not connected to an 
ISIS Storage Location, or is connected to an ISIS location that is not configured to do 
continuous updates to PMR files, will only update its PMR files when there is user input. 
If many files have been added or removed before there is user input, the time required 
for Media Composer will be significant. 

The PMRUpdater runs on the Kumulate server and updates PMR files as soon as 
changes are made to the contents of a PMR file's folder.

Installing Media Composer PMRUpdater Module
The PMRUpdater is installed on the Kumulate Server. PMRUpdater is only available for 
64bit architectures. Use the following procedure to install PMRUpdater:

1. Log in to the Masstech ftp site, ftp.masstech.com, as the Software user, and change 
directory to CORE_PRODUCTS/KUMULATE/AVID Interfaces/.

2. Create a directory on the Kumulate Server named Avid_PMRUpdater under the   
C:\Software\ directory.

3. Download Avid_PMRUpdater to C:\Software\Avid_PMRUpdater\.

4. Navigate to the C:\Software\Avid_PMRUpdater\2014.01.07.1.0.0.2\ directory on the 
Kumulate Server.

5. Run PMRUpdater64Installer.msi as the Administrator, and follow the instructions to 
install the PMRUpdater executable.

Media Repository Path Replacement Examples
The file paths extracted from monitored AAF files point to locations on the Media 
Composer host. These paths must be changed to locations relative to Kumulate for the 
files to be archived. The Media Repository Path and Media Repository String to Replace 
values are used to alter the file paths.
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Video Server Storage 
Locations
You can add, change, and maintain Video Server Storage Locations in Kumulate.

■ Video Server Storage Location Locations

■ K2 Storage Locations

■ Leitch Storage Locations

■ Omneon (Harmonic) Storage Locations

■ Discriminators for Video Server Locations

■ Fast Initialization & Delete Content From Archive
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Video Server Storage Location Locations
Configure each Video Server Storage Location based on the media stored on it and the 
transfer mode used to transfer the media.

Configure each Video Server Storage Location to support a specific instance format. 

Note: Typically, you can transfer an instance to a location only if the format of the 
instance is the format for which the location is configured. However, you could make 
such a transfer if you have a Transcode Profile that can transcode the incoming 
instance to the format specified by the location Restore Profile.

Storage Locations aren’t automatically accessible to users, nor are they automatically 
added to external DataMovers. You must add repositories, explicitly, as endpoints to 
external DataMovers, and you must add them explicitly to user groups.

K2 Storage Locations
A K2 Storage Location consists of a K2 Video Server connected to Kumulate. 
Communication between the video server and Kumulate is done through API calls 
using libraries installed on the Kumulate server.

Media transfers between Kumulate and the video server are done through the video 
server's FTP service.

K2 File and Folder Formats
Kumulate receives a list of clips on the video server. K2 provides metadata information 
about the clips, but does not provide the file format. When Kumulate requests a clip, it 
sends a request to retrieve the clip from an FTP directory that corresponds to a wrapper 
type. The K2 server wraps the clip in the format corresponding to the directory and 
places it in the directory for Kumulate to copy-in.

Clips can be wrapped as GXF, MXF, or MOV. The root FTP directories for the wrapped 
clips correspond to the wrapper types. For example, the root directory for GXF is /GXF/.

The physical clips are stored within a subdirectory generally named default. For 
example, physical GXF files would be located under /GXF/default/. 

For transfers to the K2 Storage Location, Kumulate places the files in their 
corresponding wrapper directories.

Kumulate can only monitor one wrapper type per K2 Storage Location.

Note: K2 does not support files with filename lengths over 32 characters long. 
Copying out a file with a file name longer than 32 characters to a K2 video 
server will fail.
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Configuring K2
A K2 Storage Location is typically configured as both a copy-in and copy-out location. 
Use the following procedure to configure a K2 Storage Location:

1. Log in to Kumulate.

See Logging In.

2. Browse to the administration tools.

See Finding the Administrator Tools.

3. From the ADMINISTRATION page menus, select Locations > Storage.

4. To create a new Storage Location, click Add New Location.

5. Enter a name and description for the Storage Location, then click OK

6. From the Storage Location Configuration page, set Video Server Type to K2.

7. Click OK to continue.

Kumulate displays a warning asking if you want to submit the change to the Stor-
age Location.

8. Click OK to continue.

Kumulate opens the Connection tab.

9. Set the minimum values as follows.

Parameter Description

API HostName The hostname or IP address of the video server. 
This address is used by the API.

Directory The location from where Kumulate requests to 
copy-in clips from the K2 server. The root directory 
dictates the type of wrapper the K2 server will 
apply to the transferred clips. Only GXF, MXF, and 
MOV wrappers are supported.

HostName, Password, Port, User Connection credentials for the FTP server used to 
transfer files.

Max Copy In Sets the maximum number of concurrent transfers 
from the Storage Location to Kumulate.

The default value is 0 and allows an unlimited 
number of concurrent transfers.

Note: It is recommended to change this to a non-
zero value.
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See K2 Settings for the complete list of K2 Storage Location configuration values.

K2 Settings

Caution: Don’t modify any parameter not in the following list. Modifying an 
unlisted parameter might affect Kumulate operations.

Set the values for K2 Storage Locations as follows:

■ API HostName

The hostname or IP address of the video server used by the API.

■ Checksum Type and Checksum Validation

Instance checksums are calculated to ensure that instance data is not corrupted.

When an instance is copied to the location, its checksum is calculated using the 
algorithm specified by Checksum Type. The instance's checksum is added to the 
database if it does not already exist. The transfer will fail and an error will be gener-

Max Copy Out Sets the maximum number of concurrent transfers 
from Kumulate to the Storage Location.

The default value is 0 and allows an unlimited 
number of concurrent transfers.

Note: It is recommended to change this to a non-
zero value.

Monitoring K2 Storage Locations are generally used to both 
copy-in and copy-out media. Monitoring should be 
kept ON unless the Storage Location will only be 
used for copy-out.

Naming Schema Sets whether assets are named using an Asset ID or 
using a UMID.

Note: Instance metadata discriminators cannot 
be used when Naming Schema is set to 
Asset ID. See Fast Initialization & Delete 
Content From Archive for more information.

Remote Dir The server directory monitored by Kumulate. This 
directory must correspond to the directory where 
the K2 server stores its clips.

Parameter Description
Kumulate Administration Guide



Video Server Storage Locations
K2 Storage Locations

111
ated if the instance's checksum exists in the database, but the two checksums do 
not match.

An additional check is made after the instance has been fully copied to the location 
if After Write is selected for Checksum Validation. The transfer will fail if the check-
sum of the written instance does not match the checksum in the database.

■ Delete Content From Archive

This parameter sets whether an asset's archived instances are deleted when the 
physical instance on the Storage Location changes.

When an instance changes on the Storage Location, the existing instance is deleted 
and replaced with the changed instance.

Setting Delete Content From Archive to YES will also delete all instances located on 
Archive Locations when the physical instance on the Storage Location changes.

If the Delete Asset With No Instances parameter in the Asset Manager module is set 
to ON, and the asset does not contain any other Storage Location Instances in addi-
tion to the one that has changed, the asset will be deleted and a new asset will be 
created for the changed instance.

The default setting is NO. 

Note: Delete Content From Archive has no effect when discriminators are used by the 
location

■ Delete From Video Server

Allows the deletion of files from the Storage Location after they have been copied 
in to Kumulate.

■ Delete Timeout

The amount of time to wait for a file to be physically deleted from the video server. 

The operation fails if the timeout is reached and the file has not been deleted. The 
file will no longer be visible, but it may remain in an unusable state on the video 
server.

■ Directory

The location from where Kumulate requests to copy-in clips from the K2 server. The 
root directory dictates the type of wrapper the K2 server will apply to the trans-
ferred clips. Only GXF, MXF, and MOV wrappers are supported. The types of file that 
will be copied in are found in a directory corresponding to their wrapper type as 
follows:

File Type Directory

GXF /GXF/default/

MXF /MXF/default/

MOV /MOV/default/
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Note: The physical files are typically found in the default subdirectory, but may be 
located in other subdirectories.

■ HostName, Password, Port, User

These parameters are the connection credentials for the FTP server used to transfer 
files.

■ Use Passive Mode (if server supports it)

Set this parameter to YES to use passive FTP connections. Passive FTP connections 
allow FTP to be used with firewalls with port forwarding.

It is set to NO by default.

Note: The FTP connection will default back to active FTP if the passive FTP 
connection fails.

■ File info command

The FTP command to use to determine whether a file is on an FTP server.

Note: Do not change the value from the default unless the FTP command results in 
errors.

This parameter is used with the instance detection pattern parameter.

■ Ignore List

Kumulate will not copy-in any files that appear in this list. Ignore List can be a list of 
filenames or a regular expression.

■ ML Direct Transfer

Transfer files directly from the video server to the tape library without creating an 
instance in the cache.

This should only be set to YES if the instance does not need to be transcoded, or if a 
proxy does not need to be created.

■ Max Copy In

This setting only applies when the Storage Location is configured for copying in 
files and sets the maximum number of concurrent transfers from the Storage Loca-
tion to Kumulate.

The value can be between 0 and 127, where 0 means that there is no limit on the 
number of transfers.

The default value is 0.

Note: Telestream strongly recommends you change this to a non-zero value.
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■ Max Copy Out

This setting only applies when the Storage Location is configured for copying out 
files and sets the maximum number of concurrent transfers from Kumulate to the 
Storage Location.

The value can be between 0 and 127, where 0 means that there is no limit on the 
number of transfers.

The default value is 0.

Note: Telestream strongly recommends you change this to a non-zero value.

■ Monitoring

Specifies whether Kumulate is monitoring the location to discover and copy-in new 
instances.

OMNEON Storage Locations are generally used to both copy-in and copy-out 
media. Therefore, Monitoring is set to ON. It should only be set to OFF if the Storage 
Location will not be used to discover and copy-in instances.

■ Monitoring Interval (Seconds)

The amount of time the system waits for the monitoring thread. The thread is 
restarted when this interval passes.

This value should be higher if there are several monitored Storage Locations in the 
Kumulate system.

Note: This parameter should be set with the help of the installation team.

■ Naming Schema

Determines how the Asset ID is set upon discovery.

Setting this to Asset ID sets the Asset ID to the root filename of the discovered 
instance. In this case, the Asset Name, Asset ID, and Original Name of the asset will 
be identical.

Setting this to UMID sets the Asset ID to a unique UMID. This ensures unique names 
for all assets. The Asset Name will still be the root filename of the discovered 
instance.

Note: Neither instance nor asset discriminators can be used when Naming Schema is 
set to Asset ID.

■ Overwrite Video Server Instance

Transfers from Kumulate to the Storage Location will fail if the file already exists on 
the Storage Location when this is set to NOT ALLOWED.

The transfer will overwrite the existing file on the Storage Location when this is set 
to ALLOWED.
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■ Polling Begin Time, Polling End Time, Polling Interval(sec)

Controls how Kumulate polls the Storage Location.

Polling Begin Time and Polling End Time instruct Kumulate to poll the Storage 
Location only between Polling Begin Time and Polling End Time. These parameters 
are based on the 24-hour clock, and can only be set to hours.

Polling Interval(sec) instructs Kumulate to poll the Storage Location every specified 
number of seconds. The interval begins when the discovery operation ends. The 
minimum value for this interval is 10s. Setting this parameter to 0 effectively sets it 
to 10s.

■ Remote Dir

The directory on the K2 server where unwrapped clips are kept. Kumulate queries 
the K2 server through the API for clips in this directory.

■ Restore Using

Restore Using specifies how to name the physical file when an instance is trans-
ferred to this Storage Location. There are four options for Restore Using:

Note: If the asset source location used Asset ID as the Naming Schema, the Asset ID, 
Asset Name, and Original Name may be identical.

■ Transcode Using

Some files may contain information at the beginning and end of the file that is not 
necessarily meant to be transcoded. This happens most often with commercial 
spots which can have agency information, tags, and blacks appended to the beg-
ging and the end of the advertisement. Selecting SOM and EOM prevents these 

Asset ID The file is named using the transferred instance's Asset ID.

Name The file is named using the transferred instance's Asset Name.

Original Name The file is named using the transferred instance's Asset Original 
Name.

Original Name contains the name of the asset when its source 
instance was discovered.

Preserve Filenames The filename is not modified after transfer.

The Restore Extension parameter will not be applicable when 
this option is used. Restore Extension will be hidden if the 
Storage Location configuration is saved after setting this 
option.
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extraneous bits from being transcoded. Additional configuration is needed to use 
EOM and SOM.

The entire file is transcoded when set to SOF and EOF.

Only a part of the file is transcoded when set to SOM and EOM.

See Start of Message Parameter for more information.

■ Transfer timeout

The transfer fails if it has not completed successfully within this amount of time. 
This value should only be changed if transfers routinely time out.

■ Transfer Mode

Always set to Direct FTP.

■ Video Format Type and Video Bitrate

The video format and bitrate information is not returned by the K2 API, but is 
extracted using HQS. Video Format Type and Video Bitrate are used as defaults if 
HQS is not installed.

Video Format Type is the video chroma subsampling. It can be 411, 420, 422, or 444.
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Leitch Storage Locations
A Leitch Storage Location consists of a Leitch video server connected to Kumulate. 
Communication between the video server and Kumulate is done through API calls 
using libraries installed on the Kumulate server.

Media transfers between Kumulate and the video server are done through the video 
server's FTP service.

Leitch File and Folder Formats
All files on a Leitch video server are in a proprietary format. The Leitch server wraps the 
file into either LXF, GXF, MXF, or MOV format, depending on the format Kumulate has 
requested, and makes the files available through the FTP server.

Configuring Leitch
A Leitch Storage Location consists of a Leitch video server connected to Kumulate. Files 
are copied in and copied out through the video server's FTP service. Leitch Storage 
Locations are typically configured as both a copy-in and a copy-out location. Use the 
following procedure to configure a Leitch Storage Location:

1. Log in to Kumulate.

See Logging In.

2. Browse to the administration tools.

See Finding the Administrator Tools.

3. From the ADMINISTRATION page menus, select Locations > Storage.

4. To create a new Storage Location, click Add New Location.

5. Enter a name and description for the Storage Location, then click OK.

6. From the Storage Location Configuration page, set Video Server Type to LEITCH.

7. Click OK to continue.

Kumulate displays a warning asking if you want to submit the change to the Stor-
age Location.

8. Click OK to continue.

Kumulate opens the Connection tab.
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9. Set the minimum parameters as follows:

Parameter Description

API HostName The hostname or IP address of the video server. 
This address is used by the API.

HostName, Password, Port, User Connection credentials for the FTP server used to 
transfer files.

Note: The Leitch FTP service uses port 2098.

Max Copy In Sets the maximum number of concurrent transfers 
from the Storage Location to Kumulate.

The default value is 0 and allows an unlimited 
number of concurrent transfers.

Note: It is recommended to change this to a non-
zero value.

Max Copy Out Sets the maximum number of concurrent transfers 
from Kumulate to the Storage Location.

The default value is 0 and allows an unlimited 
number of concurrent transfers.

Note: It is recommended to change this to a non-
zero value.

Marking Key Used to mark instances on the video server once 
they are discovered.

Leitch Storage Locations should use a short key. If 
this value is left blank, the key value set in the CMI 
module configuration is used.
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See Leitch Settings for the complete list of K2 Storage Location configuration 
parameters

Leitch Settings

Caution: Don’t modify any parameter not in the following list. Modifying an 
unlisted parameter might affect Kumulate operations.

The following parameters are used by Leitch Storage Locations.

■ API HostName

The hostname or IP address of the video server. This address is used by the API.

■ Allow Rename

Allows the renaming of an instance copied out to the video server. Only the physi-
cal file on the video server is renamed; the instance name on Kumulate does not 
change.

This parameter only applies to MMP requests and does not apply to requests made 
through the Kumulate UI.

■ Checksum Type and Checksum Validation

Instance checksums are calculated to ensure that instance data is not corrupted.

When an instance is copied to the location, its checksum is calculated using the 
algorithm specified by Checksum Type. The instance's checksum is added to the 
database if it does not already exist. The transfer will fail and an error will be gener-

Monitoring K2 Storage Locations are generally used to both 
copy-in and copy-out media. Monitoring should be 
kept ON unless the Storage Location will only be 
used for copy-out.

Monitored Extension Wrap discovered instances in the format specified 
by this extension. Only one extension is permitted. 
Allowed extensions are MOV, MXF, GXF, and LXF. 
Defaults to LXF if left blank.

Naming Schema Sets whether assets are named using an Asset ID or 
using a UMID.

Instance metadata discriminators cannot be used 
when Naming Schema is set to Asset ID. See Fast 
Initialization & Delete Content From Archive for more 
information.

Parameter Description
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ated if the instance's checksum exists in the database, but the two checksums do 
not match.

An additional check is made after the instance has been fully copied to the location 
if After Write is selected for Checksum Validation. The transfer will fail if the check-
sum of the written instance does not match the checksum in the database.

■ DefaultVideoBitrate

This bitrate is used if the API does not report the bitrate of a discovered instance. 
This value is only used when the VIDEO_BIT_RATE metadata is not set. See Mapping 
VIDEO_BIT_RATE Metadata for more information.

■ Delete Content From Archive

This parameter sets whether an asset's archived instances are deleted when the 
physical instance on the Storage Location changes.

When an instance changes on the Storage Location, the existing instance is deleted 
and replaced with the changed instance.

Setting Delete Content From Archive to YES will also delete all instances located on 
Archive Locations when the physical instance on the Storage Location changes.

If the Delete Asset With No Instances parameter in the Asset Manager module is set 
to ON, and the asset does not contain any other Storage Location Instances in addi-
tion to the one that has changed, the asset will be deleted and a new asset will be 
created for the changed instance.

The default setting is NO. 

Note: Delete Content From Archive has no effect when discriminators are used by the 
location

■ Delete From Video Server

Allows the deletion of files from the Storage Location after they have been copied 
in to Kumulate.

■ Delete Timeout

The amount of time to wait for a file to be physically deleted from the video server. 

The operation fails if the timeout is reached and the file has not been deleted. The 
file will no longer be visible, but it may remain in an unusable state on the video 
server.

■ HostName, Password, Port, User

Connection credentials for the FTP server used to transfer files.

Note: The Leitch FTP service uses port 2098.

■ Use Passive Mode (if server supports it)

Set this parameter to YES to use passive FTP connections. Passive FTP connections 
allow FTP to be used with firewalls with port forwarding.

It is set to NO by default.
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Note: The FTP connection will default back to active FTP if the passive FTP 
connection fails.

■ File info command

The FTP command to use to determine whether a file is on an FTP server. This 
parameter is used with the instance detection pattern parameter.

Note: Do not change the value from the default unless the FTP command results in 
errors.

■ Ignore List

Kumulate will not copy-in any files that appear in this list. Ignore List can be a list of 
filenames or a regular expression.

■ Use file name length validator for transfers

Leitch video servers only support a maximum file name length of 32 characters. 
Transferring a file with a filename longer than 32 characters to a Leitch video server 
will fail. Setting this parameter to YES verifies that the filename length of a file being 
copied out to the video server does not exceed this maximum. Kumulate will not 
attempt to copy out a file if its filename exceeds 32 characters; in this case Kumu-
late will generate a warning.

If this parameter is set to NO, Kumulate will attempt to copy out the file regardless 
of the length of its filename.

■ Marking Key

The Marking Key is used to mark instances on the video server after they are discov-
ered. This prevents the same instance from being discovered multiple times as 
Kumulate will ignore instances that have already been marked with its key.

The marking key is inserted into the file's wrapper. On Leitch video servers, marking 
keys must be at most 32 characters long. The default marking key should be 
changed to a shorter key that identified the Kumulate system. Each Kumulate sys-
tem must have a unique marking key.

If the Marking Key parameter is left blank, the Processed Keyword parameter from 
the CMI Module Configuration is used.

■ Max Copy In

This setting only applies when the Storage Location is configured for copying in 
files and sets the maximum number of concurrent transfers from the Storage Loca-
tion to Kumulate.

The value can be between 0 and 127, where 0 means that there is no limit on the 
number of transfers.

The default value is 0.

Note: Telestream strongly recommends you change this to a non-zero value.
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■ Max Copy Out

This setting only applies when the Storage Location is configured for copying out 
files and sets the maximum number of concurrent transfers from Kumulate to the 
Storage Location.

The value can be between 0 and 127, where 0 means that there is no limit on the 
number of transfers.

The default value is 0.

Note: Telestream strongly recommends you change this to a non-zero value.

■ Monitoring

Specifies whether Kumulate is monitoring the location to discover and copy-in new 
instances.

LEITCH Storage Locations are generally used to both copy-in and copy-out media. 
Therefore, Monitoring is set to ON. It should only be set to OFF if the Storage Loca-
tion will not be used to discover and copy-in instances.

■ Monitoring Interval (Seconds)

The amount of time the system waits for the monitoring thread. The thread is 
restarted when this interval passes.

This value should be higher if there are several monitored Storage Locations in the 
Kumulate system.

Note: Set this parameter with the help of the installation team.

■ Monitored Extension

Specifies the wrapper format returned by the video server. The video server will 
return instances in this wrapper format, if possible. The transfer will fail if the 
instances cannot be wrapped in this format.

Supported wrapper formats are LXF, MXF, GXF, and MOV and defaults to LXF if it is 
left blank.

■ Naming Schema

Determines how the Asset ID is set upon discovery.

Setting this to Asset ID sets the Asset ID to the root filename of the discovered 
instance. In this case, the Asset Name, Asset ID, and Original Name of the asset will 
be identical.

Setting this to UMID sets the Asset ID to a unique UMID. This ensures unique names 
for all assets. The Asset Name will still be the root filename of the discovered 
instance.

Note: Neither instance nor asset discriminators can be used when Naming Schema is 
set to Asset ID.
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■ Overwrite Video Server Instance

Transfers from Kumulate to the Storage Location will fail if the file already exists on 
the Storage Location when this is set to NOT ALLOWED.

The transfer will overwrite the existing file on the Storage Location when this is set 
to ALLOWED.

■ Polling Begin Time, Polling End Time, Polling Interval(sec)

Controls how Kumulate polls the Storage Location.

Polling Begin Time and Polling End Time instruct Kumulate to poll the Storage 
Location only between Polling Begin Time and Polling End Time. These parameters 
are based on the 24-hour clock, and can only be set to hours.

Polling Interval(sec) instructs Kumulate to poll the Storage Location every specified 
number of seconds. The interval begins when the discovery operation ends. The 
minimum value for this interval is 10s. Setting this parameter to 0 effectively sets it 
to 10s.

■ Restore Using

Restore Using specifies how to name the physical file when an instance is trans-
ferred to this Storage Location. There are four options for Restore Using:

Note: If the asset source location used Asset ID as the Naming Schema, the Asset ID, 
Asset Name, and Original Name may be identical.

■ Transcode Using

Some files may contain information at the beginning and end of the file that is not 
necessarily meant to be transcoded. This happens most often with commercial 
spots which can have agency information, tags, and blacks appended to the beg-
ging and the end of the advertisement. Selecting SOM and EOM prevents these 

Asset ID The file is named using the transferred instance's Asset ID.

Name The file is named using the transferred instance's Asset Name.

Original Name The file is named using the transferred instance's Asset Original 
Name.

Original Name contains the name of the asset when its source 
instance was discovered.

Preserve Filenames The filename is not modified after transfer.

The Restore Extension parameter will not be applicable when 
this option is used. Restore Extension will be hidden if the 
Storage Location configuration is saved after setting this 
option.
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extraneous bits from being transcoded. Additional configuration is needed to use 
EOM and SOM.

The entire file is transcoded when set to SOF and EOF.

Only a part of the file is transcoded when set to SOM and EOM.

See Start of Message Parameter for more information.

■ Transfer timeout

The transfer fails if it has not completed successfully within this amount of time. 
This value should only be changed if transfers routinely time out.

■ Transfer Mode

Always set to Direct FTP.

Mapping VIDEO_BIT_RATE Metadata
The Leitch DefaultVideoBitrate parameter is only used when the Storage Location's 
VIDEO_BIT_RATE metadata is not mapped. However, it is preferable to add the 
VIDEO_BIT_RATE metadata than to use the DefaultVideoBitrate parameter.

Use the following procedure to verify that the VIDEO_BIT_RATE metadata is present:

1. To open the metadata mappings for the Storage Location, click the Location 
Metadata Mapping button at the top of the Storage Location Configuration page.

2. If there is no metadata mapping already in the location, click Add Mapping.

3. Verify that VIDEO_BIT_RATE is present in the Metadata Mapping List and is mapped 
directly to Instance/Video/Video Bitrate.

4. If VIDEO_BIT_RATE is not in the list of mapped metadata, add it by clicking the ADD 
METADATA MAPPING button and selecting VIDEO_BIT_RATE from the Location 
Metadata Mapping drop-down menu.

5. From the Kumulate Metadata ID drop-down menu, map VIDEO_BIT_RATE to 
Instance/Video/Video Bitrate.

6. Set Mapping Type to Direct.

7. Click OK to save.
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Omneon (Harmonic) Storage Locations
Note: Omneon Spectrum and Media Deck are now known as Harmonic Spectrum 

Family. However, the configuration name for this type of Storage Location 
remains Omneon, and the video server type remains OMNEON.

An Omneon Storage Location consists of a Harmonic Spectrum video server, or an 
Omneon Spectrum or Media Deck video server, connected to Kumulate. 
Communication between the video server and Kumulate is achieved through API calls 
using libraries installed on the Kumulate server. Media transfers between Kumulate and 
the video server are completed through an FTP service running on the video server. 
Kumulate receives a register of all the media on the video server.

Omneon (Harmonic) File and Folder Formats
Omneon Storage Locations can contain MXF, self-contained MOV, and reference MOV 
files. A reference MOV file is essentially a list of MOV files stored in a subdirectory.

Kumulate polls the video server through the API to discover new media files. The video 
server provides information about new files and a list of the reference MOV files in any 
reference MOV files that may be available for transfer.

Files that are transferred from Kumulate to the video server are placed on the FTP 
server. Files are generally located under the clip.dir directory. If the media files are 
reference MOV files, the media files referenced by the MOV files are located in the 
clip.dir/media.dir directory.

Configuring Omneon
An Omneon Storage Location is typically configured as both a copy-in and a copy-out 
location. Each Omneon Storage Location is configured to discover MXF, self-contained 
MOV, or reference MOV files.

Use the following procedure to configure an Omneon Storage Location:

1. Log in to Kumulate.

See Logging In.

2. Browse to the administration tools.

See Finding the Administrator Tools.

3. From the ADMINISTRATION page menus, select Locations > Storage.

4. To create a new Storage Location, click Add New Location.

5. Enter a name and description for the Storage Location, then click OK.

6. From the Storage Location Configuration page, set Video Server Type to Omneon.
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7. Click OK to continue.

Kumulate displays a warning asking if you want to submit the change to the Stor-
age Location.

8. Click OK to continue.

Kumulate opens the Connection tab.

9. Set the minimum parameters as follows:

Parameter Description

API HostName The hostname or IP address of the video server. This 
address is used by the API.

Clip Directory The media file directory. This directory is usually 
clip.dir.

Container Extension List The list of file extensions corresponding to the 
types of media files this Storage Location handles. 
Valid values are MOV and MXF. If both MOV and 
MXF files are handled, MOV and MXF must be 
separated by a comma.

HostName, Password, Port, User Connection credentials for the FTP server used to 
transfer files.

Max Copy In Sets the maximum number of concurrent transfers 
from the Storage Location to Kumulate.

The default value is 0 and allows an unlimited 
number of concurrent transfers.

Note: It is recommended to change this to a non-
zero value.

Max Copy Out Sets the maximum number of concurrent transfers 
from Kumulate to the Storage Location.

The default value is 0 and allows an unlimited 
number of concurrent transfers.

Note: It is recommended to change this to a non-
zero value.

Media Directory Version Always set this to 4.0 or higher.

Media Directory The directory used for media files referenced by 
reference MOV files. The directory is usually 
clip.dir\media.dir.
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See Omneon Settings for the complete list of Omneon Storage Location configuration 
parameters.

Omneon Settings

Caution: Don’t modify any parameter not in the following list. Modifying an 
unlisted parameter might affect Kumulate operations.

The following parameters are used by Omneon Storage Locations.

■ API Hostname

The hostname or IP address of the video server used by the API.

■ Allow Rename

Allows the renaming of an instance copied out to the video server. Only the physi-
cal file on the video server is renamed. The instance name on Kumulate does not 
change.

This parameter only applies to MMP requests and does not apply to requests made 
through the Kumulate UI.

■ Clip Directory

The directory used for the clip files.

Files are transferred between the video server and Kumulate using the video 
server's internal FTP server. The MXF and MOV files, including reference MOV files, 
are usually kept in the clip.dir directory. This directory may be different in certain 
configurations.

The files referenced by reference MOV files are stored in a subdirectory. The Media 
Directory parameter must point to this directory.

Monitoring Omneon Storage Locations are generally used to 
both copy-in and copy-out media. Monitoring 
should be kept ON unless the Storage Location will 
only be used for copy-out.

Naming Schema Sets whether assets are named using Asset ID or 
using UMID.

Note: Instance metadata discriminators cannot 
be used when Naming Schema is set to 
Asset ID. See Fast Initialization & Delete 
Content From Archive for more information.

Player Version Always set this to 4.6 or higher.

Parameter Description
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■ Checksum Type and Checksum Validation

Instance checksums are calculated to ensure that instance data is not corrupted.

When an instance is copied to the location, its checksum is calculated using the 
algorithm specified by Checksum Type. The instance's checksum is added to the 
database if it does not already exist. The transfer will fail and an error will be gener-
ated if the instance's checksum exists in the database, but the two checksums do 
not match.

An additional check is made after the instance has been fully copied to the location 
if After Write is selected for Checksum Validation. The transfer will fail if the check-
sum of the written instance does not match the checksum in the database.

■ Container Extension List

The list of file extensions corresponding to the types of media files this Storage 
Location handles. Valid values are MOV and MXF. If both MOV and MXF files are 
handled, MOV and MXF must be separated by a comma.

MOV can refer to either self-contained or reference MOV files.

Note: If two files have the same name except for their extensions, only one file will be 
discovered. For example, if instance.mxf and instance.mov exist on the video 
server, only one of those files will be discovered.

■ Delete Content From Archive

This parameter sets whether an asset's archived instances are deleted when the 
physical instance on the Storage Location changes.

When an instance changes on the Storage Location, the existing instance is deleted 
and replaced with the changed instance.

Setting the Delete Content From Archive parameter to YES will also delete all 
instances located on Archive Locations when the physical instance on the Storage 
Location changes.

If the Delete Asset With No Instances parameter in the Asset Manager module is set 
to ON, and the asset does not contain any other Storage Location Instances in addi-
tion to the one that has changed, the asset will be deleted and a new asset will be 
created for the changed instance.

The default setting is NO. 

Note: Delete Content From Archive has no effect when discriminators are used by the 
location

■ Delete From Video Server

Allows the deletion of files from the Storage Location after they have been copied 
in to Kumulate.
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■ Delete Timeout

The amount of time to wait for a file to be physically deleted from the video server. 

The operation fails if the timeout is reached and the file has not been deleted. The 
file will no longer be visible, but it may remain in an unusable state on the video 
server.

■ HostName, Password, Port, User

The connection credentials for the FTP server used to transfer files.

■ Use Passive Mode (if server supports it)

Set this parameter to YES to use passive FTP connections. Passive FTP connections 
allow FTP to be used with firewalls with port forwarding.

It is set to NO by default.

Note: The FTP connection will default back to active FTP if the passive FTP 
connection fails.

■ File info command

The FTP command to use to determine whether a file is on an FTP server.

Note: Do not change the value from the default unless the FTP command results in 
errors. 

This parameter is used with the instance detection pattern parameter.

■ Ignore extra notify open

Indicates whether to ignore extra OPEN messages sent by the video server to 
Kumulate.

The extra OPEN message can cause Kumulate to fail to add newly-discovered 
instances to its database.

This may not occur with all versions of the video server. The value of this parameter 
should only be changed to YES if discovery errors occur.

■ Ignore List

Kumulate will not copy-in any files that appear in this list. Ignore List can be a list of 
filenames or a regular expression.

■ Max Copy In

This setting only applies when the Storage Location is configured for copying in 
files and sets the maximum number of concurrent transfers from the Storage Loca-
tion to Kumulate.

The value can be between 0 and 127, where 0 means that there is no limit on the 
number of transfers.

The default value is 0.

Note: Telestream strongly recommends you change this to a non-zero value.
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■ Max Copy Out

This setting only applies when the Storage Location is configured for copying out 
files and sets the maximum number of concurrent transfers from Kumulate to the 
Storage Location.

The value can be between 0 and 127, where 0 means that there is no limit on the 
number of transfers.

The default value is 0.

Note: Telestream strongly recommends you change this to a non-zero value.

■ Media Directory Version

This parameter was introduced to allow for differences between earlier and later 
releases of the Omneon software. No new installations use a release of the Omneon 
(now Harmonic) software that is lower than 4.0.

Always set this to 4.0 or higher.

■ Media Directory

The directory used for media files referenced by reference MOV files.

Files are transferred between the video server and Kumulate using the video 
server's internal FTP server. The MXF and MOV files, including reference MOV files, 
are kept in the Clip Directory. The MOV files referenced by the reference MOV files 
are kept in a subdirectory of this directory; typically media.dir.

The full path to the subdirectory must be specified for Media Directory. For exam-
ple, if the reference MOV files are located in clip.dir, and the referenced files are 
located in media.dir, Media Directory must be set to clip.dir/media.dir.

■ Monitoring

Specifies whether Kumulate is monitoring the location to discover and copy-in new 
instances.

OMNEON Storage Locations are generally used to both copy-in and copy-out 
media. Therefore, Monitoring is set to ON. It should only be set to OFF if the Storage 
Location will not be used to discover and copy-in instances.

■ Naming Schema

Determines how the Asset ID is set upon discovery.

Setting this parameter to Asset ID sets the Asset ID to the root filename of the dis-
covered instance. In this case, the Asset Name, Asset ID, and Original Name of the 
asset will be identical.

Setting this parameter to UMID sets the Asset ID to a unique UMID. This ensures 
unique names for all assets. The Asset Name will still be the root filename of the dis-
covered instance.

Note: Neither instance nor asset discriminators can be used when Naming Schema is 
set to Asset ID.
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■ Overwrite Video Server Instance

Transfers from Kumulate to the Storage Location will fail if the file already exists on 
the Storage Location when this is set to NOT ALLOWED.

The transfer will overwrite the existing file on the Storage Location when this is set 
to ALLOWED.

■ Player Version

This parameter was introduced to allow for differences between earlier and later 
releases of the Omneon software. No new installations use a release of the Omneon 
(now Harmonic) software that is lower than 4.0.

Always set this to 4.0 or higher.

■ Polling Begin Time, Polling End Time, Polling Interval(sec)

Controls how Kumulate polls the Storage Location.

Polling Begin Time and Polling End Time instruct Kumulate to poll the Storage 
Location only between Polling Begin Time and Polling End Time. These parameters 
are based on the 24-hour clock, and can only be set to hours.

Polling Interval(sec) instructs Kumulate to poll the Storage Location every specified 
number of seconds. The interval begins when the discovery operation ends. The 
minimum value for this interval is 10s. Setting this parameter to 0 effectively sets it 
to 10s.

■ Process DAL0

Ensures compatibility with files that contain DAL.0 metadata. Changing the value of 
Process DAL0 to YES only has an effect if GenerateDAL0 in the ALL Module Configu-
ration has been set to YES.

■ Restore Using

Restore Using specifies how to name the physical file when an instance is trans-
ferred to this Storage Location. There are four options for Restore Using:

Note: If the asset source location used Asset ID as the Naming Schema, the Asset ID, 
Asset Name, and Original Name may be identical.

Asset ID The file is named using the transferred instance's Asset ID.

Name The file is named using the transferred instance's Asset Name.

Original Name The file is named using the transferred instance's Asset Original 
Name.

Original Name contains the name of the asset when its source 
instance was discovered.

Preserve Filenames The filename is not modified after transfer.

The Restore Extension parameter will not be applicable when 
this option is used. Restore Extension will be hidden if the 
Storage Location configuration is saved after setting this option.
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■ Transcode Using

Some files may contain information at the beginning and end of the file that is not 
necessarily meant to be transcoded. This happens most often with commercial 
spots which can have agency information, tags, and blacks appended to the beg-
ging and the end of the advertisement. Selecting SOM and EOM prevents these 
extraneous bits from being transcoded. Additional configuration is needed to use 
EOM and SOM.

The entire file is transcoded when set to SOF and EOF.

Only a part of the file is transcoded when set to SOM and EOM.

See Start of Message Parameter for more information.

■ Transfer timeout

The transfer fails if it has not completed successfully within this amount of time. 
This value should only be changed if transfers routinely time out.

■ Transfer Mode

Always set to Direct FTP.
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Discriminators for Video Server Locations
The Asset Discriminators and Instance Discriminators under the Discriminators tab are 
used to differentiate between instances with the same name on the same video server.

Asset Discriminators and Instance Discriminators are metadata used to determine 
whether an instance that has changed is the same instance or a different instance than 
one that is already on the Storage Location.

Note: Delete Content From Archive has no effect when discriminators are used.

When an instance has changed, the instance discriminator metadata values of the 
original and changed instances are compared. If any of the discriminator metadata 
values do not match, the original instance is deleted and a new asset is created for the 
changed instance.

The original asset will be deleted if the original instance is the only instance in its asset 
and Delete Assets with No Instances is set to ON.

Discriminator metadata is selected from the left hand side list and moved to the right 
hand side using the arrow icon.

For example, to compare instances based on file size and video standard, select File Size 
and Video Standard.

When Kumulate detects that the physical instance on the Storage Location has 
changed, it will compare the file size and video standard of the original instance to the 
changed instances. If either of the two metadata values do not match, then the current 
instance in Kumulate will be deleted and a new asset will be created for the instance on 
the physical location.

Note: Naming Schema must be set to UMID, and Extract Metadata must be set to YES 
when using discriminators. No instances will be discovered on the Storage 
Location if discriminators are used but the Storage Location's naming schema 
is not set to UMID.
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Fast Initialization & Delete Content From Archive
The Fast Initialization and Delete Content From Archive parameters together determine 
what happens to archive instances when an instance with the same name as an 
existing asset is discovered on the Storage Location.

The Delete Content From Archive determines whether an asset's archived instances are 
deleted when a new instance with the same name is discovered on the Storage 
Location.

When turned on, Fast Initialization causes Kumulate to only perform an in-depth 
cataloging of the instances on the Storage Location once; then subsequently only 
cataloging changes to the instances.

Delete Content 
From Archive 
Setting

Fast 
Initialization 
Setting Result

No No Kumulate deletes the existing archived instances. 
The discovered instance is added to the asset.

The existing asset is deleted if the Asset Manager 
Delete Asset With No Instances parameter is set to 
ON and the asset has no other instances on Storage 
Locations. A new asset is created, and the new 
instance is added to this asset.

If the Naming Schema parameter is set to UMID, 
there may be more than one asset with the same 
name. In this case, Kumulate will generate an 
exception.

Yes No Kumulate deletes all the instances in the existing 
asset, and creates a new asset for the newly-
discovered instance.

The asset will be deleted if the Asset Manager 
Delete Asset With No Instances parameter is set to 
ON.

Yes Yes Kumulate will delete all instances in the existing 
asset. The existing asset will be deleted if the Asset 
Manager Delete Asset With No Instances parameter 
is set to ON.

A new asset will be created for the newly-discovered 
instance.

No Yes Kumulate will ignore the newly-discovered instance. 
No changes will be made to the existing asset.
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Archive Locations
You can configure archive locations for your specific cache requirements.

■ Archive Location Connections

■ Configuring the Cache

■ Adding A Tape Library

■ Registering LibAttach for StorageTek/Oracle Network Libraries

■ Configuring the Archive Location

■ Enabling Tape Spanning

■ Formatting Tapes

■ Defragmenting Tapes

■ Adding Group Access to a Location

■ Importing LTFS Tapes

■ Searching the Archive

■ Recovering Content from Tapes
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Archive Location Connections
Data libraries and the cache are classified as Archive Locations. The cache is used as 
temporary storage, and storage for the low-resolution proxies. Data libraries are used 
for long-term storage.

In general, Archive Locations are connected to the Kumulate server and the 
DataMovers through fiber channels rather than through a network connection. A 
notable exception are StorageTek libraries using LibAttach. These are connected to 
Kumulate through a network connection.

Configuring the Cache
Every Kumulate system has exactly one cache. The cache is created by default and is 
used as a dedicated Archive Location connected to the Kumulate server and its 
DataMovers.

The physical cache location is generally connected to the DataMovers and the 
Kumulate server through fiber channels. The cache can also be connected to a network, 
and a UNC path can be used to ensure that a connection to it is always available. A UNC 
path also ensures that additional servers and workstations that are not directly 
connected to the cache can still access it.

Four directories must be created on the physical cache:

The cache information is entered into Kumulate from the Administration page during 
installation. The cache information can be viewed from the Administration pages.

Use the following procedure to configure the cache:

Directory Name Description

Media Main cache directory. Any instance that is located on the cache, 
with the possible exception of proxy instances, will be located in 
this directory.

ProxyRoot Dedicated directory for low-resolution proxies. Low-resolution 
proxies can be located in the main cache along with the other 
cache instances or they can be kept in a separate directory.

Proxies located on a separate directory cannot be transferred to 
other locations.

The path to the proxy instances is also used to configure Tomcat 
for proxy streaming.

Attachments Attachment directory. Asset attachments are stored in this 
directory including closed caption files and thumbnails.

TempAttachment Temporary directory that is used as a temporary repository when 
instances and attachments are discovered or uploaded.
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1. Click System > Administration in the menu bar in the Kumulate web interface

2. Select Locations > Archive.

3. Click the pencil to open the Cache Location Manager and click Configure (pencil 
icon). 

4. The Main Cache Path, Proxy Cache Path and, Attachment Path as well as their 
corresponding UNC paths should be filled in correctly.

5. Click OK to save the configuration if changes have been made.

6. Stop and restart the Tomcat service on the Kumulate server host.
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Adding A Tape Library
When creating a new Archive Location, Kumulate will automatically detect the libraries 
connected to it. Before creating a new Archive Location, make sure that the model of 
any library connected to Kumulate is known.

Use the following procedure to create a new Archive Location:

1. Click System > Administration in the menu bar in the Kumulate web interface.

2. Select Locations > Archive

3. Click Add New Location to open the Create Archive Location page. Kumulate detects 
the devices connected to it and list them under Device Information

The SCSI_CHANGER data library type is selected by default. When SCSI_CHANGER is 
selected, Kumulate will automatically detect all the devices connected through the 
SCSI connection.

Selecting the NETWORK data library type will automatically discover all the Storag-
eTek libraries connected to Kumulate through LibAttach.

For more details on using the NETWORK library type, see Registering LibAttach for 
StorageTek/Oracle Network Libraries .
Kumulate Administration Guide



Archive Locations
Adding A Tape Library

138
4. Select the device to use with the location, provide the location with a name, then 
click OK to create the location

The location will open in the Manage Archive Location page. Before the location can 
be used, it must be validated to discover all the tapes in the library.

5. Click Validate in the Manage Archive Location menu

A dialog box will appear asking which validate action to use. Click Validate Full to 
discover all the tapes in the library

6. Click Storage Units in the Manage Archive Location to get a list of all the tapes in the 
library

The tapes are in the unformatted state when the library is first validated. Instances 
can’t be copied to the library until at least one of its tapes is formatted.
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Note: Do not format tapes that will be added manually to a media group. See Media 
Groups for details.
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Registering LibAttach for StorageTek/Oracle 
Network Libraries

A StorageTek library connected to Kumulate via LibAttach must be configured as a 
NETWORK library type.

When the NETWORK library type is used, Kumulate will send commands to the ACSLS 
using the LibAttach API.

To use the NETWORK library type, the LibAttach API needs to be registered before 
Tomcat starts. An error will be generated if LibAttach is not registered as shown in the 
following figure:

Before registering the LibAttach API, ensure that LibAttach for 64bit architectures is 
installed on the Kumulate host. Use the following procedure to register the LibAttach 
API:

1. Shutdown Tomcat if it is running.

2. Open a command prompt and change directory to C:\Masstech\bin\dll\x64\.

3. Execute the ComStoragetek.exe command as follows:

ComStoragetek.exe /regserver

4. Restart Tomcat after the API is registered; the NETWORK library type can now be 
used.
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Configuring the Archive Location
Use the following procedure to configure the Archive Location:

1. Click Configure in the Manage Archive Location page.

2. Set all parameters that need changing from the defaults.

Caution: Take special care when setting parameters related to defragmenting.
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Parameter Description

LibraryUsage The name of the library being used by the 
Archive Location.

Medium Changer The name of the medium changer being 
used by the Archive Location.

ScsiTransferLength The maximum length for transfers across 
the SCSI interface.

ACSLS Commands Timeout (in seconds) The time in seconds to wait for an ACSLS to 
respond when connected to a StorageTek/
Oracle library.

Note: Only visible when configuring 
StorageTek/Oracle libraries.

Auto Clean Enable This enables or disables automatic 
cleaning of the Archive Location. When set 
to TRUE it is enabled; setting it to FALSE 
disables this function.

Automatic Defragmentation includes 
readonly tapes

When set to NO, read only tapes will not be 
defragmented automatically.

Checksum Type Generate a checksum using the specified 
algorithm.

This is set to MD5 by default.

Checksum Validation When an instance is copied to the location, 
its checksum is calculated using the 
algorithm specified by Checksum Type. 
The instance's checksum is added if it does 
not exist in the database. The transfer will 
fail and an error will be generated if the 
instance's checksum does exist in the 
database, but the two checksums do not 
match.

An additional check is made after the 
instance has been fully copied to the 
location if After Write is selected. The 
transfer will fail if the checksum of the 
instance after copy does not match the 
checksum in the database.

This is set to No Verification by default.
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Automatic Defragmentation When enabled, tapes in the library will be 
defragmented automatically when the 
library's fragmentation level is reached.

Two options are available for 
defragmenting tapes: 

EnabledOnSameTape copies the 
undeleted contents of a tape to the cache, 
defragments the tape, then recopies the 
contents back to the same tape.

EnabledUsingGroupPattern copies the 
undeleted contents back to any tape in the 
media group specified in Grouping 
Pattern.

Device Unload Timeout(sec)

Fragmentation Level When enabled, this is the percentage by 
which the ratio of deleted content to 
written content needs to be exceeded to 
trigger automatic defragmentation.

Grouping Category The media group category to use when 
defragmented content is recopied to tape.

Used with the Automatic Defragmentation 
EnabledUsingGroupPattern option.

Grouping Pattern The media group to use when 
defragmented content is recopied to tape.

Used with the Automatic Defragmentation 
EnabledUsingGroupPattern option.

MediaWarningNotification

Num Of Format Drives

Override Remaining Capacity

Number of Drives for Read

ReadOnly Threshold The tape will be marked as read after the 
amount of empty space drops to this level 
or below.

Server Address The IP address of the library server.

Tape Recovery Threshold

Transfer Timeout

Parameter Description
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Enabling Tape Spanning
When storing an instance containing multiple files to more than one tape, Kumulate 
splits the instance over the tapes. By default, Kumulate does this even if the instance is 
larger than the space available on all the tapes. You can disable this feature so that 
Kumulate holds the instance until you introduce a tape with large enough capacity to 
the media library. In this case, Kumulate displays an Operator message letting you 
know that the instance is in a waiting state.

To enable or disable tape spanning, do the following:

1. Log in to Kumulate.

See Logging In.

2. Browse to the administration tools.

See Finding the Administrator Tools.

3. From the ADMINISTRATION page menus, select Locations > Archive.

Kumulate opens the Archive Location Manager page.

4. On the list of instances, click the edit button  for the desired instance.

Kumulate opens the Archive Location Configuration page.

5. Do one of the following:

– To enable tape spanning, select YES from the Enable Tape Spanning drop-down 
menu.

– To disable tape spanning, select NO from the Enable Tape Spanning drop-down 
menu.

6. Click OK.

Formatting Tapes
Tapes must be formatted before they can be written to. Tapes belonging to a particular 
Archive Location are accessed by clicking the Pencil icon next to the Archive Location, 
then click the Storage Units button as shown in the following figure:
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Tapes can also be accessed by performing a search through the Archive Search. Select 
all or some of the tapes to format, then click the Format Media button as shown in the 
following figure.

The Media Format page will open. Select the tapes that need LTFS formatting before 
clicking Format Media.

Note: If the tape is not an LTFS tape, Kumulate will not use LTFS formatting, even if 
LTFS Format is selected.

The Formatting Status page will open.

The tape statuses will go from To format, which indicates that the tape is queued for 
formatting, to Fetching, which indicates that the tape is being moved to a drive, and 
finally, to Formatting. Tape status can also be viewed from the Media Status page.
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From the Media Status page, select the operation to monitor. To monitor tape 
formatting, select Format from the pull down menu.

A list of tapes that are in the process of being formatted and their statuses will be 
displayed.

The status of the tapes changes to FRMTTED after the formatting is complete. Tapes will 
not change to ONLINE until an instance has been copied to them.
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Defragmenting Tapes
When an instance is deleted from a tape in Kumulate, the record of the instance is 
deleted from the database. However, the content is not deleted from the tape itself; a 
physical copy is left on the tape.

A tape can be defragmented to make room on the tape and to consolidate all the 
content that is still in Kumulate.

When a tape is defragmented, all the content that remains in Kumulate is copied to the 
cache, and the EOD (End Of Data) mark is reset to the beginning of the tape. The 
content is then recopied to the original tape, or to any tape in a specified media group.

Defragmenting can be triggered automatically for all tapes on a tape library Archive 
Location by setting Automatic Defragmentation to either EnabledOnSameTape or 
EnabledUsingGroupPattern. Defragmenting will then occur whenever the ratio of 
deleted content to written content exceeds the percentage specified by the 
Fragmentation Level parameter.

Automatic defragmenting can be disabled for read only tapes using the Automatic 
Defragmentation includes readonly tapes parameter. This prevents content that has 
been deleted in Kumulate from being overwritten on the tape.
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Adding Group Access to a Location
Storage and Archive Locations are not automatically visible to users. A location must be 
added to a user's Group ACL (Access Control List) for the user to have access to it.

Use the following procedure to add group access to a location:

1. Click System > Administration in the menu bar of the Kumulate web interface

2. From the menu bar select Security, then Group Information to open the Group 
Information page

3. The default view in the User Group Information page does not allow the user to 
create or edit groups. Selecting Future from the See rights pull down menu enables 
editing.

4. Click the Pencil icon to the left of the group to select the group to edit.

5. An existing ACL can be modified to include a new Storage Location, or a new ACL 
can be created for the Storage Location. Click the icon to the left of a resource filter 
under Storage Location ACL to modify an existing ACL.

Note: Adding a location to an existing ACL resource filter modifies all ACLs and 
groups that use that filter.
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6. Select locations from the Available Storage Locations list, then use the right arrow 
to add them to the Selected Storage Locations list.

7. Click Add to add the location to the filter. The location will be added to the 
Matching Rule Set list.

8. Click OK to save the changes and return to the User Group Information page.

9. An attention symbol will remain next to the group until all the changes are applied 
or canceled.

10. Click Apply Changes. A confirmation dialog will open; click OK to continue.

11. The new Storage Location will appear in the Kumulate web interface.
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Importing LTFS Tapes
Kumulate can import tapes written in LTFS format by other systems. When importing 
projects from LTFS tapes, the system now supports the ability to choose the parent 
folder for the assets to be imported. The LTFS structures are saved in the database (for 
future use) after they have been read. Users can initiate an operation to read the LTFS 
structure (index and label) for selected tapes, and then download file(s) displaying the 
structure.

When a tape is sent for import, if the structures are present, the import will be 
executed, regardless of whether the drives are available for import. A successful import 
will not remove the LTFS data; allowing the user to run subsequent imports with 
different parameters.

If one tape is selected, the download operation will produce a file containing an 
explanation of the LTFS structure related to the import operation. If more than one tape 
is selected the download will create a zip archive containing an explanation of the LTFS 
structure for the selected tapes.

Users can view the status of the operations on the Media Status page.They can then set 
the folder depth for the tape (as in previous releases) based on the tape's structure.

To access this function navigate to System > Administration > Locations > Archive and 
select Storage Units. From this page, you will be able to select the tapes to import and 
then click the Import Media button

After clicking the Import button, you will be presented with a new page where you can 
configure the LTFS content import criteria. This is presented in the following section 
regarding the import of LTFS tapes.
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You can also access the LTFS content import by navigating to 
System > Administration > Locations > Archive, then selecting the library and clicking 
Import

You can set individual parameters for each tape selected

Parameter Description

Treat multiple MXF files 
as AVID/ MXF

Applies to folders with multiple files with mxf extensions 
and instructs the system to identify these files as either 
AVID or as MXF instances.
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The system will attempt to determine what kind of content is on each tape during the 
import process and set the instance format and wrapper appropriately.

Deleting LTFS Data
Users can manually delete the LTFS data for the selected tapes. The data is removed 
automatically when the tape goes into a formatted state. This means that even if the 
tape had content on it, the user knowingly chose to format the tape. In this case, the 
LTFS index is no longer valid for the tape content.

Use the appropriate button as shown to perform the desired operation.

Create one asset from 
each file in folders with 
many files

Combined with the option above, will generate either one 
AVID/MXF instance with capture format MXF_OP_ATOM 
(if unchecked) or many AVID/ MXF instances with capture 
format MXF_OP_ATOM/ MXF (if checked).

Instance format for files 
with no extension

For files that have no extension this instructs the system 
to consider them as GENERIC/ K2 or LEITCH.

Match existing assets Attempts to match the newly imported instances to 
existing assets based on the original name or, if not filled, 
on the alias. If no match is found, a new asset will be 
created.

Parameter Description
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Searching the Archive
A dedicated archive search is available. Use the following procedure to perform an 
archive search:

1. Click System > Administration in the menu bar in the Kumulate web interface

2. Select Media Management > Search Storage Units

Note: The terms storage units, media, and tapes are sometimes used 
interchangeably.

3. The search returns tapes that match the search criteria. Clicking Search without any 
criteria returns all the tapes in the system
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Recovering Content from Tapes
When Kumulate’s database is compromised and cannot be recovered, content written 
to tapes is lost. However, the files are still there and by “scanning” the tapes for them, 
whole asset instances can be recuperated and inserted into the database, making the 
content available again.

User Actions for Recovering Tapes
A Recover button is now available in the Tapes view of an Archive Location’s page when 
tapes eligible for content recovery are selected:

There is also a Recover button on an individual tape’s page; the button is only available 
for eligible tapes.
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Uninitialized tapes in UNFORMATTED or OLD_CONTENT states are the main target for 
the recovery operation. However, used tapes in READONLY or ONLINE states can also be 
recovered; in the latter case, the recovery operation equates to an undelete of deleted 
instances.

Only so much content can be restored as it’s available on tapes: no metadata for files, 
instances and assets can be recovered (except for LTFS tapes, see the following), as 
these are not present on non-LTFS tapes written by Kumulate. However, because asset 
IDs are stored on tape, recovered instances are associated with assets existing in the 
database; if there are none, new assets will be created. The asset’s Source metadatum is 
also initialized with the Recovered from TapeID value, where TapeID is the id of the 
recovered tape.

The recovery process detects whether the tape under recovery has been formatted for 
LTFS and employs different mechanisms for recovering content from LTFS tapes. LTFS 
tapes written by Kumulate contain instance and asset metadata, so a full recovery of 
the content on LTFS tapes is possible. Recovering content from LTFS tapes is a much 
shorter process because only the LTFS index must be read (as opposed to all content in 
the non-LTFS case).

Clicking the Recover button displays the Recover Tape Content dialog box:

The following parameters are configurable from this page and dictate the recovery 
process:

■ Priority

Scanning a tape for content requires allocating a DataMover and a drive that is con-
figured as an endpoint in that DataMover; just like for any transfer from/to tape job. 
This means the recover job competes for available drives with all other tape jobs in 
the system, so setting the job’s priority allows for the prioritization of recover jobs 
relative to the other scheduled tape jobs.

A recover job might take a significant amount of time to complete (if the tape con-
tains a lot of files), during which the drive is unavailable for other tape jobs. There-
fore, giving recover jobs a high priority might significantly slow down content 
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archive and restore operations. This can be partially mitigated by configuring 
appropriate schedules for the drive’s operations. As seen in the following figure, 
content recovery is on the same schedule as the Import operations:

■ MXFs as Avid

An instance containing only MXF files can be coerced into an Avid instance format 
using this flag (even though a regular Avid instance would also have an AAF file). 
When this is not set, these instances are regarded as having regular MXF instance 
format.

■ Prefer Project to Generic

The recovery process tries to determine on a best-effort basis the instance format 
from the recovered file’s extensions; when no specific format can be determined, it 
defaults to the unspecific and limited Generic format. With this setting, these 
instances can be configured to have Project format instead.

■ No Extension Format

Instances with files having no extension cannot be assigned a specific format and 
will default to Generic. With this setting, a more specific instance format like LXF 
(for Leitch media) and GXF (for K2 media) can be assigned to these instances when 
the tapes are known to contain such formats.

■ Force Full Scan

For ONLINE and READONLY tapes, this setting allows undeleting all the instances 
written on the tape. This makes little sense for tapes in UNFORMATTED and OLD_-
CONTENT tapes because they are always scanned from the beginning, and no 
sense for RECOVERING and PARTIALLY_RECOVERED tapes. RECOVERING tapes are 
either in the process of already being recovered, or their recovery jobs have been 
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cut short (typically by a system restart), and PARTIALLY_RECOVERED tapes have 
been canceled; so only resuming from where the previous jobs left is possible for 
these states.

Recovering Tape Content Jobs
Clicking the Recover button in the Recover Tape Content dialog box launches a Recover 
Tape Content job for each of the selected tapes. When there is more than one tape, the 
launched jobs are grouped into one compound job that contains all the individual 
recovery jobs for easier tracking of the overall progress.

A new state named RECOVERING has been added to the tapes’ state set. It is the state 
tapes are in during the process of being recovered and during the entire scanning 
process.

Recover Tape Content jobs on non-LTFS tapes may take a lot of time as all written 
content on tape is read until End of Data. Therefore, it might make sense to pause these 
long-running jobs; unfortunately, this cannot be done in Kumulate.

However, as a work-around, a Recover Tape Content job can be canceled, and a new 
one can be scheduled later to resume the recovery process from where the job was 
canceled. When a job is canceled, the tape changes states from RECOVERING to 
PARTIALLY_RECOVERED; so tapes for which the recovery process has not been carried 
out completely can be easily identified as those having PARTIALLY_RECOVERED status.

When content recovery is successful, the status of the tape switches from RECOVERING 
to ONLINE if any content has been restored; except for the READONLY tapes, which 
become READONLY again. If there is no content the tape reverts to the initial status 
before the recovery. For example, an UNFORMATTED tape with no content ends up 
UNFORMATTED again after a successful recovery is complete.
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Media Groups
You can configure media groups for your particular needs.

■ Tapes in Media Groups

■ Default Media Group

■ Creating a Media Group

■ Grouping Instances

Tapes in Media Groups
Media groups are groups of tapes within the same Archive Location where instances 
with specific metadata values are stored. Tapes can be assigned to groups manually or 
automatically.

When tapes are assigned to a group automatically, the Archive Location must have a 
pool of formatted tapes where instances can be copied. When an instance is copied to 
the location it will be copied to a tape from the location's pool of formatted tapes. That 
tape will be assigned to the appropriate media group based on the instance's metadata 
values.

When tapes are added to the media group manually, unformatted tapes are added to 
the group when it is configured.

By default, Kumulate adds unassigned tapes to the default group (DEFAULT_GROUP) 
when an instance is copied to it.

Instances that are stored on tapes belonging to the wrong group can be moved to 
tapes belonging to the appropriate group using back end grouping.

Default Media Group
After a tape has been assigned to DEFAULT_GROUP it can no longer be assigned to any 
other group in the Kumulate system. If there are no groups configured in the Kumulate 
system, all the tapes with instances will belong to DEFAULT_GROUP.
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If tapes belonging to a particular Archive Location have been grouped, but the instance 
being copied to the location does not have metadata that matches any of the groups, 
Kumulate will copy the instance to an unassigned formatted tape and assign it to 
DEFAULT_GROUP.
Kumulate Administration Guide



Media Groups
Creating a Media Group

160
Creating a Media Group
Media groups are groups of tapes that will be used to store instances with certain 
metadata values. Determining which instances to store on specific groups of tapes is 
accomplished using instance and asset resource filters. Add any new metadata needed 
before creating the grouping.

Use the following procedure to create a media group:

1. Click System > Administration in the menu bar in the Kumulate web interface

2. Select Media Management > Media Grouping

3. On the Media Grouping page, enter the information needed to create the tape 
group, and select which instances are stored on these tapes
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4. Click Add to create the group. It will appear at the bottom of the Media Groupings 
page. Click the Pencil icon to open the group in the Modify Group page.

5. Select whether to add the tapes manually to the group, or to allow Kumulate to 
assign tapes to the group automatically.

6. If tapes will be added manually click ADD under Media Assignment at the bottom 
of the page to assign tapes to the group.

Parameter Description

Group Name The unique name of the group.

Group Description An optional description of the group.

Instance Filter The instance resource filter to use to select instances to 
store on the tapes in this group.

If a new resource filter is needed, select new and create a 
new resource filter.

Asset Filter The asset resource filter to use to select instances to store 
on the tapes in this group.

If a new resource filter is needed, select new and create a 
new resource filter.

Media Library Identifier The Archive Location from which to select the tapes for this 
group.
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7.  Select the tapes to add to the group on the Group Media Assignment page and 
click OK.

Note: All unformatted tapes in the system will be shown on the Group Media 
Assignment page. Be mindful to select only the tapes that belong to the 
Archive Location assigned to the group.

8. The selected tapes will appear under Media Assignment.

9. Use the archive search to ensure that the tapes are assigned to the group.
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10. If tapes are added automatically, Kumulate will assign a formatted tape to the 
group when an instance with matching metadata is copied to the group's Archive 
Location. After an instance has been copied to the location, the tape where the 
instance was copied will appear in the group's Media Assignment list.

11. Use the Archive Search the view the tapes assigned to the group.
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Grouping Instances
Back end grouping is used to reorganize instances onto tapes in a particular group.

Note: A formatted, unused tape (FRMTTD) must be available in the tape group for an 
instance to be added to the tape group. This means that instances can only be 
regrouped into groups with automatically-added tapes.

And instance's Storage Unit ID shows the tape it is stored on.

The Storage Unit ID can be used to check the group the instance is associated with.

For example, a search for the instance (shown in the previous figure) Storage Unit ID 
(F50725), shows that the tape belongs to DEFAULT_GROUP.

If the instance is meant to be stored on a tape in the ROUGH_DRAFT group, the 
instance can be moved to an available formatted tape in that group.

Use the following procedure to move the instance to the appropriate group:

1. Click the Show Instances icon (looks like a magnifying glass) next to the tape the 
instance is currently stored on.
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2. On the Instance Search Results page, select the instance to move, then click 
Backend Group.

3. On the Backend Group page, select the instance to move again, then click Backend 
Group again.

4. On the Backend Group screen, select Specify Tape ID from the pull down menu; 
then select the tape group the instance should be on.

5. Select Preserve original instances to keep the instance on the source tape. Select 
Eject after BEG to eject the source tape after the instance has been moved.

6. Select the tape in the group to move the instance to, then click Backend Group.
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7. The Media Status page will open. The status will be Copy to Archive while the 
instance is being copied.

8. After the instance has been copied the status will change to BackEndGrouped.

9. The instance's Storage Unit ID will now show the new tape ID.
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Attachment Templates
You can configure attachment templates for your particular instance.

■ Attachment Templates for Additional Files

■ Built-In Attachment Templates

■ Creating an Attachment Template

■ Adding Attachment Template Access to Groups

■ Deleting an Attachment Template

Attachment Templates for Additional Files
Attachments are additional files associated with assets. Captions, formatsheets, marks, 
segments, and thumbnails are stored as attachments. Image files, pdf documents, and 
Microsoft Office documents can also be uploaded as attachments provided that 
attachment templates have been created for these types of attachments.

Attachment templates are used to upload attachments to the asset. They contain 
information on the type of file to expect and what metadata is associated with the 
attachment.

Attachment templates must be created for any type of attachment aside from the built-
in caption, formatsheet, mark, segment, and thumbnail attachments.
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Built-In Attachment Templates
Kumulate includes built-in attachment templates for certain file types. These templates 
cannot be modified.

Attachment Template Usage

Thumbnail Thumbnail images associated with the media content. The 
thumbnail attachment type is used internally by Kumulate.

Segment Video segments created by the user. The segment 
attachment type is used internally by Kumulate.

Marker Video markers set by the user in the video previewer. The 
marker attachment type is used internally by Kumulate.

Closed Captioning Closed captioning file. The closedcaptioning attachment 
type is used internally by Kumulate, but users can also use it 
to upload additional captioning files to an asset.

Formatsheet XML attachments that provide information on run orders. 
The formatsheet attachment type is used internally by 
Kumulate, but users can also use it to upload formatsheet 
files to assets.
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Creating an Attachment Template
Attachment templates must be created to upload files other than caption and 
formatsheet files. Kumulate supports uploading any file type as an attachment. Using 
the exact file type in an attachment template optimizes indexing of the file, and 
improves attachment searches. Use the following procedure to create an attachment 
template:

1. Click System > Administration in the menu bar in the Kumulate web interface

2. Select Content > Attachment Management

3. To create a new attachment type, click Add Attachment Type.

4. Provide an Attachment Template Name, Description, and Class for the attachment 
type. The description is used as the attachment template's display name. The 
description appears in a drop-down menu in the Kumulate user web interface. If it 
is omitted, the template name will be used instead

Select the file type for this attachment template.

Note: Using the exact file type in an attachment template optimizes indexing of the 
file and improves attachment searches. Use the free and text classes only when 
absolutely necessary.

Class Description

free Any type of file. Use this class if the attachment will contain a type not 
defined by any other class.

xml XML file

jpeg JPEG file

pdf PDF file

word Word document
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5. Click Add Metadata to add attachment attributes and provide a Metadata id and 
the Metadata type. These attributes are filled in by the user when the attachment is 
uploaded.

Note: The file metadata type is required to upload a file as an attachment.

6. Click OK to add the attribute.

7. Click OK to save and exit after all the attributes have been added.

8. Refresh the browser to ensure that the changes are reflected in the user interface.

Saving the template automatically creates a resource filter for the new attachment 
template. The new resource filter is added with full privileges and controls to the 
current user's group and to the Montana User Group.

The resource filter can be added to all other groups manually. See the Adding 
Attachment Template Access to Groups for more details.

excel Excel document

binary Binary file: Use this class only if the attachments will not be Word, PDF, or 
Excel files.

text Text file: Use this class only if the attachments will not be xml files.

Class Description
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Adding Attachment Template Access to Groups
User groups do not automatically gain access to attachment templates created by a 
user. Access control lists for the templates must be added to the groups to allow groups 
of users to access the templates.

For more information on groups, see Groups and Users.

Use the following procedure to add attachment template access to a group:

1. Click System > Administration in the menu bar in the Kumulate web interface

2. Select Security > Group Information

3. The default view in the User Group Information page doesn’t allow the user to create 
or edit groups. Enable editing by selecting Future from the See rights drop-down 
menu

4. Select a group to edit. Click Add New ACL on the Modify User Group page
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5. On the Add ACL page give the ACL a name, then select the resource filter 
corresponding to the new attachment template. A new resource filter can be 
created if necessary.

6. Set the access rights to the template. See Access Control Lists (ACLs) for more 
information.

7. Click OK to save the changes and return to the Modify User Group page. An 
attention symbol will remain next to the group until all the changes are applied or 
canceled.

8. Click Apply Changes. A confirmation window will open; click OK to continue.

The message Changes are scheduled to be applied will appear after the dialog box 
closes.

9. Kumulate must be restarted for the changes to take effect. Stop and start the 
Tomcat server to restart Kumulate.

10. After Kumulate has restarted, return to the Groups page to verify that the changes 
were applied.
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Deleting an Attachment Template
When an attachment template is deleted, its resource filter is not deleted. You must 
remove the resource filter from any groups that use it before deleting an attachment 
template.

Note: You can delete templates only when they are not associated with any 
attachments. Any attachment template with the note Has Children is 
associated with one or more attachments currently in the system. You can’t 
delete templates with “children.”

Use the following procedure to delete an attachment template:

1. To open the Attachment Template Management page, click System in the left menu. 
Then select Content > Attachment Management from the top menu.

2. Delete the attachment template by clicking on the X button next to the template.

After the attachment is deleted, the resource filter associated with the template can 
be removed from any groups that use it; then the resource filter itself can also be 
deleted.
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Removing an Attachment Template Resource Filter From a 
Group (Optional)

Use the following procedure to remove an attachment template resource filter from a 
group; this is optional:

1. Select Security > Group Information from the top menu

2. Select Future from the drop-down menu

3. Select the group to edit.

4. Under Attachment Template ACL, click the X button to delete the ACL identifier 
associated with the deleted template's resource filter.

Note: Resource filters created automatically by Kumulate are named 
RF_<TemplateName>. For example, the resource filter associated with the 
binary attachment template will be named RF_binary

5. Click OK to save the changes and return to the Modify User Group page. An attention 
symbol remains next to the group until all the changes are applied or canceled.

6. Click Apply Changes.

Kumulate opens a confirmation window.

7. Click OK to continue.

The message Changes are scheduled to be applied appears after the dialog closes

8. Restart Kumulate for the changes to take effect. Stop and start the Tomcat server to 
restart Kumulate.

9. To verify that the changes were applied, after Kumulate has restarted, return to the 
Groups page.

Deleting the Resource Filter (Optional)
Use the following procedure to delete the resource filter; this is optional:

1. Open the list of resource filters by selecting Content > Resource Filters from the top 
menu
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2. To bring up the list of ACL resource filters, select Future ACL from the Type drop-
down menu

3. Find the resource filter associated with the deleted template.

Note: Resource filters created automatically by Kumulate are named 
RF_<TemplateName>. For example, the resource filter associated with the 
binary attachment template will be named RF_binary

4. Click the X button to delete the resource filter. Don’t delete any resource filter still 
used by a group.

Caution: Never delete RF_CLOSEDCAPTIONING, RF_MARKER, RF_SEGMENT, All 
Storage Locations, AllAssets, AllInstances, AllMetadata, or 
ReadOnlyMetadata.
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DataMovers
Use DataMovers  to transfer media between locations.

■ DataMovers for Media Transfer

■ Adding an External DataMover

■ Adding a DataMover Endpoint

DataMovers for Media Transfer
One DataMover is installed by default on the Kumulate server host. You can deploy 
additional DataMovers to other machines.

You can transfer instances only between locations that are endpoints of the same 
DataMover. You must add locations to DataMovers manually.

Adding an External DataMover
Additional DataMovers can be installed on hosts other than the Kumulate server host. 
These external DataMovers must be added to the Kumulate system before they can be 
used. Information on installing external DataMovers is available in the Kumulate 
Deployment document.

Use the following procedure to add an external DataMover:

1. Log in to Kumulate.

See Logging In.

2. Browse to the administration tools.

See Finding the Administrator Tools.

3. From the ADMINISTRATION page menus, select DRAC Control > DataMover 
Information.

Kumulate displays the list of DataMovers. The internal DataMover is always named 
with the prefix dm.
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4. To add a new DataMover, click the Add DataMover button.

Kumulate opens the Add Data Mover dialog.

5. Give the DataMover a name.

6. Set the nameserver URL to the DataMover's IP address and its listener port.

The default DataMover listener port is 2809.

7. To save the information, click OK.

Kumulate opens the Endpoint information pane.

8. Add endpoints to the DataMover.

9. The DataMover moves instances only between locations that are in its list of 
endpoints.

10. The newly added DataMover appears in the list of DataMovers.
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Adding a DataMover Endpoint
DataMovers are used to transfer instances between locations. Locations must be added 
as DataMover endpoints for instances to be transferred between them.

The internal DataMover runs on the Kumulate server host. In the case of a clustered 
installation, it will run on the master host. When an endpoint is added to a DataMover 
on a Kumulate server that is part of a cluster, the Disable for local DM option can be 
used to remove the endpoint when the DataMover's host becomes the cluster master.

Use the following procedure to add an end point to a DataMover:

1. Log in to Kumulate.

See Logging In.

2. Browse to the administration tools.

See Finding the Administrator Tools.

3. From the ADMINISTRATION page menus, select DRAC Control > DataMover 
Information.

Kumulate displays the list of DataMovers. The internal DataMover is always named 
with the prefix dm.

4. To modify a DataMover, click the Modify Data Mover button  next to the 
DataMover name

5. Click ADD under Endpoint Management.

Kumulate opens the Add Endpoint dialog.

6. From the Endpoint ID drop-down menu, select the Storage Location desired

7. If the DataMover is located on a Kumulate server that is part of a clustered 
Kumulate installation, you can select the Disable for local DM option.

This prevents Kumulate from using that endpoint when the DataMover host is the 
Cluster Master.

8. To add the endpoint, click OK.

The location appears in the Endpoint Management list. Its Data Mover Status should 
be ONLINE. Disregard the Connection Status.
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Metadata Management
Configure metadata management to display the data most useful to you.

■ Metadata Management Features

■ Accessing the List of all Metadata

■ Adding Custom Metadata

■ Creating List Metadata

■ Adding Custom Asset Metadata to an ACL

■ Prioritizing Search Results in Specific Metadata

■ Deleting Unused Combo Metadata
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Metadata Management Features
All the metadata in Kumulate can be viewed through Metadata Management. 
Additional custom metadata can also be added to Kumulate from the Metadata 
Management page. Administrators can assign a default set of pinned metadata fields 
starting with release 2.1 and later.

Accessing the List of all Metadata
Metadata Management is used to view and edit asset and instance metadata, and 
create custom instance and asset metadata.

Use the following procedure to access the list of all metadata:

1. Log in to Kumulate.

See Logging In.

2. Browse to the administration tools.

See Finding the Administrator Tools.

3. From the ADMINISTRATION page menus, select Content > Metadata Management.
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4. Expanding the asset or instance headers shows all metadata, including custom 
metadata. For example, in this case, the is_proxy and is_temporary metadata were 
custom created for this installation of Kumulate:

Descriptions of the fields in the Instance Metadata pane follow:

4. Use the Add Metadata button to add new asset or instance metadata.

Metadata Parameter Description

Metadata ID The unique, internal metadata identifier. By convention, the 
ID is in lowercase characters with words separated by 
underscores (_).

Metadata Name The name used to identify the metadata. This is the name 
used when the metadata is displayed and is the name that 
should be used when creating resource filters, or searching 
using metadata.

Metadata Group The group to which the metadata belongs. Groups can be 
added as needed. Metadata will appear under its group in 
the asset or instance view.

Format The format of the metadata. The following options are 
available:

Free: The metadata can have any value assigned by the user.

Combo: The metadata value can be selected from a list of 
values or entered by the user.

List: The metadata value can only be selected from a list of 
values.

Date: The metadata value is a date.

Default Value The value assigned to the metadata by default.

Length The maximum character length of the metadata value.

Mandatory The metadata must be populated when set to YES.

Display Mode The metadata value cannot be set or modified by a user 
when set to Read Only.
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Adding Custom Metadata
Custom metadata can be added from the Metadata Management screen. 
Administrators can now assign a default set of pinned metadata fields. Use the 
following procedure to add custom metadata:

1. Log in to Kumulate.

See Logging In.

2. Browse to the administration tools.

See Finding the Administrator Tools.

3. From the ADMINISTRATION page menus, select Content > Metadata Management.

4. Click Add Metadata.

Kumulate opens the Add Metadata dialog.

5. Enter the values for the new metadata element.

Descriptions of the fields in the Add Metadata pane follow:

Metadata Parameter Description

Metadata ID The unique, internal metadata identifier. By convention, the 
ID is in lowercase characters with words separated by 
underscores (_).

Metadata Name The name used to identify the metadata. This is the name 
used when the metadata is displayed and is the name that 
should be used when creating resource filters, or searching 
using metadata.
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Metadata Parameter Description

Metadata Format The format of the metadata. The following options are 
available:

Combo: The metadata value can be selected from a list of 
values or entered by the user.

Date: The metadata value is a date.

Note: Never set a default value when creating date 
metadata.

Free: The metadata value can be in any format. The length is 
capped at 4000 characters.

List: The metadata value is selected from a set list of values. 
See Creating List Metadata for detailed information on 
configuring this metadata format.

Number: The metadata value is a number entered by the 
user.

Large Text: The same as Free, except that the length is capped 
at 32000 characters instead of 4000 characters.

Length The maximum character length of the metadata value.

Default Value The value assigned to the metadata by default.

Note: Keep this field empty when creating date metadata.

Type Indicates whether this is asset or instance metadata.

Display Mode The metadata value cannot be set or modified by a user 
when set to Read Only.

Mandatory The metadata must be populated when set to YES.
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4. Click OK to save.

If new asset metadata was added, it must be added to a group ACL to be visible by 
users. When viewing an asset or instance, the new metadata will be visible under its 
group.

Metadata Parameter Description

Metadata Group The group to which the metadata belongs. Groups can be 
added as needed. Click Create New Group if a new metadata 
group is needed.
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Creating List Metadata
List metadata is metadata that uses pre-set values that can be selected from a list. Use 
the following procedure to create list metadata:

1. Select List as the Metadata Format after filling in the Metadata ID and Display 
Name.

2. Click Modify List Values to open the Metadata Values Editor.

3. Enter the metadata value that will be used internally by Kumulate and the display 
name that users will see. Spaces are not allowed in the internal value, but are 
allowed in the display name.

4. Click ADD to add the value to the list of values.

5. Add in as many values as required before clicking Save. Clicking Close cancels the 
operation.
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6. Choose a Default Value if required.

7. Set the rest of the parameters as required, then click OK to save.

The metadata can be set by choosing from the values in the list.
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Adding Custom Asset Metadata to an ACL
To let users see the new metadata, after creating a custom asset metadata, add it to 
group ACLs.

To add custom asset metadata to an ACL, do the following:

1. After creating the new custom asset metadata, click Security > Group Information.

Kumulate opens the User Group Information dialog.

2. From the See rights drop-down menu, select Future.

3. To modify a user group, click the Modify User Group button  next to the name of 
the user group.

4. To add the new metadata, under Metadata ACL, click the metadata resource filter 
for the ADL.

5. On the Modify Resource Filter page, select the new asset metadata to add to the ACL.

6. Click ADD.

7. To save changes and return to the Modify User Group page, click OK.

8. To save changes to the user group and return to the User Group Information page, 
click OK.

Note: A hazard sign may appear next to the groups affected by the change to the 
resource filter.

9. For the changes to take effect, click Apply Changes.
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The new asset metadata is visible to users belonging to the groups affected by the 
change.
Kumulate Administration Guide



Metadata Management
Prioritizing Search Results in Specific Metadata

189
Prioritizing Search Results in Specific Metadata
The ability to prioritize search results that contain the searched text in specific 
metadata has been added to Kumulate. A new Asset Definition page is added where 
users can configure the Boost Factor value for any asset, instance or attachment 
metadata. This means that if the searched text is found in the metadata, the results will 
appear before others in a Relevance priority order. By default, the boost factor value of 
the asset metadata Name and Title will be increased to 5, respectively 3. This means 
that if the searched text will be found in those metadata, the results will appear before 
others in the Relevance priority order.

Navigate to the System view, choose Asset Definitions, then choose your desired asset/
metadata, and click Modify. The boost factor values are visible in the last column of the 
table.
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Currently, only the boost factor can be changed from this UI.
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Deleting Unused Combo Metadata
Combo metadata is metadata where the value is entered manually and then stored in 
the database. When editing a combo metadata, any previously used values will be 
available in a pull down menu.

All previously-used values will be available in the pull down menu regardless of 
whether these values are currently assigned to the metadata.

For example, if the AddedBy metadata had once been assigned three different values, 
all three of these values are made available as options in the pull-down menu.

The search will return no results if a search is performed for a metadata value that is not 
used anywhere in the system.
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The Remove Unused Values button removes any combo metadata values that are no 
longer assigned to the metadata.

These values will no longer appear in any pull down menus of metadata value 
suggestions.

Note: The Kumulate web interface will need to be reloaded for the changes to take 
effect. The cache may also need to be cleared.
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Resource Filters
You can configure resource filters to find specific assets, instances, storage locations, 
metadata, and attachments based on the requirements.

■ Resource Filters for Finding Assets

■ Types of Resource Filters

■ Adding an Asset Resource Filter

■ Adding an instance Resource Filter

■ Audio Metadata in Non-ACL Instance Resource Filters

■ Adding a Metadata Resource Filter

■ Adding the Storage Location Resource Filter

■ Adding an Attachment Template Resource Filter

■ Adding a Video Essence Resource Filter

■ Adding an Audio Essence Resource Filter

■ Using Date Metadata in a Resource Filter

■ Searching with a Metadata-Based Resource Filter

Resource Filters for Finding Assets
Resource filters are separated into ACL and non-ACL filters. ACL Resource Filters are 
used in group configurations to control access to attachment templates, Storage 
Locations, and metadata elements. Non-ACL Resource Filters are used by workflow and 
transcode to narrow triggers, sources, and destinations.

Non-ACL and ACL Resource Filters can share the same names. However, it is best 
practice to not duplicate resource filter names.

Because resource filters can be changed from several different administrative pages, 
always verify that modifications to resource filters will not impact workflows, 
transcodes, or groups.
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Types of Resource Filters
Resource Filters are used to select assets, instances, metadata, Storage Locations, and 
attachments using specific criteria. The type of the resource filter dictates what is 
filtered.

Adding an Asset Resource Filter
Asset Resource Filters select assets based on metadata values. They are used in 
workflows and group ACLs (Access Control Lists). Always ensure that any changes made 
to an Asset Resource Filter will not negatively affect existing workflows or groups.

Use the following procedure to create an Asset Resource Filter from the Resource Filters 
page:

1. Log in to Kumulate.

See Logging In.

2. Browse to the administration tools.

See Finding the Administrator Tools.

3. From the ADMINISTRATION page menus, select Content > Resource Filters.

Kumulate opens the Resource Filters dialog.

4. You can use Asset Resource Filters in workflows and ACLs. If you want to use the 
resource filter in a group ACL, select Future ACL Filters from the Type drop-down 
menu.

5. If you want to use the resource filter in a workflow, select Non ACL Filters from the 
Type drop-down menu.

6. Click Add New Resource Filter.

Kumulate opens the Filter Information pane.

7. Give the resource filter a useful name and description.

Type of Resource Filter Description

Asset Selects assets with metadata that matches the defined 
criteria.

Instance Selects instances with metadata that matches the defined 
criteria.

Metadata Selects only the listed metadata elements.

Storage Location Selects only the listed Storage Locations.

Attachment Template Selects attachments created with the listed attachment 
templates by the listed user groups.

Video Essence Selects video essences with the matching metadata.

Audio Essence Selects audio essences with the matching metadata.
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8. Select Asset (Asset) from the Type drop-down menu.

9. Click OK.

10. On the Modify Resource Filter page, enter the asset metadata to use as a filter.

a. Select the metadata from the Metadata drop-down menu.
b. Enter the metadata value. The resource filter selects instances that satisfy the 

metadata conditions.

– You can select the Program Status metadata value from a drop-down menu, or 
enter it using the text box.

– Enter all other metadata values using the text box.

– All metadata values are treated as regular expressions except Create Date, 
Duration, and Purge Date. The Contains option finds all values that match the 
regular expression, and the Not Equal option finds all values that do not match 
the regular expression.

– The Range option is disabled for all metadata except Create Date, Duration, and 
Purge Date.

– Kumulate interprets the Contains option as equal to Create Date, Duration, and 
Purge Date.

See Using Date Metadata in a Resource Filter before using date metadata.

c. To save the metadata condition, click Add.
d. Repeat these steps for each attachment to include in the resource filter.

11. To save the resource filter, click OK.
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Adding an instance Resource Filter
Instance Resource Filters select instances based on metadata values. They are used in 
workflows and group ACL (Access Control Lists). Always ensure that any changes made 
to an instance Resource Filter will not negatively affect existing workflows or groups.

Use the following procedure to create an instance Resource Filter from the Resource 
Filters page:

1. Log in to Kumulate.

See Logging In.

2. Browse to the administration tools.

See Finding the Administrator Tools.

3. From the ADMINISTRATION page menus, select Content > Resource Filters.

Kumulate opens the Resource Filters dialog.

4. You can use instance resource filters in workflows and ACLs. If you want to use the 
resource filter in a group ACL, select Future ACL Filters from the Type drop-down 
menu.

5. If you want to use the resource filter in a workflow, select Non ACL Filters from the 
Type drop-down menu.

6. Click Add New Resource Filter. Give the resource filter a useful name and description. 
Select Instance from the Type drop-down menu.

7. Click OK.
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8. On the Modify Resource Filter page, enter the asset metadata to use as a filter.

a. Select the metadata type from the Metadata drop-down menu.
b. Enter the metadata value. The resource filter selects instances that satisfy the 

metadata conditions.

– Select the AFD, Frame Rate, and Scan Mode metadata values exclusively from a 
drop-down menu.

– Select the Aspect Ratio, Instance Format, Instance Status, Storage Media, and Video 
Format metadata values from a drop-down menu, or enter the values in the text 
box.

– Enter all other metadata values in a text box.

– Kumulate treats all metadata values, except Last Update, as regular expressions. 
The Contains option finds all values that match the regular expression, and the 
Not Equal option finds all values that do not match the regular expression.

– The Range option is disabled for all metadata except Last Update.

– Kumulate interprets the Contains option as equal to Last Update.

Before using date metadata, see Using Date Metadata in a Resource Filter.

Before using audio metadata, see Audio Metadata in Non-ACL Instance Resource 
Filters.

c. To save the metadata condition, click Add.
d. Repeat these steps for each attachment to include in the resource filter.

9. To save the resource filter, click OK.
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Audio Metadata in Non-ACL Instance Resource 
Filters

Audio metadata can be used to select instances in non-ACL Instance Resource Filters.

Note: Metadata must be extracted from instances before using these resource filters.

Types of Audio Metadata
Instances can be filtered by the bit depth, bitrate, block align, sample rate, codec used 
in one or more essences, the number of essences, and audio channels in an instance.

Metadata Description

Audio.Bit depth Used to filter instances by the bit depth of one or more of 
their audio essences.

Audio.Bitrate Used to filter instances by the bitrate of one or more of their 
audio essences.

Audio.Block align Used to filter instances by the block align of one or more of 
their audio essences.

Audio.Sample rate Used to filter instances by the sample rate of one or more of 
their audio essences.

Audio.Codec Used to filter instances by the codec used in one or more of 
their audio essences.

Audio.Channels Used to filter instances by the number of channels in one or 
more of their audio essences.

Audio.Channel count Used to filter instances by the total number of channels over 
all its essences.

Audio.Essence count Used to filter instances by the number of essences in the 
instance.
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Using Audio Metadata
With the exception of Audio.Channel count and Audio.Essence count, the audio 
metadata is matched to one or more audio essences in the instance. The Essence no: 
field specifies the essence to which the metadata must be matched.

Note: Essence numbers are visible from the instance audio metadata.

To apply the filter to one specific essence, enter the essence number in the Essence no: 
field. For example, to select instances where audio essence 1 has a bit depth of 16, enter 
1 in the Essence no field.

To apply the filter to more than one essence, essence numbers can be separated by 
commas, or specified by a range.

Note: The metadata must match each essence in the list. 

For example, to select instances where essences 1, 2, and 4 have a bit depth of 16, enter 
1,2,4 in the Essence no: field.
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To select instances where essences 1, 2, 3, and 4 have a bit depth of 16, enter 1-4 in the 
Essence no: field.

Note: All ranges are inclusive, meaning that the lower and upper limits will be 
included in the range.

Use the * to match the metadata to any essence in the instance.

For example, to select instances that have at least one essence with a bit depth of 16, 
enter * in the Essence no: field.

In the Matching Rule Set list, the matched values are displayed as essence.value. If only 
one essence is being matched, that essence number will appear in the value:

If a comma-separated list of essences is used, the comma separated list will appear in 
the value:

If a range of essences is used, the range will appear in the value:

If the value can match any essence, the * will appear in the value:
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Adding a Metadata Resource Filter
Metadata Resource Filters select the listed metadata elements and are used to limit the 
metadata elements a user group can access. They are generally used in ACLs.

Use the following procedure to create a Metadata Resource Filter from the Resource 
Filters page:

1. Log in to Kumulate.

See Logging In.

2. Browse to the administration tools.

See Finding the Administrator Tools.

3. From the ADMINISTRATION page menus, select Content > Resource Filters.

Kumulate opens the Resource Filters dialog.

4. You can use Metadata Resource Filters in workflows and ACLs. If you want to use 
the resource filter in a group ACL, select Future ACL Filters from the Type drop-down 
menu.

5. If you want to use the resource filter in a workflow, select Non ACL Filters from the 
Type drop-down menu.

6. Click Add New Resource Filter. Give the resource filter a useful name and description.

7. Select Metadata from the Type drop-down menu.

8. Click OK.

9. On the Modify Resource Filter page, enter the asset metadata to use as a filter.

a. Select the metadata type from the Metadata drop-down menu.
b. To save the metadata element, click Add.
c. Repeat these steps for each attachment to include in the resource filter.

10. To save the resource filter, click OK.
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Adding the Storage Location Resource Filter
Storage Location Resource Filters are a list of Storage Locations. They can be modified 
from Group Settings or from the Resource Filters page. Always ensure that any changes 
made to the Storage Location Resource Filter will not negatively affect group 
configurations.

Use the following procedure to create the Storage Location Resource Filter from the 
Resource Filters page:

1. Log in to Kumulate.

See Logging In.

2. Browse to the administration tools.

See Finding the Administrator Tools.

3. From the ADMINISTRATION page menus, select Content > Resource Filters.

Kumulate opens the Resource Filters dialog.

You can use Storage Location Resource Filters exclusively in group ACLs (Access Con-
trol Lists).

4. Select Future ACL Filters from the Type drop-down menu.

5. Click Add New Resource Filter.

6. Give the resource filter a useful name and description.

7. Select Storage Location from the Type drop-down menu.

8. Click OK.

9. On the Modify Resource Filter page, select the storage locations returned by this 
filter.

a. Select storage locations from the Available Storage Locations list on the left.
b. Click the right arrow to add locations to the Selected Storage Locations list on the 

right.
c. To add the location to the filter, click Add.
d. Kumulate adds the location to the Matching Rule Set list.

10. To save the resource filter, click OK.
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Adding an Attachment Template Resource Filter
Attachment Template Resource Filters select attachments created by specific user 
groups, using specific templates. They are used by ACLs (Access Control Lists). Always 
ensure that any changes made to an Attachment Template Resource Filter will not 
negatively affect group configurations.

Use the following procedure to create an Attachment Template Resource Filter from the 
Resource Filters page:

1. Log in to Kumulate.

See Logging In.

2. Browse to the administration tools.

See Finding the Administrator Tools.

3. From the ADMINISTRATION page menus, select Content > Resource Filters.

Kumulate opens the Resource Filters dialog.

You can use Attachment Template Resource Filters exclusively in group ACLs (Access 
Control Lists).

4. Select Future ACL Filters from the Type drop-down menu.

5. Click Add New Resource Filter.

6. Give the resource filter a useful name and description.

7. Select Attachment Template from the Type drop-down menu.

8. Click OK.

9. On the Modify Resource Filter page Rule Definition, add the attachments created by 
the specific user groups returned by this filter.

a. Select an attachment template type from the Metadata drop-down menu. The 
menu shows all built-in attachment templates, as well as any user-created 
templates.

b. Select a group. This group is the group that created the attachment. The filter 
returns only attachments created by the selected group. Select as many groups 
as needed from the Available groups list.

c. Click the right arrow to add the group to the Selected groups list.
d. Click Add.
e. Kumulate adds the group to the Matching Rule Set list.
f. Repeat these steps for each attachment to include in the resource filter.

10. To save the resource filter, click OK.
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Adding a Video Essence Resource Filter
Video Essence Resource Filters select instances based on their video metadata. They are 
used in workflows and transcode profiles. Always ensure that any changes made to a 
Video Essence Resource Filter will not negatively affect existing workflows and 
transcode profiles.

Use the following procedure to create a Video Essence Resource Filter from the 
Resource Filters page:

1. Log in to Kumulate.

See Logging In.

2. Browse to the administration tools.

See Finding the Administrator Tools.

3. From the ADMINISTRATION page menus, select Content > Resource Filters.

Kumulate opens the Resource Filters dialog.

4. Select Non ACL Filters from the Type drop-down menu. You can’t use Video Essence 
Resource Filters in ACLs.

5. Click Add New Resource Filter.

6. Give the resource filter a useful name and description.

7. Select Video Essence from the Type drop-down menu.

8. Click OK.

9. On the Modify Resource Filter page, add the attachments created by the specific user 
groups returned by this filter.

a. Select the metadata type from the Metadata pull down menu.
b. Enter the metadata value. The resource filter selects instances that satisfy the 

metadata conditions. You can select the afd, Bit depth, Frame Rate, and Scan Mode 
metadata values exclusively from a drop-down menu.

You can select the Aspect Ratio, Chroma Format, GOP Structure, Instance Format, 
Video Format, and Video Standard metadata values from a drop-down menu, or 
enter the values using the text box.

Kumulate adds a value entered into the text box to the drop-down menu if the 
value is also assigned to an instance.

Kumulate adds the SOM, Video Bitrate, Video Height, Video Width, and Wrapper 
metadata values into the text box.

Note:

• Kumulate interprets Text metadata values as regular expressions. The Contains 
option finds all values that match the regular expression, and the Not Equal option 
finds all values that do not match the regular expression.

• Kumulate interprets the Contains option as equal to when the metadata value is a 
numeric type, such as SOM.

• Kumulate disables the Range option for all metadata except SOM and Video Bitrate.
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c. To save the metadata condition, click Add.

10. To save the resource filter, click OK.

Adding an Audio Essence Resource Filter
Audio Essence Resource Filters select instances based on their audio metadata. They 
are used in workflows and transcode profiles. Always ensure that any changes made to 
an Audio Essence Resource Filter will not negatively affect existing workflows and 
transcode profiles. 

to create an Audio Essence Resource Filter from the Resource Filters page, do the 
following:

1. Log in to Kumulate.

See Logging In.

2. Browse to the administration tools.

See Finding the Administrator Tools.

3. From the ADMINISTRATION page menus, select Content > Resource Filters.

Kumulate displays the Resource Filters dialog.

4. Select Non ACL Filters from the Type drop-down menu.

Audio Essence Resource Filters are not used in ACLs. 

5. Click Add New Resource Filter.

6. Under the Filter Information heading, enter a useful name and description for the 
resource filter.

7. Select Audio Essence from the Type drop-down menu.

8. Click OK.

Kumulate opens the Modify Resource Filter page.

9. Enter the audio metadata type for the desired instances.

a. Select the metadata type from the Metadata drop-down menu.
b. Enter the metadata value.

The resource filter selects instances that satisfy the metadata conditions.

c. Set Bit Depth, Bitrate, Number of channels and Sample Rate metadata either to 
equal to a value (Contains), not equal to a value (Not Equal), or between two 
Kumulate Administration Guide



Resource Filters
Adding an Audio Essence Resource Filter

206
values (Range).

The Range option includes the lower bound, but excludes the lower bound in the 
match.

d. Set the Codec metadata values either to match a codec (Contains) or not match a 
codec (Not Equal). Select the codec from the drop-down menu or enter it into 
the text box.

The Range option is disabled for codec metadata.

c. To save the metadata condition, click Add.
d. To save the resource filter, click OK.
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Using Date Metadata in a Resource Filter
Date metadata, such as Purge Date, Create Date, and Last Update Date are stored with 
second precision; meaning the metadata contains date, hour, minute, and second 
information.

When creating a Date Resource Filter, the Contains option exactly matches the date and 
time of the metadata. An exact match with stored metadata is almost impossible 
because a resource filter only allows you to match a date without the time component. 

For example, a resource filter that selects assets where Create Date Contains January 1, 
2016 will only return assets that were created on January 1, 2016 at 00:00:00, instead of 
all assets that were created on January 1, 2016.

Instead, use the Range option to select date metadata that contains a particular day. 
The range includes the lower limit, but does not include the upper limit.

For example, to select all assets that were created on January 1, 2016, use a range 
between January 1, 2016, and January 2, 2016.

Because the upper limit of the range is not included, this range only matches assets 
with a Create Date of January 1, 2016.
Kumulate Administration Guide



Resource Filters
Searching with a Metadata-Based Resource Filter

208
Searching with a Metadata-Based Resource Filter 
In some cases it may be necessary to find all the resource filters that use specific 
metadata. For example, this may be necessary in cases where metadata needs to be 
deleted or replaced.

Searching for resource filters is accomplished using the search bar at the top of the 
Resource Filter list.

Use the following procedure to search resource filter metadata:

1. Select the type of resource filter to search.

2. Select the asset metadata type.

3. Select the metadata. Only the metadata associated with the asset type selected will 
be visible in the pull down menu.

4. After the metadata is selected, the Resource Filter list will only show resource filters 
that use the selected metadata.
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Access Control Lists (ACLs)
You can control user access and privileges by configuring Access Control Lists (ACLs).

■ Access Control Lists and Access Privileges

■ Access Privileges

■ Privileges and Permissions for Common Operations
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Access Control Lists and Access Privileges
Kumulate uses Access Control Lists (ACLs) to control how users interact with particular 
groups of resources.

ACLs use resource filters to give groups access to specific assets, instances, 
attachments, locations, and metadata. Access Privileges are used to give group access 
to administrative tasks.

It is important to understand how ACLs and access privileges work together before 
creating a user group.

ACLs are granular, allowing different access permissions for different groups of 
resources. ACLs use resource filters to specify the exact resources users in groups have 
access to.

There are four types of ACLs:

• Storage Locations

• Metadata

• Attachment Templates

• Assets and Instances

Storage Location
The ACL for Storage Locations allows or denies users the ability to view or modify 
storage and Archive Locations and their contents.

Access is given to groups of locations defined by resource filters. A group will have no 
access to locations that are not selected by a resource filter.

Metadata
The Metadata ACL sets whether users in the group can search, view, or modify 
metadata. Access to metadata ACLs must be set at least to Search for search operations 
to work properly. Administrators can now assign a default set of pinned metadata 
fields.

Access Description

View The minimum access level needed for users to view locations and their 
contents. If a location is not visible to the user, the user cannot access the 
instances on that location, even if their assets are visible.

Modify Allows users to move and transcode instances to the locations in the 
resource list. If a user does not have modify access to a location they will not 
see the location as a transcode or transfer destination.
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Attachment Template
Attachment Template ACLs give a group's users permission to access asset 
attachments. These include marks, segments, closed captions, formatsheets, and any 
user-created attachment types.

Resource filters are automatically created for each individual attachment type, 
including user-created attachment types. This allows ACLs to be set for each 
attachment type, giving groups specific permissions to specific attachments.

Asset and Instance
Asset and Instance ACLs give a group's users permission to access assets and instances. 
ACLs for assets and instances are set separately. However, the two ACLs work together. 
Instances within an asset are not visible unless the asset is visible. Assets must have at 
least View permissions for the instances within them to be visible.

Access Description

View The minimum access level required for users to view and download 
attachments.

Add Allows users to upload attachments. The Add access level depends on the 
View access level. View access is automatically added when Add is selected. 
If View is deselected then Add is automatically deselected.

Modify Allows users to modify existing markers and segments, and modify 
attachment metadata. The Modify access level depends on the View access 
level. View access is automatically added when Modify is selected. If View is 
deselected then Modify is automatically deselected.

Delete Allows users to delete attachments. The Delete access level depends on the 
View access level. View access is automatically added when Delete is 
selected. If View is deselected then Delete is automatically deselected.
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Asset ACL permissions provide the following access levels:

Instance ACL permissions provide the following access levels:

Access Description

View The minimum access level needed for users to view assets. No 
information about assets or instances is available unless the ACL access 
is set to View.

Modify Allows users to modify asset metadata. The Modify access level depends 
on the View access level. View access is automatically added when 
Modify is selected. If View is deselected then Modify is automatically 
deselected.

Delete Allows users to delete assets, including all instances in the asset, 
regardless of the Instance Access Control Level. The Delete access level 
depends on the View access level. View access is automatically added 
when Delete is selected. If View is deselected then Delete is 
automatically deselected.

Copy Allows users to transfer instances from the asset search results page. The 
Copy access level depends on the View access level. View access is 
automatically added when Copy is selected. If View is deselected then 
Copy is automatically deselected.

Transcode Has no effect on the ability to transcode instances. Access to 
transcoding is set exclusively by the Instance ACLs.

Access Description

View The minimum access level needed for users to view instances and 
extract thumbnails. No information about instances is available unless 
the ACL access is set to View.

Modify Allows users to modify instance metadata and extract thumbnails. The 
Modify access level depends on the View access level. View access is 
automatically added when Modify is selected. If View is deselected then 
Modify is automatically deselected.
Kumulate Administration Guide



Access Control Lists (ACLs)
Access Control Lists and Access Privileges

213
Delete Allows users to delete instances and extract thumbnails. The Delete 
access level depends on the View access level. View access is 
automatically added when Delete is selected. If View is deselected then 
Delete is automatically deselected.

Copy Allows users to transfer instances and extract thumbnails. The Copy 
access level depends on the View access level. View access is 
automatically added when Copy is selected. If View is deselected then 
Copy is automatically deselected.

Transcode Allows users to transcode instances and extract thumbnails. The 
Transcode access level depends on the View access level. View access is 
automatically added when Transcode is selected. If View is deselected 
then Transcode is automatically deselected.

Access Description
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Access Privileges
Access Privileges control which parts of the Kumulate system users in the group can 
access. Privileges can be set at different levels for the following:

• Storage Location Administration

• Asset Access

• Instance Access

• Administrative Functions

• Proxy Access

• Cancel Operations and Priority Changes

Storage Location Administration
A Storage Administrator group and a default Storage User were added in release 2.0 to 
provide access to storage administration tasks on the Locations page without giving the 
user access to all Administration capabilities.

The following privileges apply to archive, cache, and Storage Location configuration 
functions:

Privilege Level Description

Storage 
Administrator

Users in this group have full control as identified in the next entry.

Full Control Users in the group can create, delete, modify, and view Storage 
Locations.

Add Users in the group can create, modify, and view Storage Locations, 
but cannot delete them.

Modify Users in the group can modify and view Storage Locations, but can 
neither create nor delete locations.

Read Users in the group can only view the Storage Location 
configuration, and cannot modify, create, or delete locations.

Storage User Users in the group have access to limited administrative Storage 
Location functions.

No Access Users do not have access to the Storage Location Administration 
page, but they can still view Storage Locations and their contents 
from the Locations page.
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Asset Access
The following privileges set access to assets:

Note: Only No Access prevents users from manipulating instances. All other privilege 
levels allow users to create and delete instances, transcode and transfer 
instances, extract metadata and thumbnails, and extract instance segments 
into new assets (Partial Restore).

Instance Access
The following privileges set access to instances:

Privilege Level Description

Full Control Users in the group can create, delete, modify, and view assets.

Add Users in the group can create, modify, and view assets, but cannot 
delete them.

Modify Users in the group can view assets, and change asset metadata, but 
cannot create or delete assets, nor can they add attachments; 
including segments and markers.

Read Users in the group can only view the assets and cannot modify, 
create, or delete assets.

No Access Users have no rights to assets and cannot search for assets, nor can 
they search for instances.

Privilege Level Description

Full Control Users in the group can create, delete, modify, and view instances.

Add Users in the group can view, create, transfer, transcode instances, 
and extract thumbnails and metadata, but cannot delete instances.

Modify Users in the group can view instances and change instance 
metadata, but cannot create, delete, transfer, or transcode 
instances, nor can they extract thumbnails or metadata.

Read Users in the group can only view and play instances.

No Access Users have no rights to instances or assets.
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Administrative Functions
The Administration Privileges set the access privileges for the entire administration 
section of the Kumulate web interface. If these privileges are set to a stricter value than 
the other settings, these settings will take precedence.

Proxy Access
These privileges govern how users in the group interact with proxy instances.

Note: If the asset privileges are set to No Access, users in the group will be unable to 
access proxy instances.

Privilege Level Description

Full Control Users in the group have full access to all administrative functions.

Add Users in the group can create, modify, and view configurations, but 
cannot delete elements such as Storage Locations, groups, 
resource filters, and so on.

Modify Users in the group can modify and view configurations, but cannot 
create nor delete elements such as Storage Locations, groups, 
resource filters, and so on.

Read Users in the group can only view configurations, but cannot 
modify, create, or delete elements such as Storage Locations, 
groups, resource filters, and so on.

No Access Users do not have access to the Storage Location Administration 
page.

Privilege Level Description

Full Control Users in the group can view, play, create, and delete proxy 
instances.

Add Users in the group can view, play, and create proxy instances, but 
cannot delete them.

Modify Users in the group can view, play, create, and delete proxy 
instances.

Read Users in the group can only view proxy instances, but cannot 
modify, create, or delete them.

No Access Users cannot see proxy instances.
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Cancel Operations and Priority Changes
The Cancel Operations and Priority Changes privileges set whether users in the group 
can cancel operations, and change priorities on operations, respectively. These 
privileges are set to either No Access or Full Control.

Setting the privilege to Full Control allows users to cancel or change priorities. Setting 
the privilege to No Access prevents users from canceling or changing priorities.
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Privileges and Permissions for Common 
Operations

The following sections outline the minimum group privileges and permissions needed 
for common operations.

Privileges and Permissions for Searching
Searching requires access to the metadata of the assets being searched and read access 
to the assets themselves.

There must be access to instances and assets at a minimum. To successfully search 
attachments, including captions, marks, and segments, the group additionally needs 
access to the type of attachment they are allowed to search.

Minimum Requirements to Search Assets and Instances
The following are the minimum requirements to successfully search and view assets 
and instances. These permissions and privileges do not give the group the ability to 
modify assets, instances, or their metadata in any way.

Privilege Level

Asset Read

Instance Read

ACL Resource Filter Action Description

All Metadata Search, View The ACL must use the AllMetadata resource 
filter.

Read Only Metadata Search, View The ACL must use the ReadOnlyMetadata 
resource filter.

Assets View The asset resource filter used with the ACL must 
include assets the group should have access to 
and exclude any assets the group should not 
have access to.

Instances View The instance resource filter used with the ACL 
must include any instances the group should 
have access to and exclude any instances the 
group should not have access to.

Instances that are on locations the group does 
not have access to will not be visible.
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Minimum Requirements to Search Attachments
The following are the minimum requirements to successfully search attachments. 
These permissions and privileges give the group the ability to view and download 
attachments, but do not give the group the ability to modify, delete, or upload 
attachments, or to modify attachment metadata.

Note: Assets and instances can be viewed only.

Privilege Level

Asset Read

Instance Read

ACL Resource Filter Action Description

All Metadata Search, View The ACL must use the AllMetadata resource 
filter.

Read Only Metadata Search, View The ACL must use the ReadOnlyMetadata 
resource filter.

Assets View The asset resource filter used with the ACL must 
include assets the group should have access to 
and exclude any assets the group should not 
have access to.

Instances View The instance resource filter used with the ACL 
must include any instances the group should 
have access to and exclude any instances the 
group should not have access to.

Instances that are on locations the group does 
not have access to will not be visible.

Attachments View Multiple ACLs can be created, each 
corresponding to a resource filter for a specific 
attachment type.

Kumulate automatically creates resource filters 
for attachment types. These resource filters are 
named RF_<attachment_type>.

The ACLs and their resource filters must cover 
all the attachments the group should have 
access to.
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Privileges and Permissions for Transferring
Transferring an instance to another location is a copy operation, not a move operation. 
When an instance is transferred to a location, a new instance is created on the target 
location, but not removed from the original location.

A group needs privileges and permissions to create new instances on a location to 
successfully transfer instances to the location.

A group does not need the rights to modify assets or Storage Locations to create new 
instances.

Note: Groups with only transfer privileges are still able to perform dissimilar transfers, 
which include transcode operations.

Privileges and Permissions for Transcoding
Transcoding requires access to the cache. The cache acts as a staging area for 
transcoding instances. If the group does not have permission to access the cache, users 
in the group will be unable to transcode instances and create low-resolution proxy 
instances.

A group needs privileges and permissions to create new instances to successfully 
transcode instances.

Privilege Level

Storage Unit Read

Asset Read

Instance Add

ACL Resource Filter Action Description

Storage Locations Modify The instance resource filter used with the ACL must 
include all the locations that the group should be 
able to transfer instances to.

Assets View The instance resource filter used with the ACL must 
include all the locations where the group should be 
able to view instances.

Instances Copy The instance resource filter used with the ACL must 
include all the locations that the group should be 
able to copy instances to.
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A group does not need the rights to modify assets or Storage Locations to create new 
instances.

Privileges and Permissions for Marking
Marks made using the Kumulate player are stored as attachments. Because of this, 
access to the mark attachment type regulates the way a group can use marks.

Different access levels are available for marks. Groups can be given permission to view, 
add, modify, or delete marks.

The following privileges and permissions are required for any group that needs to 
access marks:

Privilege Level

Storage Unit Read

Asset Read

Instance Add

ACL Resource Filter Action Description

Storage Locations Modify Transcoding requires access to the Kumulate 
cache. The resource filter used must include the 
cache otherwise all transcode operations will fail.

Assets View Transcoding requires access to the Kumulate 
cache. The resource filter used must include the 
cache otherwise all transcode operations will fail.

Instances Transcode Transcoding requires access to the Kumulate 
cache. The resource filter used must include the 
cache otherwise all transcode operations will fail.

Privilege Level

Asset Read

Instance Read

Proxy Read

ACL Resource Filter Action

Assets View

Instances View
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The group must use an ACL with an attachment resource filter that includes the Marker 
Attachment Type.

A Marker Attachment Resource Filter (RF_MARKER) is already included in Kumulate. 
However, the ACL can use any attachment resource filter that includes the marker 
attachment template. See Adding an Attachment Template Resource Filter for more 
information.

The following ACL permissions are needed for access to different actions on marks:

Note: For users in the group to have access to the marks they created, the Group 
Name must be added to the Marker Attachment Resource Filter. Users in the 
group will be unable to view, modify, or delete the marks they have created if 
the Group Name is not added to the resource filter. See Adding an Attachment 
Template Resource Filter for more information.

Privileges and Permissions for Segmenting
Segments created using the Kumulate player are stored as attachments. Because of 
this, access to the segment attachment type regulates the way a group can use 
segments. Different access levels are available for segments. Groups can be given 
permission to view, add, modify, or delete segments.

Note: The privileges and permissions needed to extract (partial restore) segments are 
covered in Privileges and Permissions for Extracting Segments.

Mark Action ACL Action Description

View Marks View Allows users in the group to view marks. This action is 
selected automatically when any of the other actions 
are selected. If View is deselected all the other actions 
will also be deselected automatically.

Add Marks Add Allows users in the group to create marks.

Edit Marks Modify Allows users in the group to edit the mark comment 
and color.

Delete Marks Delete Allows users in the group to delete marks.
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The following privileges and permissions are required for any group that needs to 
access segments:

The group must use an ACL with an attachment resource filter that includes the Marker 
Attachment Type.

A segment attachment resource filter (RF_SEGMENTS) is already included in Kumulate. 
However, the ACL can use any attachment resource filter that includes the segment 
attachment template. See Adding an Attachment Template Resource Filter for more 
information.

The following ACL permissions are needed for access to different actions on segments:

Note: For users in the group to have access to the segments they created, the Group 
Name must be added to the Segment Attachment Resource Filter. If the Group 
Name is not added to the resource filter, users in the group will be unable to 
view, modify, or delete the segments they have created. See Adding an 
Attachment Template Resource Filter for more information.

Privilege Level

Asset Read

Instance Read

Proxy Read

ACL Resource Filter Action

Assets View

Instances View

Segment Action ACL Action Description

View Segments View Allows users in the group to view segments. This 
action is selected automatically when any of the 
other actions are selected. If View is deselected all 
the other actions will also be deselected 
automatically.

Add Segments Add Allows users in the group to create segments.

Edit Segments Modify Allows users in the group to modify the start and 
end times of segments, and their metadata.

Delete Segments Delete Allows users in the group to delete segments.
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Privileges and Permissions for Extracting Segments
A new instance and asset is created for a segment when it is extracted (partially 
restored). Because of this, the group needs the privileges and permissions required to 
create an instance.

The following permissions are required to be able to extract segments:

Privilege Level

Storage Unit Read

Asset Read

Instance Add

ACL Resource Filter Action

Storage Location View, Modify

Assets View

Instances View

Segment Attachments View

See Privileges and Permissions for Segmenting for details.
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Groups and Users
You can configure user groups to determine user controls and access.

■ User Group Permissions

■ Creating a Group

■ Setting Group Privileges and Permissions

■ Applying Changes Made to a Group

■ Creating a New Kumulate User

■ Managing User Sessions
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User Group Permissions
You give access to Kumulate by assigning rights to groups of users.

Each Kumulate group specifies how users assigned to it interact with Kumulate. Access 
privileges and controls are used to grant access to features, assets, instances, 
attachments, locations, and metadata.

Note: Because a group is assigned to a user when the user is created, groups must be 
created before their users.

The Montana User Group, Transcode Engine Group, and News Group are created by 
default.

The Montana User Group gives users full read and write administration privileges for 
the entire Kumulate system.

The Transcode Engine Group is used internally by the transcode engine.

Creating a Group
Use the following procedure to create a new group:

1. Click the Page menu button.

See the Page menu button on the screenshot for The Kumulate Control Bar.

Kumulate opens the Page drop-down menu.

2. Select System > Administration.

Kumulate opens the Administration page.

3. Select Security > Group Information.

Kumulate opens the Group Information page.

4. Click the arrow at the right of the See rights field.

Kumulate opens the See rights drop-down menu.

5. To enable editing, select Future.

6. To create a new group, click Add New User Group.

Kumulate opens the Create User Group page.

7. Enter a name for the group in the User Group Name text box.

For information about setting permissions, see Setting Group Privileges and Permis-
sions.

Setting Group Privileges and Permissions
Set group privileges and permissions to enable groups to perform their assigned tasks. 
Assigning a privilege or permission to a group automatically assigns it to every user in 
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that group. Don’t assign privileges or permissions to a group that you don’t want all the 
group’s members to have.

For common sets of privileges and permissions, see Privileges and Permissions for 
Common Operations.

Group access to administrative functions is set using the privilege pull-down menus as 
shown in the following figure:

ACL privileges control which parts of the Kumulate system a group can access. After the 
privileges are set, you must add permissions to particular resources by adding ACLs. 
ACLs need to be set for Storage Locations, metadata, attachments, assets, and 
instances. If an ACL is not set for any of these items, the users will not have access to 
them at all.

Use the following procedure to add an ACL to a group:

1. Click Add New ACL to open the Add ACL dialog.

2. Provide a unique ACL Identifier and select a Resource Filter to use in the Add ACL 
dialog, or create a new resource filter by selecting New from the pull down menu. 
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Resource filters are used to select particular assets, instances, Storage Locations, 
metadata, and attachments based on a set of requirements.

Note: The selected Resource Filter can be modified. However, modifying a resource 
filter will modify all ACLs and groups that use that filter. It is recommended to 
create a new Resource Filter rather than modifying an existing filter.

3. Select the access rights for the Resource Filter, then click OK to save and return to 
the Add User Group page.
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Add as many ACLs as required. The ACLs will be grouped according to type.

4. Click OK to save and return to the User Group Information page after all the ACLs 
have been added to the group.
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Applying Changes Made to a Group
Clicking OK will not automatically apply the changes when a group's ACLs and 
privileges have been configured or modified. The changes need to be applied from the 
User Group Information page. An attention symbol will remain next to the group until 
all the changes are either applied or canceled.

Click Apply Changes. A confirmation dialog will open; click OK to continue.

Changes to the asset and Instance ACLs only take effect after Kumulate is restarted. 
Kumulate must be restarted for the changes to take effect if the Changes are scheduled 
to be applied message appears after the dialog box closes.

Stop and start the Tomcat server to restart Kumulate.
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The attention symbol will disappear after the changes are applied.
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Creating a New Kumulate User
When a user is created, it is assigned to a group which controls its access and privileges. 
Because of this workflow, users should be added to Kumulate after their groups have 
been created. A user's group can be changed after the user has been created.

Use the following procedure to create a new user:

1. Log in to Kumulate.

See Logging In.

2. Browse to the administration tools.

See Finding the Administrator Tools.

3. From the ADMINISTRATION page menus, select Security > User Information.

Kumulate opens the User Information page.

4. Click Add New User.

5. Enter the following information for the user under the User Information heading:

Parameter Description

User ID The ID the user will use to log in to Kumulate.

This is required.

Password The user’s Kumulate password.

This is required.

User Name The user's actual name. This is not the name used to 
log in.

Location The user's location. The pull down menu is populated 
with Masstech Group by default, and by any 
previously-entered locations.

A new location can be entered by selecting New, then 
clicking ADD and entering the new location in the 
text box.

This is required.

Allow multiple login sessions Allows the user to be logged in to Kumulate multiple 
times simultaneously. This is useful in cases where the 
user may be logged in through the web interface 
from multiple locations.
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5. To create the user account, click OK.

Use Alias on MMP query Allows using an alias for MMP queries rather than the 
User ID.

User Group The group assigned to this user; this is required.

Department The user's department. The pull down menu is 
populated with Development by default, and by any 
previously-entered departments.

A new department can be entered by selecting New, 
then clicking ADD and entering the new department 
in the text box.

This is required.

Active Directory User Identifies whether the user is an Active Directory user.

Parameter Description
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Managing User Sessions
A list of all users connected to the Kumulate system can be viewed from the Session 
Control page.

Use the following procedure to view the Session Control page:

1. Log in to Kumulate.

See Logging In.

2. Browse to the administration tools.

See Finding the Administrator Tools.

3. From the ADMINISTRATION page menus, select Security > Session Control.

Kumulate displays a list of all users currently connected. Descriptions of the Session 
Control fields follow.

Parameter Description

User ID The user connected to Kumulate.

IP Address The IP address from where the user has connected to Kumulate.

Connections The number of connections this user has made from this IP address to 
Kumulate.

Time Out The amount of idle time left before the user is automatically 
disconnected.

Last Access The time the user last accessed Kumulate.

Action Kill Session automatically disconnects the user from Kumulate. The 
system will not ask for confirmation of this action.
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Authentication, 
Authorization, and Access 
Control
Configure user groups for user authentication.

Authentication by User Group
Kumulate User Groups control access to the Kumulate system. Each group sets 
privileges and access levels for the users in the group. Authentication is accomplished 
either through Kumulate, or optionally, through LDAP or SSO (Single Sign On).

Enabling Optional Kumulate LDAP Authentication
The groups used by Kumulate must have LDAP group counterparts with exactly 
matched names to use LDAP. Users are added automatically to the LDAP user groups.

When users log in to Kumulate for the first time, they are automatically added to the 
Kumulate group with the same name as their LDAP group. The Kumulate group sets the 
authorization and privileges for users belonging to the LDAP group of the same name. 
LDAP groups are only used to authenticate the users.
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The Public IP adapter's Preferred DNS server must be configured to point at the LDAP 
server IP address on the Kumulate server host.
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Enabling Optional Single Sign-On Authentication
Note: LDAP authentication must be enabled to use SSO authentication.

A Kumulate system configured to use LDAP authentication can optionally use SSO 
authentication.

A user belonging to a Kumulate LDAP user group has the option to use Windows 
credentials to log in to Kumulate when SSO authentication is enabled.

Clicking the Windows icon from the standard login screen passes the user to the SSO 
login screen.
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Transcode Engines, 
Transcode Profiles, and 
Thumbnail Profiles
Configure a transcode engine for transcoding the media on your system.

■ Transcode Engines, Transcode Profiles, and Thumbnail Profiles for Transcoding Me-
dia

■ Adding a Transcode Engine

■ Adding a Transcode Profile

■ Restoring Profiles

■ Adding a Thumbnail Extraction Profile
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Transcode Engines, Transcode Profiles, and 
Thumbnail Profiles for Transcoding Media

A Transcode Engine and a Transcode Profile are required to successfully transcode 
media. A Thumbnail Extraction Profile is required to successfully extract thumbnails.

The transcode engine is the external application that transcodes video and extracts 
thumbnails. A Kumulate system can be connected to more than one transcode engine.

Transcode Profiles provide information about how to transcode specific sources to 
specific destinations.

Thumbnail Extraction Profiles describe rules for extracting thumbnails from video 
sources.

Adding a Transcode Engine
Transcode engines are external applications used to transcode instances and extract 
thumbnails. Kumulate must be configured to connect to a transcode engine before it 
can be used. More than one transcode engine can be connected to the same Kumulate 
system.

Use the following procedure to add a transcode engine to Kumulate:

1. Log in to Kumulate.

See Logging In.

2. Browse to the administration tools.

See Finding the Administrator Tools.

3. From the ADMINISTRATION page menus, select DRAC Control > Transcode Engine.

4. Kumulate opens the Transcode Engine Information page.

5. Click ADD.

6. Enter values for the Transcode Engine, as follows:

Parameter Description

Transcode Engine ID Provide a unique name for the transcode engine.

Description Provide an optional description for the transcode 
engine.

Transcode Engine Hostname/IP The IP address of the transcode engine.

Transcode Engine Port The transcode engine's connection port.
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7. To add the engine, click OK.

For transcode The transcode engine can be used to transcode 
instances when this option is selected. When the 
option is deselected, transcode jobs will not be sent 
to this engine.

For extract metadata The transcode engine can be used to extract 
metadata from instances when this option is 
selected. When the option is deselected, extracted 
metadata jobs will not be sent to this engine.

Minimum Priority The minimum priority job this transcode engine will 
accept. The transcode engine will not accept any 
job with a priority below this value.

This is useful for creating dedicated transcode 
engines that only process high-priority jobs.

Parameter Description
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Adding a Transcode Profile
Use Transcode Profiles as templates for transcoding to Kumulate.

The Source Filter option provides information about what type of instances are 
handled by this profile. The profile is only made visible to instances that satisfy the 
source criteria.

The Destination Filter provides information about the format to transcode the source 
instance into.

A Transcode Profile provides the option of performing additional metadata mapping, 
as long as this mapping is supported by HQS.

A default Transcode Profile is available for creating proxy instances.

Use the following procedure to create additional profiles:

1. Log in to Kumulate.

See Logging In.

2. Browse to the administration tools.

See Finding the Administrator Tools.

3. From the ADMINISTRATION page menus, select Processing > Transcode Profile.

Kumulate opens the Transcode Information page.

4. Click Add Transcode Profile.

Kumulate opens the Add New Transcode Profile dialog.

5. Enter the configuration parameters for the transcode profile, as follows:

Parameter Description

Name Provide a unique name for the transcode profile.

Description Provide an optional description of the profile.

Status The status is Enabled by default. Select Disabled to prevent 
users from using the profile.

Source Filter Select a resource filter that returns the type of instances to 
transcode.

Destination Filter Select a resource filter that defines the parameters of the final 
result of the transcode.

Transcode/Rewrap Select Rewrap to rewrap MXF instances with additional 
metadata without modifying the video essence.

Rewrap can only be used when rewrapping MXF OP_ATOM and 
MXF OP_1An instances.

This is set to Rewrap by default.
Kumulate Administration Guide



Transcode Engines, Transcode Profiles, and Thumbnail Profiles
Adding a Transcode Profile

242
7. To add the profile, click OK. 

8. (Optional) If you want to remap audio channels, do the following:

a. Select Set Audio Mapping.

The drop-down menu shows all audio essence resource filters in the system, 
regardless of whether they are appropriate. For example, not all resource filters 
contain the Number of channels metadata.

b. From the Audio Filter drop-down menu, select an audio essence resource filter 
containing the Number of channels metadata. If no appropriate resource filter 
exists, select New from the Audio Filter drop-down menu.

Kumulate opens the Add Resource Filter dialog.

c. Enter a name and description. From the Type drop-down menu, select Audio 
Essence. Click Next.

Kumulate opens the Modify Resource Filter dialog.

d. Select Number of channels as the Metadata type. Add the number of channels for 
the destination instance in the Value text box.

e. To create the new resource filter, click ADD.
f. To add the metadata to the rule set, click ADD.
g. To save the resource filter and return to the Transcode Profile page, click OK.
h. On the Transcode Profile, select the new resource filter from the drop-down menu  

(in the following figure this is audioMapping).

i. To map the channels, click Add Essence.

To add more mappings, click Add Essence.

Extended Metadata Use this parameter to set metadata values for the destination. 
Extended metadata must agree with the HQS parameters.

Rename This parameter has been deprecated.

Attribute Select the type of transcode to perform.

Set to Proxy to create a low-resolution proxy. Set to Profile for 
all other types of transcodes.

The Required option has been deprecated.

Parameter Description
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Caution: Do not use Set Audio Metadata.

9. To save the profile, click OK.

Restoring Profiles
Restore Profile configurations are used by Storage Locations to specify the instance 
formats that can be copied to them.

When an instance does not match the Storage Location's Restore Profile is copied to 
the Storage Location, Kumulate searches for a transcode profile that matches the 
source and destination instance and uses it to transcode the instance to the 
appropriate format before copying it.

Note: the Storage Location can use more than one Restore Profile and each can 
describe a different instance format.

Restore Profiles can be created from the Storage Location's configuration page, or from 
the Restore Profile Information page.

Use the following procedure to create a Restore Profile:

1. Log in to Kumulate.

See Logging In.

2. Browse to the administration tools.

See Finding the Administrator Tools.

3. From the ADMINISTRATION page menus, select Locations > Storage.

Kumulate opens the Storage Location Configuration page.

4. Click Restore Profile Information.

Kumulate opens the Restore Profile Information List, displaying all restore profiles 
available in Kumulate.

Note: You can create, modify, or delete restore profiles from this page. However, since 
individual Storage Locations use restore profiles, we recommend creating them from 
the specific storage locations where they will be used.

5. Open the Storage Location Configuration page of the Storage Location that will use 
the restore profile.

6. Click Restore Profile Information.
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7. One profile is always created by default with the Storage Location. However, the 
default profile doesn’t contain enough Video Essence metadata to use with a 
Transcode Profile.

Note: The default profile should not be modified. Instead, a more appropriate restore 
profile should be added to the Storage Location.

8. If there is no suitable available profile in the system that can be used by the Storage 
Location, click Add Restore Profile to create a new profile.

9. Provide the new profile a name in the Name text box.

10. Select a Destination Filter to use with the Restore Profile, or click ADD to add a new 
Destination Filter. The Destination Filter is a Video Essence Resource Filter that 
describes the target instance.

Note: Do not use the default Resource Filter created with the Storage Location.

11. If a new Destination Filter is being used, provide the filter with a name and 
(optionally) a description, then click OK.
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12. Set the metadata for the filter.

13. Click OK to return to the Restore Profile page after all metadata has been set.

14. Click OK to save the profile. It will appear in the list of Restore Profiles associated 
with the Storage Location.

The Transcode Dissimilar For Transfer check box will already be selected. This option 
must be selected for the profile to be used to transcode an instance to the right format 
before copying it. The process of transcoding an instance before copying it is referred 
to as a dissimilar transfer.

A Transcode Profile that uses the same destination metadata as the Restore Profile must 
exist for a dissimilar transfer to succeed.

When a dissimilar transfer is made to the location, the instance is transcoded to the 
cache; then the transcoded instance is copied to the destination location. The instance 
on the cache will be kept unless the Delete Dissimilar From Cache check box is selected.
Kumulate Administration Guide



Transcode Engines, Transcode Profiles, and Thumbnail Profiles
Restoring Profiles

246
If a Transcode Profile that can convert instances to the Destination Profile format exists, 
the default profile's Transcode Dissimilar For Transfer check box can be deselected, and 
its priority can be lowered.

Note: If no Transcode Profile exists, create one using either the same destination filter, 
or a destination filter with the same metadata as used in the Restore Profile

.

Restore Profiles will be visible in the Available Profiles pull down menu and can be used 
by any Storage Location after the profile has been created.

Profiles can be edited by clicking the Pencil icon.
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A list of Storage Locations that use the Restore Profile is located on the right of the 
Modify Resource Profile dialog.

Note: Any changes to the Restore Profile will affect all listed Storage Locations.
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Adding a Thumbnail Extraction Profile
Thumbnail Extraction Profiles are used to specify how to extract thumbnails from an 
instance.

The default Thumbnail Extraction Profile uses scene detection to create up to ten 
thumbnails per video. This profile is not suitable for instances that are longer than five 
minutes.

New Thumbnail Extraction Profiles can be created that are better suited to different 
types of instances.

Caution: Do not edit the default Thumbnail Extraction Profile.

Use the following procedure to create a Thumbnail Extraction Profile:

1. Log in to Kumulate.

See Logging In.

2. Browse to the administration tools.

See Finding the Administrator Tools.

3. From the ADMINISTRATION page menus, select Processing > Thumbnail Profile.

4. Select a Thumbnail Extraction Type from the Extraction type drop-down menu.

There are two main extraction types to choose from: Scene Detection and Fixed 
Interval.

Note: Fixed Interval profiles are not supported on HQS prior to release 1.14.3.

5. Click New to open the Thumbnail Extraction Configuration page and create a new 
profile.
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Scene Detection Profiles
Scene Detection selects thumbnails based on scene changes in the video source.

Fixed Interval Profiles
Fixed Interval extracts thumbnails at fixed intervals in the video source.

Parameter Description

Configuration ID A unique name for the Thumbnail Extraction Profile.

Offset(s) The time (in seconds) from the start of the instance and the 
end of the instance. Thumbnails will begin being extracted 
from the offset time after the start of the instance and stop 
being taken at the offset time before the end of the 
instance.

Number of Thumbnails The maximum number of thumbnails to extract.

Resolution The resolution to extract the thumbnails

(width x height)
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Configuring Subtitle and Logo Burn-ins
Kumulate now provides the ability to burn subtitles and/or a logo into a video file as 
part of a transfer.

The burn in details and properties, such as subtitle size and logo position, are 
configured in the Masstech Transcode Engine using strings set up in the transcode 
profiles. After they are configured, these strings must be added to Kumulate as possible 
profiles using the following procedure:

1.  Log in to Kumulate.

See Logging In.

2. Browse to the administration tools.

See Finding the Administrator Tools.

3. From the ADMINISTRATION page menus, select Content > Metadata Management.

Kumulate opens the Metadata Management page.

4. Click the “+” to expand the Instance Metadata list.

Parameter Description

Configuration ID A unique name for the Thumbnail Extraction Profile.

Offset(s) The time (in seconds) from the start of the instance and the 
end of the instance. Thumbnails will begin being extracted 
from the offset time after the start of the instance and stop 
being taken at the offset time before the end of the 
instance.

Number of Thumbnails The maximum number of thumbnails to extract.

Resolution The resolution to extract the thumbnails

(width x height)
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2. Find and edit either subtitleProfile or logoProfile.

3. Select Modify List Value > Add new profiles. Enter the burn-in profiles configured in 
the Masstech Transcode Engine.
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After this is done, the Storage Location(s) must be set up. The burn-in options work 
with video servers, but not the cache or a media library. There are two modes that can 
be used to generate a burned-in file:

• Manual: In manual mode the user chooses the settings for each file as part of the 
transfer action. To enable manual burn-in for a location, navigate to Modify Storage 
Location > Configure > Transfer Tab and set the Enable Burn-in option to Yes. After 
saving, three new default settings appear related to Burn-in options that are config-
urable defaults for the UI:

–  Subtitle Language

– Default Subtitle Profile

– Logo Profile

To perform a manual burn-in for an asset, transfer it and select a location that has been 
configured for manual burn-in. A dialog will appear that has the burn-in options 
available for selection.
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• Automatic: In automatic mode the settings are added automatically using prede-
termined parameters added in Restore Profiles. To enable automatic burn-in for a 
location, navigate to Modify Storage Location > Configure > Restore Profile Infor-
mation, select a profile and then select Modify Profile. Set Burn In Enabled to 
ENABLED.

This adds the options this restore profile will use for a burn-in:

– Subtitle Language

– Subtitle Profile

– Logo Profile

Set up either Subtitle Language and Subtitle Profile for a subtitle burn-in, logo profile 
for a logo burn-in, or both.
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This restore profile will now use these settings. When an asset is transferred to a 
location that has automatic burn-in configured, the burn-in process will be executed as 
part of the transfer.

Note: Multiple restore profiles with different settings can be configured on the same 
location.
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Workflows
Configure workflow automation for your specific needs.

■ Workflow Automation

■ Profiles

■ Triggers

■ Commands

■ Creating a Workflow
Kumulate Administration Guide



Workflows
Workflow Automation

256
Workflow Automation
Workflows automate operations on assets and instances. Each workflow consists of one 
or more profiles, each consisting of a trigger and a command.

Profiles are triggered on Kumulate events, such as creating new instances or changing 
metadata, or they can be triggered by the completion of another profile. More than one 
profile can be triggered on the same event, allowing them to run in parallel.

A workflow is considered completed once all its profiles are completed.

Note: If a workflow includes a profile that deletes an asset, the workflow will not enter 
the completed state even if the asset was successfully deleted.

Profiles
A workflow profile consists of a trigger and a command. The command is executed 
when the conditions for the trigger are met.
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A workflow consists of one or more profiles.

Each profile command will have its own entry on the Jobs page when the workflow 
executes. However, individual profile commands cannot be canceled.

Note: If a profile is configured to run the delete command, this command will not 
appear in the Jobs view.
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Triggers
A workflow profile's command executes on the event defined by the trigger. If the 
trigger is not configured properly, the command will not execute, or will not execute 
under the right conditions.

Triggers are configured with a unique ID, an event, and one or more filters. Filters are 
non-ACL resource filters that narrow down the trigger to events that occur to specific 
types of assets or instances, on specific Storage Locations, or with specific metadata. 

The following events can be used as triggers:

Trigger Description

Add Instance The command is triggered when an instance is added 
to an asset.

Add Asset The command is triggered when an asset is added to 
Kumulate.

Add Segment The command is triggered when a segment is 
created.

Delete Instance The command is triggered when an instance is 
deleted.

Delete Asset The command is triggered when an asset is deleted.

Delete Segment The command is triggered when a segment is 
deleted.

PreparedCompleted The command is triggered when the metadata in the 
Workflow Manager Module's Prepare Completed 
Asset Metadata field is modified.

PreparedCompletedInstance The command is triggered when the metadata in the 
Workflow Manager Module's Prepare Completed 
Instance Metadata field is modified.

ProfileCompletion The command is triggered by the completion of 
another profile's command.

Rename Asset The command is triggered when an asset is renamed.

Timer Used to trigger the command at specific times, or at 
specific time intervals.

Update Asset The command is triggered when asset metadata is 
updated.

UpdateList
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Adding an instance Event
The profile's command is triggered when an instance is added to an asset.

This event is used in situations where a command must be executed when a new 
instance is discovered or created. The filter is used to refine the type of new instance 
that will trigger the command.

In this case, the command is triggered when a new low-resolution proxy is created on 
the cache.

The ProxyOnCache resource filter is an instance resource filter that selects cache 
instances with MP4 Instance format.

More than one filter can be used instead of one specific filter and shown in the 
following figure:

In this case, the OnCache filter selects instances on the cache, and the MP4Instance 
filter selects instances with MP4 Instance format. The command will be triggered when 
a new instance is added that is selected by both resource filters.

To trigger the command if a new instance is discovered on either of two Storage 
Locations, two instance resource filters that select instances on specific Storage 
Locations can be used instead of one resource filter.

In this case, the command will be triggered when a new instance is detected on either 
the GenericUNC1 or GenericUNC2 locations.
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Adding an Asset Event
The profile's command is triggered when a new asset is created. This event is used 
when a command must be executed whenever a new asset is created. The filter is used 
to refine the conditions that will trigger the command.

In this case, the command is triggered when any asset is created. Use a different 
resource filter to trigger the command when an asset is created with a certain set of 
metadata attributes.

The AvidLocation resource filter is an asset resource filter that selects assets with 
sources on the AVIDSTANDALONE Storage Location.

More than one filter can be used as shown in the following figure:

In this case, the AvidLocation filter selects sources on the AVIDSTANDALONE location, 
and the OnGenericUNC1 filter selects sources on the GENERICUNC1 location. The 
command will be triggered when an asset with a source on either of these Storage 
Locations is created.

Adding a Segment Event
The profile's command is triggered when a segment is created. This event is used when 
a command must be executed when a segment is created in an asset that satisfies the 
resource filter.
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In this case, the command is triggered when a segment is created in any asset. Use a 
different resource filter to trigger the command when a segment is created in a 
particular set of assets.

The DecemberAssets resource filter is an asset resource filter that selects assets that 
were created in December.

Deleting an Asset Event
The profile's command is triggered when an asset is deleted. This event is used when a 
command must be executed whenever an asset that satisfies the conditions of the filter 
is deleted.

In this case, the command is triggered when any asset created in December 2015 is 
deleted. The DecemberAssets resource filter is an asset resource filter that selects assets 
created in December 2015.

A profile that triggers on the deletion of an asset cannot operate on that asset. The 
profile can only use the Notify or Synchronize command.

Deleting an Instance Event
The profile's command is triggered when an instance is deleted. This event is used 
when a command must be executed when an instance that satisfies the conditions of 
the filter is deleted.
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In this case, the command is triggered when a low-resolution proxy is deleted from the 
cache. The ProxyOnCache resource filter is an instance resource filter that selects cache 
instances with MP4 Instance format.

More than one filter can be used instead of one specific filter.

In this case, the OnCache filter selects instances on the cache, and the MP4Instance 
filter selects instances with MP4 Instance format. The command will be triggered when 
an instance selected by both resource filters is deleted.

To trigger the command if an instance is deleted on either of two Storage Locations, 
use two instance resource filters that select instances on specific Storage Locations.

In this case, the command will be triggered when an instance is deleted from either the 
GenericUNC1 or GenericUNC2 locations.

Deleting a Segment Event
The profile's command is triggered when a segment is deleted. This event is used when 
a command must be executed when a segment is deleted from an asset that satisfies 
the resource filter.
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In this case, the command is triggered when a segment is deleted from any asset. Use a 
different resource filter to trigger the command when a segment is deleted from a 
particular set of assets.

The DecemberAssets resource filter is an asset resource filter that selects assets that 
were created in December.

Configuring a PreparedCompleted Event
The profile's command is triggered when the specific asset metadata listed in Workflow 
Manager Module's Prepare Completed Asset Metadata parameter is modified. The filter 
specifies the metadata values that will trigger the command.

In this case, the command is triggered when a particular user name is added to the 
AddedBy custom metadata element.

In the Workflow Manager Module, the Prepare Completed Asset Metadata will list this 
metadata.
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To trigger the command on more than one metadata element, enter a comma-
separated list of metadata in the Workflow Module's Prepare Completed Asset 
Metadata parameter.

In this case, the PreparedCompleted trigger can use changes to the AddedBy and View 
By All custom metadata to trigger the command. If changes to both the metadata are 
required to trigger the event, both metadata can be set in the same filter.

In this case, the AddedByViewAll Asset resource filter filters both AddedBy and View By 
All custom metadata.

Alternately, two filters can be used:

In either case, all the metadata listed must be modified at the same time for the 
command to be triggered.

Use an OR operator to allow the command to be triggered using any of the metadata 
listed in the Workflow Manager Module.
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Configuring a PreparedCompletedInstance Event
The profile's command is triggered when the specific instance metadata listed in 
Workflow Manager Module's Prepare Completed Instance Metadata field is modified. 
The filter specifies the metadata values that will trigger the command.

In this case, the command is triggered when an instance's IsTemporary custom 
metadata element has been set to YES.

In the Workflow Manager Module, the Prepare Completed Instance Metadata will list 
this metadata.

To trigger the command on more than one metadata element, enter a comma-
separated list of metadata in the Workflow Module's Prepare Completed Instance 
Metadata parameter.

In this case, the PreparedCompletedInstance trigger can use changes to the 
IsTemporary and IsProxy custom metadata to trigger the command. If changes to both 
the metadata are required to trigger the event, both metadata can be set in the same 
filter.
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In this case, the IsTempAndProxy Instance resource filter filters both AddedBy and 
IsProxy custom metadata.

Alternately, two filters can be used:

In either case, all the metadata listed must be modified at the same time for the 
command to be triggered.

Use an OR operator to allow the command to be triggered using any of the metadata 
listed in the Workflow Manager Module.

Configuring a ProfileCompletion Event
The profile's command is triggered when another profile's command completes. This 
event is used when a the command must be executed after a previous command has 
completed. The Processing Profiles pull down menu will list the profiles used in the 
workflow that is being modified. Select the profile that will trigger this profile.

For example, a profile that extracts thumbnails will be executed after CreateProxy, a 
profile that creates a low-resolution proxy, completes.
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Configuring a Rename Asset Event
The profile's command is triggered when an asset is renamed. This event is used when 
a command must be executed when an asset that satisfies the resource filter is 
renamed.

In this case, the command is triggered when any asset is renamed. Use a different 
resource filter to trigger the command when only certain assets are renamed.

The DecemberAssets resource filter is an asset resource filter that selects assets that 
were created in December.

Configuring a Timer Event
The Timer trigger is used to trigger the command at specific times, or at specific time 
intervals. Unlike other profiles, a profile that use a timer profile must be started 
manually using the Start button.

After the Start button is pressed, the profile is triggered according to the timer 
configuration. 

Note: The Start button is active even though it appears grayed out.

The Start button changes to a Stop button when it is clicked. The Stop button stops the 
profile from being triggered. The profile should be stopped before it is edited.

The Run button is used to run the profile only one time. Clicking the Run button 
triggers the command immediately, regardless of the timer settings.

To configure the command to be triggered at specific time intervals, keep the Simple 
cron pattern option deselected, and add the time interval (in seconds) to the field.
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To configure the command to be triggered according to a schedule, select the Simple 
cron pattern check box; an interval pull down menu will open.

Select whether you want the profile triggered every minute, hour, day, week, month, or 
year.

Helpful dialogs will open to help you create the cron pattern.

You can click Cron schedule pattern for more information.

Note: Cron scheduled jobs that cross between standard time and daylight savings 
time may behave unexpectedly when the time change happens.

The filter is used to select assets or instances on which to run the command. To run the 
command on any asset, use AllAssets, and to run the command on Any Instance, use 
AllInstances. Otherwise, select the appropriate filter. For example, to only run the 
command on instances on a specific Storage Location, select an instance resource filter 
that selects instances on that location.

In this case, the OnGenericUNC1 resource filter selects instances on the GenericUNC1 
Storage Location.
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Commands
A profile's command defines the action to perform on the asset or instance that 
triggered it. Commands are configured with a unique ID, an action, and one or more 
attributes. Attributes are non-ACL resource filters that select the instance or asset on 
which to perform the action, or select and set the metadata that needs to be modified, 
depending on the type of action.

The command's action will appear under the workflow name in the Jobs view of the 
web interface when the workflow executes.

Executed command: Processing_WF TranscodeCopyExtract

Kumulate performs a check on the command prior to its execution. If there is nothing 
to do for a command because an instance it creates already exists, its metadata is 
already extracted, or no instances or assets match its attributes, the command will not 
be executed, its profile will not complete, and the workflow will never enter the 
completed state.

The following actions can be taken by the command:

Command Description

Batch This has been deprecated. This will be replaced with the 
upcoming Story Board feature.

Copy Copy an instance from one Storage Location to another.

CreateThumbnail Extract a thumbnail from the proxy instance.

Delete Delete an asset or an instance.
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Copy Command
The Copy command copies the instance that triggered the command, or an instance of 
the asset that triggered the command, from one location to another. 

Note: Kumulate checks whether an instance belonging to the asset being processed 
exists on the destination before running the command. If an instance exists on 
the destination, the command will not be run. No message will be generated. 

The command needs two attributes. The first attribute is the source location, and the 
second attribute is the destination location.

Both attributes are instance resource filters. The source location attribute must include 
the source location's name. An instance format can be provided if only certain instance 
formats should be copied to the destination.

Only the destination location name is required in the destination location attribute. 
However, to ensure that Kumulate does not attempt to copy an incompatible instance 
to a location, the expected instance format should also be included in the attribute.

Extract Content Info Extracts clip instance information.

Extract Metadata Extract metadata from the instance that triggered the 
command.

Modify Metadata Modify the metadata of the asset or instance that triggered 
the command, using the attributes set in the command.

Notify Used only with Harris databases. Sends a notification to a 
Harris database.

Rename Asset Used to rename the asset.

Synchronize Synchronizes two connected Kumulate systems.

Transcode Transcode an instance using the transcode profile specified 
in the command attributes.

Command Description
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Create Thumbnail Command
The Create Thumbnail command extracts thumbnails from an instance. 

Note: If thumbnails have already been extracted for the instance's asset, the 
command will not be run. No message will be generated. 

The command requires an instance resource filter attribute that selects the type of 
instances from which to extract the thumbnails, and the thumbnail extraction profile to 
use.

In this example, the default thumbnail extraction profile is used to extract thumbnails 
from instances selected using the ProxyOnCache instance resource filter. If custom 
thumbnail extraction profiles have already been created, they can be selected from the 
Configuration pull down menu.

In this example (see the previous figure), the ExtractFive thumbnail extraction profile is 
used to extract thumbnails.

New thumbnail extraction profiles can be created by clicking Modify next to the 
Configuration pull down menu. Follow the instructions in the section on thumbnail 
extraction profiles.

Note: Only the Scene Detection extraction type is currently supported.

Delete Command
The Delete command deletes assets or instances that satisfy the conditions set in the 
command's attributes. If no asset or instance exists that satisfy the attribute, the 
command will not run.
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The Delete command requires one attribute that selects the asset or instance to delete. 
To delete a specific instance from the asset, select an instance resource filter from the 
list of attributes.

In this case, the NonProxyOnCache attribute is a resource filter that selects an instance 
on the cache that is not the low-resolution proxy.

Note: If the command deletes the asset that was passing through the workflow, the 
action will not appear in the list of jobs. The workflow will also never enter the 
completed state even if all its commands were completed successfully.

Extract Metadata Command
The Extract Metadata command extracts metadata from one or more instances.

Note: Kumulate checks the metadata before running the command. If metadata has 
already been extracted from the instance, the command will not run. 
Consequently, the workflow may not enter the completed state.

Select an instance resource filter attribute that narrows down the type of instance from 
which to extract the metadata.

In this case (see previous figure), OnGenericUNC1 selects instances that are located on 
the GENERICUNC1 Storage Location.

Note: The Extract Metadata command only runs on instances.

Modify Metadata Command
The Modify Metadata command modifies the metadata of the asset being processed, 
or of an instance being processed. Administrators can now assign a default set of 
pinned metadata fields.
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Note: Kumulate checks the metadata before running the command. If the asset or 
instance metadata is already set, the command will not be run. No message will 
be generated.

When modifying asset metadata, the command takes only one attribute that defines 
the new metadata values. When modifying instance metadata, an additional attribute 
selecting the instances to modify must be used.

Note: Only select one metadata-modifying attribute. The profile will not be triggered 
if more than one attribute is used.

To modify the metadata of the asset being processed, select an attribute that is an asset 
resource filter that modifies metadata.

In this case (see previous figure), the RenameAsset attribute changes the asset name 
and title.

Select two instance resource filter attributes to modify the metadata of an instance. The 
first attribute in the list filters the instances that will be modified, and the second 
attribute modifies the instance metadata.

Note: If no instance satisfies the first attribute, the command will not run.

In this case (see previous figure), ProxyOnCache selects the low-resolution proxy on the 
cache.

And the IsProxy attribute sets the IsProxy custom instance metadata to YES.
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Transcode Command
The Transcode command transcodes the instance the workflow is operating on using 
the selected transcode profile.

Note: Kumulate checks whether an instance that matches the transcode profile exists 
on the destination before running the command. If an instance that matches 
the profile exists on the destination, the command will not be run. No message 
will be generated.

Select a transcode profile from the list of attributes.

Only one transcode profile can be used at a time. If more than one transcode profile is 
selected, the command will not run. No message will be generated.
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Creating a Workflow
Workflows are used to automate tasks. Each workflow is composed of a set of profiles 
that execute commands when triggered by specific events in Kumulate.

Use the following procedure to create a workflow:

1. Log in to Kumulate.

See Logging In.

2. Browse to the administration tools.

See Finding the Administrator Tools.

3. From the ADMINISTRATION page menus, select Processing > Workflow Information.

Kumulate opens the Workflow Information page.

4. Click Add Workflow.

5. Use the ID field to provide a unique name for the workflow. Optionally, a 
description of the workflow can be added. The workflow name should reflect the 
actions performed by the workflow.

6. Select the Exclusive Workflow check box if this workflow should run only when no 
other workflow is running.
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7. The workflow Status can be set to Active or Inactive. An inactive workflow is not 
executed.

Note: Do not use the Test status.

8. Click OK to save the workflow. You will be returned to the Workflow Information 
page.

9. Click the Pencil icon next to the workflow to add profiles to the workflow.
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Creating a Profile
A workflow is composed of at least one profile. Profiles execute commands when they 
are triggered by an event. After creating a workflow, click Add Profile from the 
Workflow Definition page to open the Processing Profile Information page.

The profile must be given a unique name. The name should reflect what the profile 
does, so it should include an action word such as extract, transcode, or copy. Because 
several profiles may exist that perform the same action, a way of differentiating 
between the different profiles that perform the same actions should be used.

The maximum number of times its command can be retried upon failure, and its 
priority must also be provided.
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Configuring the Trigger
The profile's command is executed when a trigger event is detected. If the trigger is not 
configured properly, the command may not execute, or it may execute at an 
unexpected moment.

The section on Triggers provides additional information about configuring different 
types of triggers. 

To use a previously-configured trigger, select a trigger from the Configured Triggers 
pull down menu.

This will automatically populate the trigger fields. Do not forget to save the trigger.

Use the following procedure to create a new trigger:

1. Click ADD in the Triggers page.

Parameter Description

Profile ID A unique profile name.

Completed profiles can be used as triggers in their workflows. A 
descriptive name helps differentiate between the profiles in the 
workflow, making it less likely that a trigger will be misconfigured.

Profiles should be named after the function they perform. For example, 
a profile that extracts metadata from a newly-discovered instance 
could be ExtractMetadataFromNew.

Description A description of the profile can help differentiate between similar 
profiles. This is optional.

Retry The number times to retry the command if it fails. By default, retry is set 
to unlimited, meaning that the command will be retried infinitely. The 
retry interval is set in the Workflow Manager Module.

Priority The command’s execution priority. This defaults to normal.
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2. Enter a unique name for the trigger in the Trigger ID field. 

The trigger name should reflect the event associated with the trigger; for example, 
instanceDiscoveredOnSL, or TranscodeCompleted. Because several triggers may 
exist that are triggered on similar events, a naming scheme that differentiates 
between the similar triggers should be used.

3. Select the event that will trigger the command from the Event pull down menu. 
More information about events can be found in the Triggers section.

4. Select a resource filter that identifies the conditions that will trigger the command 
for the event from the Filter drop-down menu.

Click Add to create a new non-ACL resource filter if no suitable filter is available.

Note: Do not modify an existing resource filter unless it is certain that this resource 
filter is not used in another profile or workflow, and is not used in another part 
of Kumulate. Filters can be used in more than one trigger, and also in 
commands. To prevent confusion, filter names should reflect the types of assets 
that it selects; for example, NewInstances or InstancesOnCache.

5. To add more than one filter, click Add Filter and select whether both or either filter 
condition must be satisfied.

6. Click Save to save the trigger.

Configuring the Command
Configure the command that will execute when the trigger conditions are detected. If 
the command is not configured properly, it might not execute, or it may produce 
unexpected results. See the Commands section for more information.

To use a previously configured command, select a command from the Configured 
Commands pull down menu.
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Use the following procedure to create a new command:

1. Click ADD on the Commands page.

2. Enter a unique name for the command in the Command ID text box. The 
command's name should reflect the type of action it will execute; for example, 
CreateProxyInstance, or ExtractThumbnails. Because several commands may exist 
that perform similar actions, a naming scheme that differentiates between the 
similar commands should be used.

3. Enter the number of times to execute the command in the Number of executions 
text box.

4. Select the command to execute from the Action pull down menu. See the 
Commands section for more information.

5. Select a resource filter the command will act on from the Attributes pull down 
menu. Click Add to create a new non-ACL resource filter if no suitable filter is 
available.

Note: Do not modify an existing resource filter unless it is certain that this resource 
filter is not used in another profile or workflow, and is not used in another part 
of Kumulate. Attributes can be used in more than one command and in 
triggers. To prevent confusion, attribute names should reflect the types of 
assets selected; for example, CacheLocation or InstancesOnCache.

6. Click Save to save the command.

Setting the Final/Transient Value
The only profiles that should be marked as final are profiles that appear last in a 
workflow, or profiles that create an instance through a copy or a transcode. All other 
profiles must be set to transient.
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Configuring Email Notifications (Optional)
The profile can be configured to send notification emails.

Note: The email alert feature must be enabled, and email templates must be created 
to use this feature.

Select the condition to send a notification (Failed in the following figure), then select 
the email template to use (Failed Profile in the following figure).

Optionally, an asset or instance filter can be used, and a priority for the email can be set. 
The notification will only be sent if the asset or instance processed by the profile match 
the filter.
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Email Alerts and 
Notifications
Configure Kumulate to send logs, alerts, and notifications via email.

■ Email Configuration for Alerts and Notifications

■ Configuring the Email Service

■ Configuring Email Notification Templates
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Email Configuration for Alerts and Notifications
When the email alerts feature is turned on, operator emails will automatically start 
being sent to the specified emails. Workflow notifications will only be sent if the email 
alerts feature has been enabled. The email notification system can also be configured 
to send zipped log files to the recipient. 

Configuring the Email Service
The email service that sends workflow notifications, log messages, and operator alerts 
is configured in the System module.

Before configuring the email service, ensure that the address that will be used to send 
emails can send emails, that the SMTP port and server are known, and that the TSL or 
SSL port is known.

Note: The password for the address that will send email is visible in the System 
module.

Use the following procedure to configure the email service:

1. Log in to Kumulate.

See Logging In.

2. Browse to the administration tools.

See Finding the Administrator Tools.

3. From the ADMINISTRATION page menus, select Modules.

4. Click the Advanced button on the System Control page.

5. Click the Pencil icon to the left of the SYSTEM module.
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6. Enter the information in the parameters identified in the following figure (the 
parameter descriptions are in the table following the figure):

Parameter Description

Email From Address The sending email address for notification emails. This must be 
identical to the email address specified in Email User Name.

Use SMTP Auth When set to YES, authentication is done through SMTP. 
Generally, this should be set to YES.

Email SMTP Host The SMTP host being used to send emails.

SMTP Port The non-SSL SMTP port. This is typically port 25.

SMTP SSL Port The SSL or TSL SMTP port.

SSL uses port 465 by default. TLS uses port 587 by default. 

If TLS is used, ensure that StartTLS is set to YES.
Kumulate Administration Guide



Email Alerts and Notifications
Configuring the Email Service

285
6. Click OK to save the configuration.

Email Service Turns the email service on and off. 

If the email service is off, no emails will be sent by the system.

Note: Most operator messages are not sent using email, 
even when the service is on.

Email Subject The subject line for emails containing logs and operator 
messages. Subject lines for emails sent by workflows are set in 
their respective email templates.

Email To Address The email address of the recipient of log and operator 
messages. Recipients for emails sent by workflows are set in 
their respective email templates.

Use SSL SMTP Set to YES to use SSL; set to NO if TSL will be used instead.

Email User Name The email address of the sender. This must be identical to 
Email From Address.

Email User Password The sender's SMTP authentication password.

Operator Email

Optional Email 1

Optional Email 2

Additional email address which can receive operator email. 
Any or all of these parameters can contain an email address. 

Note: If more than one Operator Email parameter is present, 
only the second one is active. If only the first of the 
two has been assigned an email address, emails will 
never be received at that address. Send Operator 
Email must be set to YES for emails to be sent to these 
recipients.

Send Logs By Email Zipped log files are sent to the Email To Address when this is 
set to ON.

Send Operator Email Operator emails are sent to the email addresses specified by 
Operator Email, Optional Email 1, and Optional Email 2 when 
this is set to ON.

Start TLS Set to YES to use TSL; set to NO if SSL will be used instead.

Parameter Description
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7. Restart Kumulate for the changes to take effect. On the Kumulate server host, stop 
and restart Tomcat.
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Configuring Email Notification Templates
Email templates must be created for Kumulate to send workflow notifications by email. 
Workflows will only send notifications if the email alerts feature is enabled.

Use the following procedure to create an email template:

1. Log in to Kumulate.

See Logging In.

2. Browse to the administration tools.

See Finding the Administrator Tools.

3. From the ADMINISTRATION page menus, select Processing > E-mail templates.

Kumulate opens the E-mail Templates page.

4. Click the ADD button.

5. Provide the template with a unique name, the email address of the recipient, a 
subject for the email, and body text for the email.

To send the notification to two or more recipients, the email addresses must be 
separated by commas.

The email subject and body can include dynamic fields which specify workflow, 
asset, and instance information, making the email more informative.
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To add a dynamic field, right-click on the email subject or body where the field 
should appear, and select the field from the pull down menu.

The dynamic field to insert will appear enclosed in curly braces in the subject or 
body text.

6. Click OK to save the template. The email generated using the previous template will 
look like the following figure when it is received:
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System Control and 
Configuration Modules
Configure system control and configuration modules for transcoders, indexers, loggers, 
email servers.

■ System Modules

■ Accessing System Modules

■ ALL Module Configuration

■ Asset Manager Module

■ CMI Module

■ DM Manager Module

■ Media Library Module

■ MMC Module

■ Reports Manager Module

■ SSC Module

■ System Module

■ UII Module

■ Workflow Manager Module

■ XMTI Module

■ SDBI Module
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System Modules
System control and configuration modules control how Kumulate operates. Settings for 
transcoders, indexers, loggers, email servers, and DataMovers are accessible through 
Kumulate system modules.

Accessing System Modules
Use the following procedure to access system modules:

1. Log in to Kumulate.

See Logging In.

2. Browse to the administration tools.

See Finding the Administrator Tools.

3. From the ADMINISTRATION page menus, select Modules.

4. (Optional) To access system configuration modules, the Media Library module, and 
disabled system control modules, click the ADVANCED button.

Caution: Do not click the Restart System or Halt System buttons
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ALL Module Configuration
Caution: Don’t modify any parameter not in the following list. Modifying an 

unlisted parameter might affect Kumulate operations.

Parameter Description

Default StandardID The video system standard used in the Kumulate system. 
Defaults to NTSC.

Default Title Use this as an asset's title if the information cannot be 
extracted from the asset itself.

Default VideoServer Type Sets the video server that is selected by default when 
creating a new Storage Location.

The default is Repository.

Setting this to an invalid Storage Location name, or simply 
misspelling the Storage Location name, will cause the 
following message to appear when attempting to create a 
new Storage Location: 
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Asset Manager Module
Caution: Don’t modify any parameter not in the following list. Modifying an 

unlisted parameter might affect Kumulate operations.

Parameter Description

Delete Asset with No Instances When set to ON, Kumulate automatically deletes 
assets that have no instances associated with them.

Trace Level Sets the logging level for the module.

• OFF: Only errors are logged.
• NORMAL: Errors and trace messages are logged.
• DEBUG: Logs all messages, including debug mes-

sages.
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CMI Module
Caution: Don’t modify any parameter not in the following list. Modifying an 

unlisted parameter might affect Kumulate operations.

Use the CMI Module to mark already discovered instances.

DM Manager Module
Caution: Don’t modify any parameter not in the following list. Modifying an 

unlisted parameter might affect Kumulate operations.

Use the DM Manager module for configuring the DataMovers.

Parameter Description

Processed Keyword Used as a mark that is inserted into an instance wrapper to 
indicate that the instance has already been discovered and 
copied in by the Kumulate system.

Because this mark cannot be longer than 32 characters on 
Leitch Storage Locations, this setting can be overwritten on 
Leitch Storage Locations only using the Marking Key parameter.

This value must be unique to each Kumulate system.

Trace Level Sets the logging level for the module.

• OFF: Only errors are logged.
• NORMAL: Errors and trace messages are logged.
• DEBUG: Logs all messages, including debug messages.

Parameter Description

Local DataMover Port The Kumulate server DataMover listening port. 
Defaults to port 2089.

Process Restart Timeout (seconds) If the DataMover does not restart in this time, it 
remains offline.

Trace Level Sets the logging level for the module.

• OFF: Only errors are logged.
• NORMAL: Errors and trace messages are 

logged.
• DEBUG: Logs all messages, including debug 

messages.
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Media Library Module
Caution: Don’t modify any parameter not in the following list. Modifying an 

unlisted parameter might affect Kumulate operations.

This module must be enabled and running to connect Kumulate to tape libraries.

Parameter Description

Enabled Must be set to YES to connect to tape libraries.

For the change to take effect, stop and restart Tomcat.

Enabled modules are visible under System Control. Disabled modules 
are visible under System Configuration.

Make sure that the module is also running.

Trace Level Sets the logging level for the module.

• OFF: Only errors are logged.
• NORMAL: Errors and trace messages are logged.
• DEBUG: Logs all messages, including debug messages.

LTFS 
version for 
write

Sets the LTFS index version. Kumulate applies the version selected 
across all tapes within the Kumulate system, regardless of media library. 
This affects only the writing operations, not the import or read 
operations, for LTFS tapes.

The two options are:

• 2.4.0 (default)
• 2.5.1
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MMC Module
Caution: Don’t modify any parameter not in the following list. Modifying an 

unlisted parameter might affect Kumulate operations.

.

Parameter Description

Archive Buffer Size The size in KB of the buffer used for transfers 
to and from Archive Locations.

The default is 5120KB.

Failed reads threshold when Force 
Read Tape is YES

When Force Read Tape is set to YES, read 
operations from a tape library will take 
precedence over write operations to the 
library. In cases where the read operations are 
unsuccessful, the queued write operations 
may never be executed.

Failed reads threshold when Force Read Tape 
is YES sets a limit on the number of failed read 
attempts to make before attempting the 
write operations.

Force Read Tape When set to YES, read operations from a tape 
library will take precedence over write 
operations to the library.

Works with Failed reads threshold when Force 
Read Tape is YES and Max writes to allow 
before read again.

Max Archive Transfers Maximum number of transfers to and from 
the tape archive.

The default is 1.

PMRUpdater Path Path to the PMRUpdater executable. This only 
applies when using the PMRUpdater with 
Avid Standalone Storage Locations.
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Trace Level Sets the logging level for the module.

• OFF: Only errors are logged.
• NORMAL: Errors and trace messages are 

logged.
• DEBUG: Logs all messages, including debug 

messages.

Write In New Thread When set to ON improves archiving 
performance by creating separate threads for 
reading from and writing to archive.

Max writes to allow before read again Max writes to allow before read again works 
with Force Read Tape and Failed reads 
threshold when Force Read Tape is YES.

Max writes to allow before read again 
specifies the number of write operations to 
attempt when read operations to a tape 
library are suspended.

Parameter Description
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Reports Manager Module
Caution: Don’t modify any parameter not in the following list. Modifying an 

unlisted parameter might affect Kumulate operations.

Use the Reports Manager Module for polling the system for information used in 
reports.

Parameter Description

Cache polling interval (seconds) Cache polling interval in seconds. Information 
from the cache is entered into the database each 
time the cache is polled.

Set to 30s by default.

Maximum thread count (more 
than 1, less than 100)

The maximum number of database entry 
threads.

Set to 50 threads by default.

Maximum cached Assets age 
(minutes)

The maximum age of asset events kept in the 
cache, in minutes. Any events older than this 
value are removed from the cache during cache 
cleanup. Cache cleanup occurs every five 
minutes.

Set to 30min by default.

Maximum cached Assets count 
(less than 10000)

The maximum number of asset events than can 
be cached. Any additional events are removed 
from the cache during cache cleanup. The oldest 
events are removed first. Cache cleanup occurs 
every five minutes.

Set to 1000 events by default.

Maximum cached Instances age 
(minutes)

The maximum age of instance events kept in the 
cache, in minutes. Any events older than this 
value are removed from the cache during cache 
cleanup. Cache cleanup occurs every five 
minutes.

Set to 30min by default.

Maximum cached Instances count 
(less than 10000)

The maximum number of instance events than 
can be cached. Any additional events are 
removed from the cache during cache cleanup. 
The oldest events are removed first. Cache 
cleanup occurs every five minutes.

Set to 1000 events by default.
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Maximum cached transfer 
information age (minutes)

The maximum age of transfer events kept in the 
cache, in minutes. Any events older than this 
value are removed from the cache during cache 
cleanup. Cache cleanup occurs every five 
minutes.

Set to 10min by default.

Maximum cached transfer 
information count (less than 2000)

The maximum number of transfer events that 
can be cached. Any additional events are 
removed from the cache during cache cleanup. 
The oldest events are removed first. Cache 
cleanup occurs every five minutes.

Set to 200 events by default.

Trace Level Sets the logging level for the module.

• OFF: Only errors are logged.
• NORMAL: Errors and trace messages are 

logged.
• DEBUG: Logs all messages, including debug 

messages.

Parameter Description
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SSC Module
Caution: Don’t modify any parameter not in the following list. Modifying an 

unlisted parameter might affect Kumulate operations.

Use the SSC Module to control cache operations, such as space management and 
logging.

.

Parameter Description

Free Limit Generates an operator message if the storage space on the cache 
drops below this percentage. The level is a percentage of the total 
amount of storage space on the cache. 

Note: An operator message will be generated, but it will not be sent 
by email regardless of whether the email service has been 
enabled.

FreeSet Point Instances will be deleted from the cache when the free space on the 
cache drops below this percentage.

Trace Level Sets the logging level for the module.

• OFF: Only errors are logged.
• NORMAL: Errors and trace messages are logged.
• DEBUG: Logs all messages, including debug messages.
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System Module
Caution: Don’t modify any parameter not in the following list. Modifying an 

unlisted parameter might affect Kumulate operations.

Use the System Module toconfigure settings for a variety of Kumulate features.

Parameter Description

AVID Interplay 
WebService 
TraceLevel

Controls the logging of messages to and from the Avid 
Interplay web service.

Messages are logged when set to DEBUG.

Messages are not logged if set to NORMAL or OFF.

Set to NORMAL by default.

Client Id The client ID of the Kumulate system appears in the Kumulate 
UI tab; allowing you to differentiate between multiple systems.

The Tomcat service on the Kumulate server host must be 
stopped and restarted for this change to take effect.

Email debugging This enables or disables debugging email errors; leave this 
disabled unless emails are not operational. Can be Off or On.

Email From Address The email address that will be used to send logs and operator 
messages. Credentials must be known for this email address.

Caution: The email user's password is visible and stored 
in clear text; not encrypted.

Use SMTP Auth When set to YES, authentication is done through SMTP; when 
set to NO SMTP authentication is disabled.

Generally, this should be set to YES.

Email SMTP Host The SMTP server host of the sender's email.

SMTP Port The non-SSL SMTP port; this is port 25 by default.
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SMTP SSL Port The SSL or TSL SMTP port.

SSL uses port 465 by default. TLS uses port 587 by default. 

This parameter is set to port 465 by default. 

The Use SSL SMTP parameter must be set to YES for SSL to be 
used.

StartTLS must be set to YES for TLS to be used.

Email Service Turns the email service on and off. 

If the email service is OFF, no emails will be sent by the system.

Set this to ON to allow Kumulate to send emails.

Email Subject The subject line for emails containing log messages.

Email To Address The email address of the recipient of log and operator 
messages. Recipients for emails sent by workflows are set in 
their respective email templates.

Use SSL SMTP Set to YES to use SSL; set to NO if TSL will be used instead.

Email User Name The email address of the sender. 

Email User Password The sender's SMTP authentication password.

Caution: The email user's password is visible and stored 
in clear text; not encrypted.

General TraceLevel The logging level to use for general trace logs.

LDAP Domain The customer's LDAP client domain. Used when Kumulate is 
configured to use LDAP.

See Authentication by User Group for more information.

LDAP Single Sign-On Enables the single sign-on feature when set to ON.

This parameter is set to OFF by default. 

LDAP must be enabled to use single sign-on. If this parameter 
is set to ON, but LDAP is not configured and enabled, setting 
this feature will change the login screen, but single sign-on 
will not work. See Enabling Optional Single Sign-On 
Authentication for more information.

LDAP URL The customer's LDAP server location, with appropriate search 
terms. Used when Kumulate is configured to use LDAP. See 
Authentication by User Group for more information.

Log Dir The directory where the Kumulate logs are saved. 

This parameter is set to C:\Masstech\Logs\Montana by default.

Parameter Description
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Monitor Period Set to YES to keep track of periods; otherwise, set to NO.

Operator Email

Optional Email 1

Optional Email 2

Additional email address which can receive operator email. 
Any or all of these parameters can contain an email address. 

Note: If more than one Operator Email parameter is present, 
only the second one is active. If only the first of the 
two has been assigned an email address, emails will 
never be received at that address. Send Operator 
Email must be set to YES for emails to be sent to these 
recipients.

Send Operator Email When set to ON, operator messages will be sent to the email 
addresses specified in Email To Address, Operator Email, 
Optional Email 1, and Optional Email 2.

System Id A unique ID generated by Kumulate used in clustering.

Trace Level Sets the logging level for the module.

• OFF: Only errors are logged.
• NORMAL: Errors and trace messages are logged.
• DEBUG: Logs all messages, including debug messages.

Parameter Description
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UII Module

Parameter Description

Low Res Streaming Server The streaming server to use when the Stream Proxy is set 
to Yes, True, or On.

Stream Proxy Set this parameter to Yes, True, or On to stream proxies 
using the server specified by the Low Res Streaming 
Server parameter when a request to http://
<machineName>/montana/
Proxy?userID=XXX&program_instance_num=999

or

http://<machineName>/montana/
Proxy?program_instance_num=999&userID=XXX&retrie
veCCFileOnly=Yes

is made through XMMPI.

Set this parameter to No, False, or Off to download the 
proxy instead.

Trace Level Sets the logging level for the module.

• OFF: Only errors are logged.
• NORMAL: Errors and trace messages are logged.
• DEBUG: Logs all messages, including debug messages.
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Workflow Manager Module
Caution: Don’t modify any parameter not in the following list. Modifying an 

unlisted parameter might affect Kumulate operations.

Use the Workflow Manager module to control workflow operations.

See Workflows for more information.

Parameter Description

Command Retry Interval (sec) The amount of time to wait between 
attempts to retry a workflow command.

This is set to 600 seconds (10 minutes) by 
default.

E-mail Queue Capacity The total number of emails that can be 
queued when workflows are configured to 
send notification emails.

Prepare Completed Asset Metadata The asset metadata that must be modified 
to trigger a profile with a 
PreparedCompleted trigger. Kumulate must 
be stopped and restarted for changes to 
take effect.

See PreparedCompleted for more 
information.

Prepare Completed Instance Metadata The instance metadata that must be 
modified to trigger a profile with a 
PreparedCompletedInstance trigger. 
Kumulate must be stopped and restarted for 
the changes to take effect.

See PreparedCompletedInstance for more 
information.

Trace Level Sets the logging level for the module.

• OFF: Only errors are logged.
• NORMAL: Errors and trace messages are 

logged.
• DEBUG: Logs all messages, including 

debug messages.
Kumulate Administration Guide



System Control and Configuration Modules
XMTI Module

305
XMTI Module
Caution: Don’t modify any parameter not in the following list. Modifying an 

unlisted parameter might affect Kumulate operations.

Set XMTI values as follows:
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Parameter Description

Delete temporary PR Instances When an PR restore to the Storage Location is 
requested, the PR is first created on CACHE and 
after that the PR-ed instance is transferred to 
desired Storage Location. If this flag is set to YES, 
the instance from CACHE is automatically deleted 
at the end of restore. If set to NO, the intermediate 
instance from CACHE will remain in the system. 
This is particularly useful when you want to do a PR 
to multiple Storage Locations or if you want to 
preserve the PR-ed content in the archive for a 
period of time.

Enabled Set Enabled to YES to enable the module; set it to 
NO to disable the module.

Tomcat must be stopped and restarted for the 
change to take effect.

Enabled modules are visible under System Control.

Disabled modules are visible under System 
Configuration. 

Note: Enabling the module does not necessarily 
start the module.

ML partial restore max percent This percent represents the value after a partial 
restore from tape is always performed as a full 
restore to CACHE followed by a partial restore 
versus a direct partial restore from tape. In this 
example (see the following figure), if the part to 
restore is greater the 30% of the full media file, the 
entire file will be restored from tape.

ML partial restore min size (GB) This value represents the minimum size of a partial 
restore from tape to be performed directly from 
tape. If the partial restore section is estimated to be 
less than this size, then a full restore is performed 
to CACHE followed by a partial restore.
Kumulate Administration Guide



System Control and Configuration Modules
XMTI Module

307
Omneon Proxy Timecode Offset A value of 100 is recommended unless the 
version of HQS is prior to release 1.12.

Omneon files include pre-frames. In versions of 
HQS prior to 1.12, an offset had to be specified to 
prevent HQS from transcoding the pre-frames. 
Starting with release 1.12, HQS is capable of 
handling the pre-frames.

However, Kumulate still sends the offset to HQS. In 
order for HQS to ignore the offset, a number that is 
larger than the number of pre-frames should be 
used. This will effectively cause HQS to ignore the 
offset altogether.

Restart Transcode Engines If this value is set to YES, all Transcode Engines 
connected to Kumulate will be restarted when 
Kumulate starts.

Trace Level Sets the logging level for the module.

• OFF: Only errors are logged.
• NORMAL: Errors and trace messages are logged.
• DEBUG: Logs all messages, including debug mes-

sages.

Parameter Description
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SDBI Module
Kumulate has a memory cache that maintains information about a number of assets 
and instances as an optimization to reduce the number of accesses to the database for 
frequently used assets and instances. If Kumulate needs details about an asset or 
instance that is found in that cache, the details are obtained directly from the cache, 
without querying the database. If an asset or instance is not found in the cache it will be 
automatically added at first use.

Sometimes it is useful to disable the caching mechanism when performing 
investigations related to metadata values that are not correct in Kumulate.

Parameter Description

Asset Cache Expire Time [minutes] The expiration time for an asset in cache. The 
asset is removed automatically from cache after 
a certain time period from when it was inserted 
into the cache.

Asset Cache Size The maximum number of assets that are 
preserved in memory cache. If this value is set to 
0, the cache for assets is disabled.

Instance Cache Expire Time 
[minutes]

The expiration time for an instance in cache. The 
instance is removed automatically from cache 
after a certain time period from when was 
inserted into the cache.

Instance Cache Size The maximum number of instances that are 
preserved in memory cache. If this value is set to 
0, the cache for instances is disabled.
Kumulate Administration Guide



310
Elasticsearch and Kibana
Configure Elasticsearch and Kibana for proper indexing and visualizations.

■ Elasticsearch Indexing and Kibana Visualizations

■ Configuring Elasticsearch

■ Index Alias Indicators

■ Importing Default Kibana Dashboards Into Kumulate

■ Creating and Modifying Dashboards and Visualization

Elasticsearch Indexing and Kibana Visualizations
Kumulate uses Elasticsearch to index asset metadata and system activities. These 
Elasticsearch indexes are used by all Kumulate searches. They are also used to create 
Kibana visualizations and dashboards; which are displayed in Kumulate's Reports page.

Configuring Elasticsearch
Configure Elasticsearch as part of your initial configuration.

Use the following procedure to configure the Elasticsearch and Kibana server:

1. Log in to Kumulate.

See Logging In.

2. Browse to the administration tools.

See Finding the Administrator Tools.

3. From the ADMINISTRATION page menus, select Elasticsearch Clusters.

4. Click the three-dot menu button for the cluster you want to modify.

5. Select Modify from the drop-down menu.
Kumulate Administration Guide



Elasticsearch and Kibana
Configuring Elasticsearch

311
6. Enter field values, as follows:

Caution: Don’t modify these settings without conferring with Technical Support.

Parameter Description

Cluster Name The name of the Elasticsearch cluster that was created 
during the Kumulate system installation. The cluster name 
can be determined by viewing the Elasticsearch.yml file; 
typically found in 
C:\ProgramData\Elastic\Elasticsearch\config\.

Description The descriptive name of the cluster.

Enable Set to Yes.

Use Sniffer Set to No.

Security Plugin Set to X-Pack Security.

Authentication Scheme Set to Basic.

Use SSL Set to Yes.

Username The user that Kumulate will use to send REST API requests 
to Elasticsearch.

Password The password associated with the Username.

Kibana Server URL The address that Kumulate will use to send REST API 
requests to Kibana.

Kibana Server URL (User) The address used by Kumulate GUI to access Kibana.

Kumulate Kibana User The user that Kumulate will use to send REST API requests 
to Kibana.

This does not need to be configured if security plugins 
were not configured for Kibana.

Kumulate Kibana 
Password

The password that Kumulate will use to send the account 
above.

Elasticsearch nodes
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Configuring Bulk Processor
A new section in the Elasticsearch Cluster configuration allows configuring the bulk 
processor settings.

The Bulk Processor accumulates indexing requests until it exceeds the number of Bulk 
Actions configured, or the Bulk Size (MB) configured, or at every Flush Interval (s). Up to 
Concurrent Requests bulk requests can be sent for processing at once to Elasticsearch 
while accumulating more bulk requests.

Note: Do not use excessive values, as the Elasticsearch coordinating node has to hold 
the entire bulk request in memory and you can potentially run out of memory if 
you have too many large requests simultaneously. Official advice from Elastic is 
not to exceed tens of MB for the bulk size, even if it appears to perform better.
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Index Alias Indicators
Index Alias Indicators are now displayed to the left of the Status on the Index 
Management page as seen in the following figure. This is useful for viewing if an index 
has an alias associated with it without having to enter Kibana and use the API for 
diagnostics purposes.

If one of the indexes does not have its index aliases but should have it (for example, 
from a snapshot restore, or if re-indexing from the Elasticsearch was interrupted), then 
you can select the index and choose the Promote Index option.
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Importing Default Kibana Dashboards Into 
Kumulate

When the Kumulate system is initially installed, no dashboards will be displayed on the 
Reports page. Click Import Default Dashboards from the Reports page to import the 
default dashboard into Kumulate. This imports a set of dashboards and their 
visualizations that have been preconfigured by Telestream.
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Creating and Modifying Dashboards and 
Visualization

Kibana provides the ability to create custom visualizations using any of the information 
stored in Elasticsearch indices. Tutorials can be found at www.elastic.co. Alternatively, 
Telestream can create custom visualizations as a professional service.

Contact your Telestream Account Manager for more information.
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